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TS EHRICEEBUBEOR v ssnsm s o - fascination lies in the stately ritual of a single game. For others, it
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Sales SupportuusyisigmssiiiEminig 185 a close pennant race or Series. Still others see baseball as more of
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and vision can eventually raise any player from the bush leagues
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The “National Pastime” has its unique appeal to each fan. That is
why we have designed Front Page Sports: Baseball Pro '98 Season
(FPS: Baseball) with the widest, most flexible array of play options
and features in any baseball simulation. It is designed to
emphasize the relationship you have with professional baseball.

Whether you prefer the arcade action of an exhibition game, or the
strategic challenge of building and maintaining a baseball
dynasty, FPS: Baseball is as close as you can get to the major
league dugout without putting on cleats. In fact, it is better—rather
than a pre-structured playing environment, FPS: Baseball is, in
effect, a baseball fan’s fantasy construction set that lets you play
any role—or all.

The range of playing options is unprecedented. Opt for swing-by-
swing control of on-field action. Build a dynasty with the draft,
trade, and training strategies you select in Career Associations.
Input historical teams and replay classic pennant races, build your
own league from scratch, or create any combination you want.

This “do it yourself” approach extends to the VCR and replay
options. OQur Camera Angle Management System (CAMS) lets you
select exactly how you want to view the action, choosing from five
camera modes. You can even record and edit your own highlight
films and trade them with your friends.
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Welcome I

FPS: Baseball provides a diverse and powerful set of tools for
constructing your own dream teams. From the optimism of spring
training to the intense drama of the championship series, welcome
to the world of professional baseball!

See "What's New for '98” for a complete list of things we've added
or changed since the '96 version.

—The Front Page Sports Team

GAME OVERVIEW

Whether you want to manage an entire baseball league or just go
out and hone your batting skills, FPS: Baseball has something for
everybody. When you launch FPS: Baseball, you will see the
startup screen. This screen provides the following basic options for
playing the game:

¢ Arcade Play

Exhibition Play
= Batting Practice

* League Management

Web Site

s Preview

Note: Experienced FPS: Baseball users can bypass the startup
screen and go directory to the league management screen by
editing the BBPRO.INI file. see “Editing the BBPRO.INI File” on
page 174 for details.

In the Stadium

Arcade Play, Exhibition Play and Batting Practice all take place in
the Stadium, where you can use your joystick, keyboard, or mouse
to control the hatters, pitchers, and fielders, and you can even
create replays and highlight films. Once you have created an
association and are ready to play regular league games, you will
access the stadium from the Front Office. (See “In the Stadium” on
page 36 for complete details.)

8

'38 Season

Arcade Play allows you to play an exhibition game with all
settings at their easiest levels. This is ideal for the beginning
player who wants to get a feel for the game.

Exhibition Play takes you to the stadium for an exhibition game.
An exhibition game is identical to a league game, except that the
results and game statistics are not added into league or team data.
You can use exhibition games to learn to play the game « little
better and experiment without affecting Association statistics.
Exhibition Play is also ideal if you are not interested in having
your own team or running your own Association.

Note: When selecting Exhibition Play from the FPS: Baseball
'98 startup screen, you can only play games between the
current year's MLPA teams and you can't change the game's
"ground rules" before starting. This is more limiting than
entering Exhibition Play from the Front Office, where you can
play any two teams from any two associations and they can be
standard or all-star teams.

Batting Practice allows you to match any batter against any
pitcher, regardless of which team they are on.

Selecting either Arcade or Exhibition Play takes you to the Stadium
and you will see the Batting/Pitching display on your screen. You
can access all pitching, batting, manager, and game options from
here. When the ball is put in play, the display switches to the 3D
Stadium view for fielding and baserunning. After each play, you
have the option to see an Instant Replay and edit it as much as you
want, using the Camera Angle Management System (CAMS). You
can also pause a play in progress and start CAMS from the 3D
Stadium view.

The Front Office

The League Management button on the startup screen takes you to
"the Front Office,” where you select the game(s) you want to play,
set up your Associations and teams, review rosters or stats,
conduct spring training and trades, and so forth.The menu bar at
the top of the screen allows you to display ditferent information
and controls. These intuitive "point-and-click" screens are easiest
to use with a mouse, although you may also use the keyboard.

9
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Mer%u options that you can currently select appear in black type.
Opiuons not currently available are grayed out, or "ghosted.” The
active option appears highlighted in white type.

You can only manage one Association at a time in the Front Office.
The association's name is displayed on the right of the status bar
at the bottom of the screen. The Association's current calendar date
is displayed on the left part of the status bar. You can select
commands from the menu to load a different association, view the
schedule, look at team rosters, make trades and so on. For more
information on Associations, see “Association Overview” on
page B4, If you are not interested in running your own team or
Association, select Exhibition Play from the Main menu to set up a
single game to play.

WHAT'S NEwW FOR '98

FPS: Baseball Pro '98 inherits the core set of features that made
Baseball '96 so popular. But go ahead and run Baseball '98 and you
will immediately begin to see the major enhancements that take
FPS: Baseball '98 to a new level of ease-of-use, accuracy, and fun!

The first change you will notice is the newly designed Startup
Screen. For those of you who just want to jump in and swing the
bat, this feature provides you with quick access to batting preactice,
exhibition games, or arcade play without having to deal with
leagues, schedules, or statistics.

E:at?ing practice has been enhanced, as well. Instead of being
limited to practice with only a single team, you may now choose to

face off any batter and pitcher from the 1997 MLBPA season in any
of the 28 big league ball parks.

Another enhancement is the addition of adjustable difficulty levels
in the arcade game. You can quickly choose an "Easy" or "Normal"
setting for batting, fielding, and/or base running, in any
combination, or if you want, you can set your own custom difficulty
levels by changing such things as the effective size of the bat for
hitting or the size of the glove for fielding.

We've also added several playing aids to make it easier to control
the various arcade aspects of the game. The SmartMove and
SmartThrow features can be combined with the IntelliPoint player
cursor to make fielding the ball easier for the casual arcade gamer.
The ability to control only a single fielder during a play provides
simpler access to the arcade game.

10

Graphically, the game has been enhanced by the addition of the
player's uniform numbers on the backs of their jerseys in the
arcade game. Additionally, the Front Office portion of the game
has seen a face lift with the addition of background photos on the
desktop.

The Remote League concept has been expanded considerably from
the difficult, process-intensive system found in FPS: Baseball ‘96, to
the new Remote Manager utility. Remote Manger completely
cutomates the task of running and playing in remote leagues over
the Internet. It can even create expanded reports with embedded
HTML codes for automatic updating of team and league Web

pages.

Simulation gamers will appreciate the new "fastsim" module,
which forgoes game highlights in favor of completing seasons in
about one third the time required by the "normal” simulation
engine. Best of all, the new fastsim doesn't come at the expense of
consistency and accuracy, as it is a derivative of the original
simulation module, rather than being a completely new design.

Of course the 1997 MLBPA association is included with the game,
as well as an association reflecting team rosters as of the end of
the 1996 MLBPA season. Additionally, the 1997 MLBPA Opening
Day association features the 1997 schedule, complete with
interleague games.

The most important new feature cannot be seen without playing
the game and looking at the statistics. The heart of the game, the
batting and pitching model, has been completely redesigned to
more accurately simulate the batting and pitching tendencies of
the MLBPA players. Pitchers need to be able to establish their
ability to throw strikes with each of their pitches and need to
change speeds and locations to be successful. A mediocre fastball
or hanging breaking ball in the middle of the strike zone will get
punished accordingly. Batters will tend to wait for a good pitch
that they can drive, until they fall behind in the count and then will
work to protect the plate. Computer controlled batters will even
check their swing, or at least attempt to, if they identify a pitch as
being unhittable.

We've spent the majority of our efforts working to improve the
accuracy of the simulation model, from both raw statistical results
and "on the field" points of view. When it comes to "accuracy,"
FPS:Baseball Pro '98 is unique in that it provides both accurate

11
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statistical results and uses the same physics and type of pitch-by-
pitch thought processes that the real MLBPA players use.

In addition to the improved batting and pitching system, the entire
on-field Artificial Intelligence (Al) system has been enhanced.
Fielder and baserunner logic has been modified to allow players
to more accurately gauge their abilities on the field and
basepaths, resulting in better fielding and base running by the
computer-controlled players.

Field Manager Al in the Stadium and General Manager Al in the
Front Office have been improved, as well. Each manager should
perform a more capable job of controlling the team on the field and
of providing the team with the right talent to win, or to rebuild for
the future as circumstances require.

Along with this advanced strategical intelligence, is the addition
of altitude to the game's physics model. As can be seen from the
barrage of runs coming out of Denver the last few seasons, altitude
can have a huge effect. In fact, the same physics that would send
a ball 400 feet to dead center in New York would send it sailing 40
feet further in Denver!

Even better than having improvements to the game's Al is the
ability to change it yourself, and that's just what you get with FPS:
Baseball ‘98! Over 800 different aspects of the game's Al and
physics model have been included in the [Playbalance] section of
the BBPRO.INI {ile in the BBPRO_98 directory. These entries allow
you to adjust various aspects affecting the game's results, giving
you the ultimate baseball "construction set." For more details,
check the BBPROINLTXT file in the BBPRO_98 directory.

We can't detail every improvement or change from the previous
version, so just jump in and check it out.

12
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Getting Started

PREGAME SCREEN

If the Windows 95 AutoPlay feature is enabled, the PreGame
screen comes up automatically when you insert the FPS: Baseball
CD into the drive. If you want to insert the FPS: Baseball CD
without this screen showing up, just hold down the SHIFT key
while you insert the CD.

If you have not installed FPS: Baseball ‘98, you will see the
following choices:

INSTALL BASEBALL PRO: Runs Sierra Setup so that you can install
FPS: Baseball and test your hardware.

READ ONLINE MANUAL: Brings up the Help file. If you're interested
in finding out more about FPS: Baseball, click on the Contents
button at the top of the screen.

EXIT: Ends the start-up program.
If you already installed FPS: Baseball, you will see these choices:

RUN BASEBALL PRO: Starts FPS: Baseball from the directory
where you installed it. Once it's running, you can create and/or
play in Associations, or you can start a single game with any two
teams of your choosing.

PLAYBALL: Starts FPS: Baseball from the directory where you
installed it, but takes you right to the field to play a game with two
pre-selected teams.

READ ONLINE MANUAL: Brings up the Help file. If you're interested
in finding out more about FPS: Baseball, click on the Contents
button at the top of the screen.

REINSTALL: Reruns Sierra Setup so that you can reinstall FPS:
Basehall, test your hardware, or change settings.

SIERRA WEB PAGE: If you have Web browser software installed,
you can connect to Sierra's Web page on the Internet.

EXIT: Ends the start-up program.
13
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Getting Started

If you've previously installed FPS: Baseball, you can start it by
selecting FPS Baseball Pro from the Sierra group. If you haven't
installed FPS: Baseball, you can run SETUP from the root directory
of the CD to install it.

INSTALLING F'PS: BASEBALL

To install FPS: Baseball:

1. Insert the FPS: Baseball Pro '98 Season CD into your CD-ROM
drive.

2. If the Windows 95 AutoPlay fecture is enabled, the FPS: Baseball
PreGame screen will appear in a few seconds. When it does, click
on the Install Baseball Pro option. Then follow the on-screen
directions to install the game.

If the PreGame screen does not appear, you can start the Setup
program with these steps:

1. Click on the Start button on the Windows 95 task bar.
2. Select the Run command.

3. Type DASETUP, where D: is the drive letter for your CD-ROM
drive. Then click on the OK button.

4. Then follow the on-screen directions to install the game.
Note: FPS: Baseball installs Microsoft DirectX as part of the game

install process; this is used to enhance the music and sound effects
on the field.

LAUNCHING F'PS: BASEBALL

If you are using Windows '"95:
1. Go to the Windows '95 Start menu and select
Programs > Sierra > FPS Baseball Pro.

Or you can just insert your FPS: Baseball CD into the CD drive and
select "Run Baseball Pro” from the menu that is displayed after a
few seconds.

14
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UsING THE TUTORIAL

FPS: Baseball comes with a quickstart tutorial to help you started
with FPS: Baseball. The tutorial introduces you to the basic skills
required to play a game in the Stadium, and it gets you started
with running your own association from the Front Office. The
tutorial is accessible from the contents screen of FPS:Baseball's
Online Help file or in this manual.

OPTIMIZING PERFORMANCE

Speeding up the Game

To speed up the performance of FPS: Baseball '98, try the following:

1. Decrease your color depth. Using 32k colors or more is great
because it gets rid of the “psychedelic flash” when a new palette is
loaded in 256-color mode. But in order to work with the lower end
machines, and for speed and storage space issues, FPS: Baseball
'98 uses an 8-bit (256-color) palette.

In Windows, 8-bit palettes operate differently than full-color
palettes, meaning that if you mix the application with the video
mode, more processor time will be needed for the conversion
process. You should always match your video color depth to that of
the application. The use of Microsoft's Powertoys "QuickRes”
utility allows you to easily switch resolutions and color depths,
without rebooting or closing applications.

2. Decrease your screen resolution. Although FPS: Baseball '98
takes advantage of large video resolutions by giving you more
room to place and size windows when in the stadium, it takes more
processor time to paint each pixel, since there are more of them.
Drop the resolution down using the Microsoft's Powertoys
QuickRes utility.

3. If the Batter/Pitcher Interface (BPI) is choppy, but the field view
is OK, try increasing the size of the BPI window until there is a thin
black border between the BPI image and the window border. This
ensures that the BPI image is not being scaled down on the fly,
taking up valuable processor time.

4. Reduce graphic detail. FPS: Baseball was designed to operate
on the full range of machines available. As a result, slower

15
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machines must have less detail. The detail settings that have the
largest effect on the framerate in the field view are:

¢ Field Texture
¢ Weather Texture
e Sky Texture

» Stadium Model Size (although the specific stadium model in
use may effect the framerate due to increased detail)

* Crowd Texture{on/off, the level, other than off, doesn't matter
for framerate purposes)

and in the BPI:
e BPI Texture

As long as the game runs smoothly with NO detail, you should be
able to find a detail level that will run at an acceptable framerate.

6. Reduce sound quality. Use of the High Quality sounds will have
an effect on the framerate. Try reducing sounds to Normal Quality.

7. Keep the field view window to the minimum size required by the
BPI window (since they are the same window). Using Full Screen
has a huge hit on the framerate, when used with large display
resolutions (1024 +).

8. Turn off the info windows. Although the Scoreboard, Info, Game
Updates, and Top View windows don't take much processor time,
they do take some and that may be enough to make a difference.
They DO have an effect on the speed of simulated games, To
maximize simulation speed, remove ALL windows (you still have
the Stadium window title bar info to take the place of the
scoreboard).

8. Increase available RAM. You can do this by closing other
windows and active applications (including the System Tray in the
extreme), but is best done by adding more RAM. With RAM, the
more the merrier. FPS: Baseball '98 will cache all of its sound and
graphic files to RAM for instant recall if there is enough available
RAM. Normally it does this on an "as needed” basis, but you can
specity to preload all animations to RAM when loading each game,
at the expense of longer load times. For more information, check
the BBPROINL.TXT file. which is in the BBPRO_98 directory.
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10. Increase available drive space on C: (or whatever is your
"swap file” drive). The swap file provides faster access than a CD
or normal hard drive access, so if there is insufficient RAM but
plenty of swap file space, Windows will load the animations there
(treating it as RAM). Remember, if you have the game on the same
drive as your Windows swap file, you must figure that scme of the
drive will be used by the swap file and there must still be space to
write the necessary game files. You will probably find that having
50 MB free of hard disk space improves the performance of other
applications, as well as FPS: Baseball. See the section below on
freeing up hard disk space.

11. Use the Scandisk and Defrag utilities on both the Windows
swap file drive and the game drive for optimum performance. If
the Windows swap file is strung out all over the drive, you will
have overall decreased performance. If the game files are strung
out all over the drive, the game will have decreased performance.

12. Install ALL the game files. CD access and retrieval times are
about 10-20 times slower than most hard drives. The game needs
these files, and will wait for them if necessary. If you see an
inordinate amount of CD activity, try reinstalling to get all the files
onto your Hard Drive. IMPORTANT! Back up your assocication files
using BBArch (to some other directory than the SIERRA or
\SIERRA'\BBPRO_98 directories) before reinstalling FPS: Baseball,
or else they will be erased.

13. Use the latest drivers for your hardware, especially your video
and sound cards. Manufacturers only make new drivers when
there is a good reason to do so.

14. Calibrate your controllers. If an unused controller is giving a
continuous signal, it may still impact game performance. You may
alsc want to try turning off unused controllers to eliminate
extraneous signals from causing “signal overload” or other
interference,

Reducing Hard Disk Space

The following are some methods for reducing the amount of disk
space used by FPS: Baseball:

- Use the BBArchive utility to backup any of your old Associations
(with the Delete Original option).

17
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- Delete any of the Associations that shipped with FPS: Baseball '98
(NOT the DEFAULT." files). To safely delete these associations, go
to the Load Association dialog (select Load Association from the
Main menu). Click on any association you do not want, then click
on Delete.

- Uninstall FPS: Baseball '98 (after you've backed up your
Associations) and then reinstall it; this time, choose to install fewer
additional game components to the hard drive. Note: This may
decrease game performance; the best option not to install to the
hard drive are the 3D stadium files. These are read once when each
game is started.

CONFIGURING CONTROLS

B Note about Controls

Throughout the game, control menus appear at various points to
allow you to take control of players, change camera angles, view
VCR tapes, and so on.

Some menus are visible (such as Offense Manage), some are
graphical {such as CAMS), and other are hidden (such as fielding).

Any visible menu item can be clicked on by the mouse. Some items
respond immediately, others allow for multiple selections.

For each team, you can set up a device to control the menus when
not playing in computer control mode. For more information, see
"Team Data” on page 106.

FPS: Baseball currently supports the following devices:

s joysticks 1-16 (if installed)
» keyboard left - see reference card
e keyboard right - see reference card

Control Setup

The Control Setup dialog allows you to calibrate/configure
joysticks and also create ond assign command maps to each
joystick. To display the Control Setup dialog box, press the] key in

18

the Front Office, or press the F2 key and click on the Configure
Conirols button in the Stadium.

Control Setup _

Note: If a control menu is open in the Stadium, or the joystick is in
use, you may not be able to capture a joystick value and therefore
edit individual menu commands. In the Front Office, you are able
to access any joystick.

Calibrating Joysticks

The Calibrate Joysticks button takes you to the Windows Control
Panel to allow you to install/calibrate the joysticks which are
connected to your computer.

Once you return to FPS: Baseball, any changes you made will be
reflected in the list of available joysticks.

Assigning Joystick Maps

By default, all joysticks use the "Defcult Map.” This map is
designed for a regular 2-axis, 2-button joystick but will also work
with just about any joystick, provided the driver is installed
correctly.

You can assign a more advanced map to your joystick. For
example, the "Map for SideWinder 3D Pro"” connects throttle,
rudder, and hat to allow you to 'fly' your camera view while in the
CAMS menu.

To assign a map, select the joystick to which you want the map
assigned to in the Joystick drop-down box. Then select the map
from the list of maps in the Command Map drop-down box. The
assignment is immediate and requires no confirmation.
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A control map may be assigned to a number of joysticks. Changes
to this map affect ALL devices that have it assigned to them. To
make a change that affects a single device, save the map as a new
name and assign that new map to the control. You may then
configure the new map for that control.

Configuring Control Maps

The Configure Maps option will allow you to program joystick
position/button combinations for every command on every menu in
the stadium (pitching, batting, baserunning, fielding, managing,
and so on). To do thig, click on the Configure Maps button in the
Configure Controls dialog box.

The currently selected map is opened by default, though you can
open and edit any control map.
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Each map consists of a list of joystick-control movements and
button-press values assigned to menu items for each menu in the
game.

Note: If you have a joystick with rudder and/or throttle, make
sure these controls are centered if you select one of the
advanced maps that use these axes, such as "Map for
SideWinder 3D Pro.”

Select the menu you wish to modify in the Menu drop-down box.
Then select the command you want to alter from the Command
scroll box. Then click the Learn button (with the correct joystick
selected). You will now have the opportunity to move the joystick
controls where you want and click on the joystick button you want
to initiate the selected command. Or you can press the Enter key if
you don't want a button involved. For example, say you want the
Steal 2nd command on the Offense menu to be Joystick down, press
button 2. After you click the Learn button, move the joystick down,
then ~ress Button 2. If you select a setting that another command
on the selected already uses, a dialog box will alert you and allow
you to cancel the change or accept it and remove the setting from
the other command.

You don't have to learn a command from the same joystick that you
will assign the map to, BUT they must be compatible types. For
example, if you learn a rudder-twist+button 4 from a SideWinder
3D Pro and then assign this map to a 2 axis joystick, you will not be
able to activate this command with the joystick. Conversely, if you
learn « simple joystick left+button 1, then most joysticks will be
able to generate this sequence.

If you capture a joystick command sequence that is in use by
another command in the current menu, you will be asked if you
wish to overwrite the existing assignment.

You can click on the Reset Command button to clear the
assignment for the selected command.

The axes which are enabled lor this map are shown below the map
name. This allows you to ignore unwanted input from the joystick
which could confuse FPS: Baseball. For example, you have rudder
pedals which are configured under Control Panel, but they don't
physically center correctly and you don't want to use them in the
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game. By clearing the appropriate check box, you can make sure
that only the axes you need are read by the game.

The lower right area of the dialog allow you to learn (or capture) a
position value from a joystick.

A static display of available joystick axes will help you see what
inputs make sense from this joystick.

Unfortunately, no standard exists for what axis name will
correspond to a physical control axis on a joystick device.
However, they usually are:

X - joystick left-right

Y - joystick forward-back

Z - throttle

R - rudder

POV HAT - POV Hat (only 5 discrete positions)

FPS: Baseball supports the first 16 joystick devices, up to 7 axes on
each joystick, and up to 32 buttons on each joystick.

To create a new map, select the map to use as your template, then
press "Save As" to save the map to a new name. You may then edit
this new map.

Configuring Keybodard Commands

The keyboard key map assignments are not configurable.

GBAME CONTROLS

Mouse

In the Front Office

Use the mouse to control the cursor on the screen, click buttons,
and select menus or menu items. Most functions are started by a
single mouse click. To “click” an item, move the cursor over the
desired item and press the left mouse button once. To select an
item from a “scrolling” menu like the Team Roster, first click the
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option to highlight it, then click again to select it. (This is also
called a "double-click.”)

In the Stadium

The mouse is also available in the stadium as a supplemental
controller to your joystick or keyboard. You can use the mouse
during the game to select the swing type for the batter, and the
pitch type, pitch location, and pitch speed for the pitcher. (You
cannot, however, use the mouse to control the batter's swing.) You
can also use the mouse to access any of the Manager menus during
a game.

Joystick

Use your joystick to select menu items and control action in the
stadium.

To recalibrate your joystick while in the stadium:
1. Right-click on the Stadium window to display the pop-up menu.
2. Select Game Options.

3. Click on the Configure Controls button at the bottom of the Game
Options dialog box.

4. Click on the Calibrate Joysticks button in the Control Setup
dialog.

To recalibrate your joystick when you're in the Front Office:

—Press the ] key.

Keyboard Equivalents

If you are using the keyboard, you can select to use a right

keyboard set or a left keyboard set. Both accomplish the same
tasks.

'.I'he Tight keyboard set uses the numeric keypad to emulate the
joystick directions as shown below. The Enter acts as Button 1 and
the * key acts as Button 2.

23
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Likewise, the left keyboard set emulates the eight joystick
directions. The Spacebar acts as Button 1, and the 2 key acts as
Button 2.

Note: There is no way to select different keys to perform the
above functions, as there is with using a joystick.

PRINTING

You may print reports from several places while you are in the
Front Office portion of FPS: Baseball: rosters, schedules, news,
champions, awards, statistics, and so on. To print a report, go to the
screen that contains the information you want to print, then select
Print from the Action menu.

For example, to print Seattle's team data:
1. Select Data from the Team menu.

2. Select Select Team from the Team menu, and select Seattle in the
dialog box that is displayed.

3. Select Print from the Action menu.

Some screens may have additional print commands. For example,
on the Association Statistics screen, you can select Print Top 50 or
Print Column Leaders. This modifies what gets printed. Top 50
prints only the top 50 players in the list (no surprise there). Print
Column Leaders prints only the top 10 players' names and the
selected column of data.

When you install FPS: Baseball, it is set to print to your default
Windows printer. It uses the default font on that printer and
expects to have enough room to print 80 characters wide. If you are
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having problems printing, or if you want to be able to load the
print-out into another program, such as a spreadsheet, word
processor, or desktop publishing program, you can print to a file.
To print to a file, select Preferences from the Main menu. Click on
the Print to File checkbox. When it is checked, all output from
printing gets appended to a file called PRINT.OUT, which is
located in the directory where BASEBALL.EXE is located. You can
turn this option off and on to alternate between printing to your
default Windows printer and the PRINT.OUT file.

BATTING PRACTICE

Batting Practice can be used to fine tune your batting skills. You
can access Batting Practice from the FPS: Baseball startup screen.

To customize Batting Practice:

1. Click Change Batter and select a batter from any team in the
MLBPA '97 association. The buttons on the right side of the dialog
box let you narrow your choices. You can display a list of batters
based on whether they are right- or left-handed, their position, or
their team.

2. Click Change Pitcher and select any pitcher from any team in
the MLBPA '97 association. The buttons on the right side of the
dialog box let you narrow your choices. You can display « list of
pitchers based on whether they are right- or left-handed, their role
(starter, reliever, etc.), or their team.

3. Click Change Stadium (optional) to select a different ball park
and field surface.

When you click Start Batting Practice, the Select Controllers
Screen is displayed.

1. Select the type of control you want to use - either the keyboard
or joystick.

2. Select the difficulty level. If you choose custom, you will be
presented with additional difficulty options.

Balls, strikes, or outs are not recorded in practice mode, so you can
continue practicing with the same players as long as you like. You
can change the current batter or pitcher by returning to the startup
screen and selecting new players.

25

paldels Bumay I



FRONT PAGE SPORTS

Basehall Pro |

Tutorials I

Tutorials

TUTORIAL OVERVIEW

The tutorials are designed to introduce you to FPS: Baseball's
basic features.

The "In the Stadium" tutorial shows you the basics of playing the
game, including the [undamentals of batting, fielding, ond
pitching.

The "Front Office" tutorial prepares you to create your own
baseball association and begin league play.

"IN THE STADIUM' TUTORIAL

FPS: Baseball gives you several options for playing the game of
baseball. This tutorial leads you through the mechanics of batting,
pitching, end fielding. These mechanics are the same whether
you're in arcade, exhibition, or league play.

If you haven't already done so, go to the Windows 95 Start menu

and select Programs > Sierra > FPS Baseball Pro.

Batting Practice

We will start with a little batting practice. When you are in Batting
Practice mode, there is no batting count, no plays, no scoring, and
no statistics kept. You are just practicing your batting skills
against a pitcher.

1. To enter Batting Practice, click Batting Practice from the FPS:
Baseball startup screen.

2. For now, click Start Batting Practice to set up your controls.
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3. From the first drop-down list, select a method of control. We
recommend using "Keyboard R" for this tutorial.

4. Select "Normal" as the difficulty level and click OK. As you get
more experienced, you can select "Custom," which will bring up
the "Difficulties Settings" screen, and give you many more options
for controlling the batter-pitcher match up.

If you chose "Keyboard R." you'll use the number pad on your
keyboard to control the batter. The picture below describes how
you use the keyboard to control your players. The keys surrounding
the "5" key on the number pad of the keyboard emulate the
movements of a joystick. The keys surrounding the "S" key on the
left side of the keyboard do the same and are referred to as
Keyboard L in FPS: Baseball. When you are playing ball, you can

assign one hand to control the batter and one hand to control the
pitcher.

BL.’rt!clr 2 Joystick Up

Joystick Up | i Button 2

‘u-«wh—n-

Joystick Left ﬂ qu Joystick Right

Joystick Down

{ kil :LEIL.tDM

ch“trck Down

5. Each item in the Swing box has ¢ number - arrow combination
to the left of it. If you want to select « bunt, you'll notice it has a
down arrow with a "1" next to it. So you will hold down the "2" key

(corresponds to "Joystick Down"), then press Enter (corresponds to
"Button 1").

_ At.'ama

6. The timing of your swing is the critical element of the batter-

pitcher dual. Be ready to push the Enter key.
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Once you are comfortable with swing timing, try batting practice
in the Advanced batting mode, in which you also control where in
the strike zone you will start your swing.

For a full explanation of batting, see "Batting” on page 36.

5. After experimenting with Batting Practice, press the Return
button on the Stadium screen to go back to the FPS: Baseball
startup screen.

Exhibition Play

Exhibition games are played outside the regular league schedule.
Exhibition games have no effect on league standings or on the
statistics of the teams and players. Injuries that occur in exhibition
games are not recorded.

There are two methods for starting exhibition games: either from
the FPS: Baseball startup screen or from the Main menu in the Front
Office. Starting Exhibition Play from the Front Office gives you
several additional options for setting game ground rules and
picking teams.

1. To start Exhibition Play, click the Exhibition Play button on the
FPS: Baseball startup screen..

FPS: Baseball will display a screen with the previously selected
stadium, listing the two teams that are set to play by default.

2. If you wish to change either the visiting or home team, you can
click on the appropriate button and choose a team from the list. For
now, just accept the default teams and click Start Game.

4. You will be taken to a screen where you will be asked what
controllers you would like to use for each team. Select the control
device you wish to use for your team using the pull-down combo
box beneath the picture. Set the opposing team to Computer
control by selecting the Computer controller for that team.

5. If you wish to change the difficulty mode, you may do so by
selecting the desired mode from the combo box beneath the
controllers selection. For now, accept the Normal default and click
CK to continue.

6. You will now see a screen that allows you to change the default
starting pitchers and lineup. See "Lineup Card” on page 49 for

Basehall Pro

inforrflation on how to change players within the lineup, but for
now, just click OK to start the game.

7. You wili. taken to the stadium and will either be in control of the
batter or pitcher, depending on the team you chose to control.

Introduction to Pitching

'In FPS: Baseball, pitching is as simple or as complex as you want
it to be. I‘n Standard pitching mode, all you have to do is select the
type of pitch, and select where in the strike zone you want it to go.

For your exhibition game pitching debut, let's keep it simple:

1. When the Pitch Selection menu opens, assuming you are using
"Keyboard R" to control your pitcher, you press "8" and then Enter.
This will select your pitcher's best pitch. If you were using
"Keyboard L," you would press "W" and then the Spacebar.

2. When prompted to select a pitch location, press "1" and then

Enter. This will select the left side of the strike zone as your
targeted location for the pitch.
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3. Alter the batter steps into the box, press the Spacebar to throw
the pitch. (You cannot throw the pitch until the batter is ready.)

In the Basic pitching mode, you select only the type of pitch to be
thrown. In Standard mode, you select the pitch type and the pitch
location. In Advanced mode, you select the pitch type, location,
and speed. For a detailed explanation of pitching in FPS: Baseball,
see "Pitching” on page 41.

Introduction to Fielding

Your initial fielding responsibilities will be easy to learn. In the
Standard fielding mode, you can let the computer control the
player best positioned to make a play on the batted ball. You do,
however, have to take control once the catch has been made. All
you have to do is throw the ball to the appropriate base and move
fielders to bases for force outs and tag outs.

You can see where the ball will land by watching for the yellow
catch zone. You can also see how far away the ball is from the
catch zone. The larger the catch zone, the farther away the ball is
from the landing point.

Once the fielder has caught the ball, press the key that will direct
him to the appropriate base and press Enter to throw the ball. (If
you are using keyboard L, you would press the appropriate key and
then the Spacebar.}
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Ball-Throwing Controls

If you play in the Advanced fielding mode, you must control the
player as he attempts to field the ball.
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What Next? Perfecting your batting, pitching, and fielding skills
takes practice in FPS: Baseball. Keep in mind that you can always
adjust the difficulty settings to match your skill level. For further
assistance, see "Guame Options” on page 52.

FRONT OFFICE TUTORIAL

Creating an Association

1, Select Main menu > Create New Association....

2. Create a 28-team league.

4. Accept the defaults of two 14-team leagues.

‘38 Season

Introduction to the VCR Interface

The VCR interface lets you recapture play-by-play coverage of any
on-field action. Once a play has taken place, select "Replay..." on
the Game Options pop-up menu (F5) to open the VCR interface and
watch or edit replays from a variety of perspectives.

For a full explanation of the VCR interface, see “Camera and
Replay Modes” on page 58.

SjenIom] l

Before starting league play, you have the option of creating « new
association or using one of the associations included with FPS:
Baseball. For this tutorial, you'll be creating a new association.

3. Choose Career - meaning that FPS: Baseball will track the
statistics of the players in this association through multiple

5. Change the division configuration to two five-team divisions
and one four-team division, just like the major leagues. When the
New Association Configuration box looks like the following
picture, click OK.
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Configuring the Leagues

After configuring the associationthe Select Teams screen
appedrs.

8. You can stick with the default teams or set up your own custom
association by selecting teams from any available F PS:Baseball
association on your system.

7. To select a different team, first select an alternate Source
association by clicking in the Association box in the source section
of the screen. Select the "1997 MLBPA Opening Day" Association.

8. Select a source league and division in this association using the
buttons in the source section of the screen until you have located
the ones that contain the team you want to add to your new
association. Click on that team in the scrollable list to select it.

9. Using the league and division buttons in the New Association
section of the screen, locate the league and division you wish to
assign this team to. Click in one of the numbered team slots to
replace the existing team with the one you selected in the previous
step. A yellow box will appear to the right of the team name,
indicating that it has been changed from the default team.

10. Now, create a name for your new association. Click in the
Association name field, which reads "New Association," press the
Delete key to clear the text, and type "Tutorial Association." Click
the Continue button.

11. The Player Options dialog box is displayed. For now, accept the
defaqult choices and click the OK button.
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12. Atter processing, you will be asked what length schedule you
would like to use. Select "Full Season" to mateh the big leagues
and click OK. Since the association is using a full season, 14-team
league schedule, you will be asked to choose between a historical
(balanced) schedule and « divisional schedule. Click historical to
make it like the majors.

The Association Data screen is displayed.
14. Click in the "League 1" field, press delete, and type "National."
In the "League 2" tield, type American. Since you made changes on

this screen, you will be asked if you want to save your changes.
Click the Yes button.

15. Select Action menu > Reset Teams.

1B6. In the Reset Teams dialog box, select "Change All to Computer"
and then click OK.

Setting up a Team

Now you will choose a team to take control of in this new
association.

1. Select Team menu > Select Team. and double-click the Seattle
Mariners to select them.

2. Select Team menu > Data.

3. Click in the "Ownership" field to change the team control from
Computer to Human.

4. Click in the manager field, press delete, then enter your name
as managet. This is now your ball team!

5. Turn off all of the Computer GM options on the right side of the
box by clicking in the X'd boxes. This gives you complete control
over the team.

B. Turn off the "one-pitch" mode by clicking its box.

7. In the "Play Modes" area, Click to the right of "Managing" until
Standard appears.
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8. "Manage-only" should currently be checked. Click it once to turn
it off. Then click in the fields below it to make pitching and batting
Standard. These settings will increase your control over your team
in the ball park. You always have the option of choosing more
automated settings.

Setting Lineups
1. Select Team menu > Roster.
2. Select Show menu > Batting Order vs Left-Handers.

3. Switch Martinez and Griffey by clicking Griffey in the player list,
then click the third slot in the lineup that Martinez is currently
ocecupying.

Note: Players already in the lineup are displayed in a
highlighted color in the player list.

4. Select Show menu > Pitching Staff Roles.

5. Highlight Mike Jackson and click "First Closer."
Starting the Game

1. Select Team menu > Schedule.

The current day of the seasons is highlighted. The Team Schedule
displays the home games, road games, and days off for your team.
Home dates are indicated by a green box, road games by a gray
box, and off days are indicated by a blue box. The current day in
the schedule is indicated by a yellow border surrounding the box.

2. If the current date has a yellow border around it, this indicates
that this is a game date and you can proceed to step 5. If there is no
yellow border, then this is an open date for your team you will need
to simulate the association's games for the current date in order to
advance the schedule so that you can play your game. To do this,
go to Association menu > Schedule (Save your changes when
prompted.)

3. Select Action > Simulate... then select OK to simulate all the
games for the current day. You will be taken to the Stadium and
will be shown a list of games for the day. As each game is
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completed, its score is written to the list. When all the day's games
are completed, you will be returned to the Association Schedule
screen.

4. Select Team menu > Schedule and you should see the yellow
"current day" indicator around the box containing your first game.

In the lower right corner of each home or away game box is a small
icon that looks like a computer screen. Any game marked with this
icon is set up to be "simulated" rather than "played.”

5. Locate the first scheduled game for your team. Click the small
computer icon in the bottom right corner of your opening game so
it changes to a joystick. This marks the game to be "played" instead
of being "simmed."

6. Now click the game to start it.
5. The Select Controls dialog box is displayed.

6. Select "Keyboard R" for your team, or if you have a joystick you can
select that option. The other team will be set to Computer-owned.

The Start Game dialog box appears.

7. Click OK to accept the detault starting pitchers and lineup, then
click Start Game.

You are now on your way to the stadium. Have fun!
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In the Stadium

STADIUM OVERVIEW

"In the Stadium" refers to the actual play field and its associated
menus and dialog boxes. It applies to batting practice, the Arcade,
Exhibition play, and Association games. There are multiple
offensive, defensive, and overall game controls in the stadium.

BATTING

In FPS:Baseball, your control of balting can be as tactical or as
strategic as you wish. Control every swing at the ball, sit in the
dugout sending signals to the batter, or turn the entire batting
process over to the computer and just enjoy watching the action.

As with pitching, the selected batting mode determines the level of
control over the batting process. The following four batting modes
are available:

Computer: delegates all batting to the computer

Basic: you control swing type.

Standard: you control swing type and swing timing

Advanced: you control swing type, swing "look" location, and

swing timing

Changing Batting Mode

You can change the batting mode whenever you start an exhibition
or a league game.

Exhibition Play

The control options appear in the lower left-hand part of the
Exhibition screen. (To get to the Exhibition screen, select
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Exhibition Play from the Main menu.) To change Batting (or any
other option), the Control setting must be set to Keyboard L,
Keyboard R, or Joystick and the Manage Only mode must be turned
off. Then click in the Batting text box under the Visitors or Home
heading to cycle through the options mentioned above.

League Play

You may only change the batting mode one team at a time. Select
Data from the Team menu. The control options appear under the
Play Modes section. To change any controls, the Ownership text
box at the left must be set to Human. Also, the Manage Only mode
must be turned off. Then click in any of the mode text boxes to cycle
through the control options.

SWING TYPE

When controlling the batter, your first selection is the type of
swing. The power swing is a strong rising swing. You may hit more
long fly balls with a power swing, but you will also strike out more.
The contact swing maximizes your chances of making contact and
putting the ball into play. The normal swing is a normal swing. The
bunt swing causes the batter to attempt to tap the ball softly into
the infield.

-ﬂﬂanta

To select a swing type, push the joystick in the direction indicated
by the on-screen arrow, and press Button 1. To select the Power
swing, for example, push the joystick right and press Button 1.
(Push left for a Contact swing, push up for a normal swing, or pull
back to select a Bunt.)
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Keyboard Control: Use your mouse to click on the command of
choice in the Swing Type menu, or press the corresponding
keyboard key.

SWING LOCATION

In Advanced batting mode, prior to swinging the bat, you must
choose a location in the strike zone to look for the pitch. If the pitch
is in that location and you swing, the batter will have a greater
chance of driving the ball with authority. If the pitch is not in that
location, the batter will attempt to adjust his swing to the actual
locction of the pitch, with his ability ratings and swing type
determining the success of his adjustments.

The strike zone is divided into nine areas that correspond to the
directions of the joystick and the keys on the keyboard. After you've
selected the swing type, a menu will appear (as shown below)
allowing to select where to watch for the pitch. Once you've
selected the location, the pitcher will throw the ball. Press Button 1
to swing. If the pitch is not thrown in the zone you selected, you still
have a chance of making an adjustment and hitting it. FPS:
Baseball makes this adjustment for you automatically, based on
the batter's ratings.

Offense Swing Location[id
| Atlanta
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SwING TIMING

In Standard and Advanced batting modes, you must decide when
to swing. Press Button | on your joystick or the appropriate key on
the keyboard to start your swing. Remember, if the pitch is a
fastball, you must start your swing earlier to hit the ball into fair
territory. You should wait a little longer on breaking balls and
change-ups.

Offense Start Swing i

Take advantage of Batting Practice to get your timing right.

SETTING OFFENSIVE PLAYS

The availability of offensive plays, strategies, and options
depends upon the current game situation as well as your selected
Ground Rules and playing modes. For example, if there are no
baserunners, the base stealing options will not be available.

When your team is at bat, access offensive plays and options by
selecting Manager Menu on the batter's Swing Selection menu.
Use your mouse to click any of the commands or follow the joystick
diagrams next to each one.
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Depending on the game situation, the Manager menu offensive
options include:

Steal 2nd: Gives a runner on first, permission to steal second. A
computer-controlled runner will try to steal only if he thinks he can
get a good jump.

Steal 3rd: Gives permission for the runner on second to attempt to
steal third.

Double Steal: Gives both baserunners permission to steal the next
base. One runner will start, and the other will go when the ball is
thrown to try to catch the first runner. Which runner breaks first
depends on the situation. With runners on first and third, the
runner on first will begin the double steal. With runners on first
and second, the runner on second will lead. With runners on
second and third, the runner on third will make the initial steal
attempt.

Steal Home: Gives permission for the runner on third to attempt to
steal home.

Hit and Run: Tells the baserunner(s) to attempt to advemece to the
next base when the ball is pitched, and the batter to attempt to hit
a ground ball, preferably to the right side of the infield.

Squeeze: Orders the runner on third to break for home with the
pitch, and the batter to attempt to bunt.

Take: Tells a computer-controlled batter not to swing at the next
pitch. (Available in Computer mode only.)

Sacrifice Bunt: Tells a computer-controlled batter to attempt «
sacrifice bunt, and the runner to go on contact. (Available in
Manage and Computer batting modes.)

Lineup Card: Lets you review the lineup, substitute a pinch hitter
or runner, or work with the bullpen.

Normal: Cancels any other offensive play instructions you have
set.

Select Swing: Returns to the Swing Selection menu, keeping any
manager decisions made.
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PITCHING

FPS:Baseball '98 gives you complete control of the pitch-by-pitch
confrontation between your pitcher and the opposing batter. This
includes strategic options, such as pitching around a batter or
attempting to pick off a runner, as well as the speed, location, and
type of each pitch.

The degree of actual pitch control you have depends on the
pitching mode. Four pitching modes are available:

Computer: the computer controls the entire pitching game
Basic: you can choose the pitch type
Standard: you can choose pitch type, and pitch location

Advanced: you can choose pitch type, pitch location, and pitch speed

PITCH SELECTION

Each pitcher can have up to four pitch types—his four best. The
available pitches are listed in order of the pitcher's rated ability to
throw them. For more information, see "Player Ratings: Pitching”
on page 133.

To select the pitch type, move the joystick in the direction of the
desired pitch (as indicated on the Pitch Type menu) and press
Button 1 or press the appropriate key on the keyboard. You may
also click on the menu item with the mouse.
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PITCH LOCATION

In Standard or Advanced pitching modes, you must aim pitches at
specific areas in or around the strike zone. To select a pitch
location within the strike zone, move the joystick in the direction
the pitching chart indicates and press Button 1. To aim a pitch right
down the middle, press Button 1 with the joystick centered. To
throw pitches outside the strike zone, push the joystick in the
direction the pitching chart indicates and press Button 2. To throw
a pitchout (a pitch thrown high and outside the strike zone on the
opposite side of the plate from the batter), press Button 2 with the
joystick centered.

Keyboard Controls: Use the mouse to click on the appropriate
command from any pitching menu.

PITCH SPEED

When playing in the Advanced pitching mode, you will also
determine the speed of the pitch. You can put a little extra on a
pitch by choosing Fast, but more speed means less control. To slow
the pitch down, you can choose Slow. This makes the pitch « little
more accurate, but also easier to hit.
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= Pitch Speed

_lr To throw the pitch fast, push the joystick up and pressButton 1. For

a slower delivery, pull the joystick down and press Button 1. To
throw at normal speed, push the joystick right or left and press
Button 1.

When you have completed your pitching selections and the batter
steps into the batting box, you are ready to pitch. With the joystick
centered, press Button 1 to throw the pitch.

Keyboard Controls: Use the mouse to click on the appropriate
command from any pitching menu or.

PICKOFFS

You can try to pickoff runners on any base. To throw to a base with
arunner, push the joystick toward that base and hold it there while
pressing Button 1 or use the keyboard equivalents.
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VISITING THE MOUND

A visit to the mound may give a struggling pitcher a chance to
compose himself and help keep him in the game longer. It can also
be used as « stalling tactic to gain time for « relisf pitcher who is
not adequeately warmed up.

While on the mound, you get a full report of the game situation and
relevant factors that will affect your managerial decision. To
display the Visit Mound dialog box, select Visit Mound from the
Detense Manage menu.

The Visit Mound screen will display the current pitcher, his
physical condition (OK, Tired, or Exhausted), and coll the
accumulated statistics for the game in progress. It also indicates
the condition (Cold, Half, or OK) of any pitchers warming up in the
bullpen.

Visit Mound
e o
oreny R .
| Bullper &1 i :
i "émlpen #z
et Bitters Ll T
i :Ngm___ { Haﬁ&_‘ A8 H R
- RyenKlasko = L0 0
davyloper | w0 A0
| Davidstos L 0 'ci_-- '

The Visit Mound screen also shows you the results of each pitch
thrown. This pitch history uses the following codes to indicate
what happened on each pitch:

B Ball

CS  Called Strike
55 Swinging Strike
F Foul Ball

P In Play
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You will also see information about the next three batters coming
to the plate, including batting statistics for the current game and
their Contact and Power Hitting ratings.

Important: Once you leave the mound, you may not revisit the
mound again until you either change pitchers or start a new
inning.

After reviewing the information and considering the game
gituation, you may either click the Bullpen button if you want to
change pitchers or start warming up a reliever, or click Return to
leave the mound and resume the game.

FIELDING

The degree of control you have over the players on the field
depends on the fielding mode you select. The following four
tielding modes are available:

Computer: the computer controls all fielding.

Basic: the computer controls the fielding of the ball. You may take
control once the defensive player has the ball, or let the computer
complete the play.

Standard: you may let the computer field the ball OR take control
of the appropriate fielder by moving the joystick. Once the fielder
has the ball, you take over to make the throw or the tag.

Advanced: you control all fielding. When the ball is hit by the

batter, you automatically gain control of the fielder best suited to
make a play on the ball.

Catching the Ball

NOTE: Keyboard Equivalents may be substituted for all
joystick commands given below.
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In Advanced fielding mode, once the ball has been hit by the
batter, you are given control of the fielder most able to make a play
on the ball. You may attempt to make the play with that player, or
select the next closest fielder to control (if another player is close
enough to the ball). To switch to the other fielder, press Button 2.

To catch the ball, move the active fielder toward the "catch zone,"
indicated by the yellow circle on the playing field.

The catch zone circle shows where the best location to make the
catch is, and its size shows how close the ball is. The higher (and
farther away) the ball, the larger the catch zone.

If you get the fielder into the catch zone before the ball lands, you
have a good chance of making the play. The playeris fielding
raling can affect those chances, however.

You can make fielders dive or jump to make difficult plays. To dive
for the ball, push the controller in the direction you want the fielder
to dive and press Button 1. To jump for the ball, center the controls
(stop the fielder) and press Button 1.

Throwing the Ball

Once your fielder has the ball, you may throw it. Move the controls
toward the appropriate position to specify a base to throw to, then
press Button 1 to throw the ball,

2nd Base

Hotme Plate

For example, to throw to Ist base, push the joystick to the right and
press Button 1. To throw to the relay man, center the joystick and
press Button 1.
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Catcher Throwing to Bases

While the catcher has the ball in the Batting/Pitching screen (the
ball has crossed the plate, but has not been thrown back to the
pitcher), you can throw to any base by pushing the controls toward
that base and pressing Button 1.

POSITIONING FIELDERS

You can control the defensive positioning of each player on your
team. In addition to using standard defensive strategies (such as
setting up a double play or positioning your players to protect the
lines), you can customize your defensive alignments.

To position fielders, select Manager Menu from the Pitch Selection
menu. When the Manager menu is displayed, select Position
Defense.

Standard Defensive Positions

The Defensive Positioning screen provides quick access to a
variety of standard fielding options.

Preset options for the outfield include:
Normal

Move Left: Shifts all outfielders left.
47
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Move Right: Shifts all outfielders right.
Preset options for the infield include:
Normal

Guard Lines: Moves the infielders into position to guard
against hits down the foul lines.

Cut-Off Run: Moves infielders into the base paths, reducing
the chance of any runners advancing.

Double Play: Positions the infielders for a double play defense.

Custom Positioning of Fielders

In addition to these standard defensive options, you can position
each fielder exactly where you wish on the playing field, and then
save these customized fielding configurations for later use. Each
team can have up to three sets of Custom Positions defined for
easy access in the Defensive Positioning screen.

You can use the Current Player combo box to set positioning for the
two groups of defensive players, infield and outfield, as well as
each individual defensive position. If Current is selected in the
Custom slot combo box, then the positioning you select will only
stay set for the current play. If you want to use a customized
positioning in the future, make sure that Custom 1, Custom 2, or
Custom 3 shows in the Custom slot combo box.

You can then move any player with movement buttons to the right
of the dialog box. Consecutive clicks move the player further each
time. Be sure to have the Top View window open on the play field
and enlarged to a size that allows easy viewing of your
positioning.

Select and move individual players until you have set the custom
locations for your players. When you select any other button on the
screen, the altered Custom Position will be saved automatically.
The Custom Position is saved until you redefine it.

Once the players are positioned as you want them, click on OK and
the players will assume their positions. The players will remain in
the set defensive position until the end of the current plate
appearance. They will then return to their default positions for the
next batter.
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LINEUP CARD

To make changes to your lineup, select the Lineup Card button on
the Defense Manage menu or Offense Manage menu.

B Season

28 Roberto Alomar SR E9 54 72 34 79 0 S50 52 49 51 52 49 51 (null)

SCURRENTLY PLAYING-
Hoiles, C.

1B Palmeiro, R.

B Alomse, R,

3B Surhoff, B,

S8 Ripken, C.

LF Devereaux M.

CF Ancderson, B.

RF Bonilla, B.

RF Tarasco, T.

Pitchers

]R Halles, C. ]

--CURRENTLY PLAYING--- |
Mussina, b,

-—-ELIGIBLE PITCHERS ---

R Benitez, A.

JIR Devereauit

wnipeis ayl uj

You can use the option buttons in the Ratings/Stats Group and
Ratings/Stats Type boxes to choose the type of statistics or ratings
to display for the selected player in the Selected Player box. To
select a player, scroll through the Position Players or Pitchers list
boxes and click on a player's name. His information will then be
displayed in the Selected Player box.

Click on OK to accept your changes or Cancel to ignore your
changes and close the Lineup Card dialog box. Click on the Other
Team button to display the other team's information. Click on the
Roster button to change the display to show a scrollable list of
ratings/stats for all players.
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Warming Up a Pitcher

A relief pitcher should be warmed up before entering the game. If
areliever is sent in before he is properly warmed up, he will not be
as effective as he would normally be and has a greater chance of
injury. Warm-up time will vary for individual pitchers, depending
upon the fatigue level, their accustomed role, and the weather
conditions.

To warm up a reliever, click on his name in the ELIGIBLE
PITCHERS section of the Pitchers listbox. Then click on one of the
two bullpen slots (Bl or B2). If you wish to have a pitcher in the
bullpen sit down, click on the Clear Bl or Clear B2 buttons.

To start a position player (non-pitcher) warming up, select the
player from the Position Players list box, then follow the same
procedures described for pitchers.

Changing Pitchers

To change pitchers, click on the new pitcher's name in the Pitchers
listbox, then click on the CP (Current Pitcher) text box. The new
pitcher will appear in the CP text box. BE CAREFUL! Be sure the
pitcher you put in the game has had a chance to warm up.

If you put a pitcher into the game who was warming up, his name
will disappear from the Bullpen box.

To put a position player (non-pitcher) on the mound, select the
player from the Position Players list box, then follow the same
procedures described for pitchers.

Making Changes in the Lineup

You can replace a defensive player by clicking on the name of the
incoming player in the Position Players listbox, then clicking on
the name of the player you wish to replace in the Lineup area. If
you are filling a vacant slot, click on the empty text box for that
position. The new player will be displayed in the lineup.

To move a player already in the game to another position, select
the new position in the position combo box (in the Lineup area,
next to his name). He will trade places with the player that was in
that position.

T
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Example: You want to remove your first baseman, move your left
fielder to first, and put a new player in left field. Click on the new
left fielder in the Position Players listbox, then click on the first
baseman's name in the Lineup display. This will switch the
players in the game. Now, select the combobox that has LF
displayed and change it to 1B. The combobox that had 1B will
automatically switch to LF.

GAME SETTINGS PoprP-UP MENU

The pop-up menu is accessed while you're in the stadium by right-
clicking your mouse in the Stadium window. From here, you can
select one of the following options:

Pause: Pauses or resumes the game in the stadium.
Help: Displays this help file. F1

Game Options: Opens a dialog box that allows you to reset several
game settings. F2

Replay: Opens the VCR control dialog box. (Not available until a
play has occurred.) FS

: CAMS: Opens the Camera Angle Management System control

dialog box. F6
Lineup: Open the lineup dialog box.F7

Exit: Exits the game with options to save the game, resume the
game in simulation or play/waich mode, or delete the game.
Ctrl+F4
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GAME OPTIONS

The Game Options dialog box contains various options theat can be
modified depending on whether you are playing a league or an
exhibition game. To display the Game Options dialog box while
you are in the stadium, right-click on the Stadium window and
select Game Options from the pop-up menu, or press the F2 key.

Advanced |7

Computer

When playing a league game, the options that cannot be changed
are ghosted (disabled). In fact, only the Controls (see "Playing
Modes” on page 107) for the home and visiting teams can be
altered during a league game.

All game options can be changed during an exhibition game,
however. This includes the playing modes, Team Options,
stadium, and weather conditions.
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GRAPHIC OPTIONS

You can access several graphic options screens from the Game
Options dialog box. These options give you control over the way
things are displayed in the 3D Stadium view. Turning options off
and setting detail levels lower will speed up the play in the 3D
Stadium view. To display the Game Option dialog box, right-click
in the Stadium window and select Game Options... from the pop-
up menu or press the F2 key. Within the Game Options dialog box
are tabs for Ball graphics, Player graphics, and Stadium graphics.

Stadium Graphics

All settings affect the speed of the play in 3D Stadium view. The
more detail, the slower the speed.

Level: Determines the number of structures to show within the
stadium.

Stadium Texture: Shows detail within the selected stadium
structures.

Crowd: Shows people in the seats.
Field Texture: Shows grass patterns.

BPI Texture: Shows batter number during the batter/pitcher
interface (BPI).

Sky Texture: Shows the cloud cover according to the day's weather
or the stadium's dome, as appropriate.

Weather Texture: Shows precipitation, if there is any.

WINDOW POSITIONING

You can position the Top View, Scoreboard, Info, and Game Update
windows on the screen wherever you want, by clicking on the title
bar and dragging the window to where you want it to be. You can
have the windows display in 2D, 3D, 2D & 3D, or not at all by
choosing the appropriate command from the cascading menus on
the Pop-up menu.

It is possible to position your windows off the screen. For example,
if you set the Top View window to be in the upper-right corner of
your screen in 1280x1024 mode of Windows, then close the game,
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then change your Windows resolution to 640x480, and restart FPS:
Baseball. The Top View window will not be visible. To correct this
problem, exit FPS: Baseball. Delete the BBPRO.INI file that is in the
directory where FPS: Baseball was installed (SIERRA\BBPROC_98).
Now when you restart FPS: Baseball, it will set the window
positions back to the default for your new Windows screen
resolution.

Player Graphics

All settings affect the speed of play in 3D Stadium view. The more
detail, the slower the speed.

When any of these check boxes are selected, that information will
be displayed over the selected player once the ball is put into play.
Choose from name, number, and position for batter, runner, on
deck, selected, battery, infield, and outfield.

You can also select which players are shown in the "Top View."

IntelliPoint graphic: activates the IntelliPoint cursor, which has
two arrows. One arrow shows the direction a fielder is facing and
the other shows the direction the fielder needs to move to make a
play on the ball. When you line up the two arrows you will be
facing in the right direction to make the play.

Ball Graphics

These check boxes will determine what is displayed in the Info
Window when it is open. (These are not the same options as
discussed in the Game Options topic.)

Radar Gun: Shows the speed of the most recent pitch.

Strike Zone Calls: Shows the location of the most recent pitch
relative to the strike zone.

Pitch Zone Indicator: Causes a shrinking box to be displayed in the
strike zone, corresponding to the pitch location. The outline of the
box will be red if the pitch will be out of the strikezone or green if
the pitch will be in the strike zone.

Caich Zone Indicator: Shows the area where the ball is headed
once it is put into play.
None turns it off.
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Fixed paints the ball-landing zone at its final location.
Floating paints the ball-landing zone on its current trajectory; this
zone drifts as the ball drifts.

Magnify: increases the size of the ball as it is displayed on screen.

Trail: adds a "trail" to the ball to allow you to track it easier once it

is put into play. The length of the trail is determined by the Trail
Length scroll bar.

Trail Length: determines the length of the ball trail; the larger the
value, the longer the trail. This value has no effect, if the Trail
option is not checked.

Home/Away Difficulty

This tab displays controls for setting batting, fielding, and
baserunning difficulty levels. FPS: Baseball includes a couple of
new fielding aids for the beginner:

Smart Move™: enables you to point a player in the “general
direction” of a location on the field to make a play rather than
requiring you to point exactly in that direction.

Smart Throw™: takes all the guesswork out of throwing the ball. If

you are making a play, simply press the keyboard or joystick
control and the ball will go in the right direction.

Display Windows

You can access these "Display Windows" settings from the Game
Options dialog box.

Top View: Displays a window with an overhead view of the
playing field, which can be positioned anywhere on the desktop. A
white dot is used to represent the ball and a flashing yellow circle
is used to represent the landing zone. Players are represented by
different color dots, depending on their current role in the ball
game. Offensive players are shown as red dots. The selected
defensive player shows up as «a yellow dot and the rest of the
fielders are represented by blue.
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You can select which groups of players are visible in the Top View
by modifying the entries in the "Player Graphics” tab of the Game
Options dialog box.

Note: When the defensive positioning dialog box is open, all
defensive players show up as blue dots, regardless of the
settings on the "Player Graphics” tab. It is a good idea to have
this window open when you are setting the positions of the
defensive players on the field.

Scoreboard: Opens or closes a scoreboard window; you can
position this window anywhere on the screen. This shows the
inning, score, number of runs, hits, errors, balls, strikes, and outs.

Player Info: Displays a window with the following information (you
can position this window anywhere on the screen):

Pitcher - the ratings of his four best pitches; a white square
shows up around his most recently thrown pitch.
Batter - his contact hitting, power hitting, and speed ratings

Baserunners - who is on base and their speed ratings

Pitcher Info: Displays a window with the following information
(you can position this window anywhere on the screen):

Strike zone - where the last pitch was thrown relative to the
strike zone

Radar - the speed of the last pitch.

Game Updates: Displays starting game conditions and player
information by inning; you can position this window anywhere on
the screen and resize it as desired.

Fullscreen 3D: Causes the display window to expand to full-screen
size, when the stadium switches to 3D view.

SOUND SETTINGS

To change sound settings in the game, right-click on the Stadium
window and select Game Options... from the pop-up menu. Then
click the Sounds tab.
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Action sounds are umpires sounds, the crack of the bat, and so on.
Heckler sounds are fans and vendors.
Crowd sounds is the background fan noise.

To turn these off, click on the Mute checkbox in the Action box. To
increase the volume of these sounds, slide the scroll bar in the
Action box to the right (larger values). To decrease the volume of
these sounds, slide the scroll bar to the left. Click on the Test button
to play a sample sound at the new volume.

You can turn the Distance and Stereo effects off by clicking in the
check box. You can choose between high-quality and normal-
quality sounds, using the option buttons in the Sound Quality box.

Using normal queality sounds, or using Mute to turn sounds off may
improve game performance. Note: if you install normal-quality
sounds during the FPS: Baseball install process, and select High-
Quality in this dialog, FPS: Baseball will attempt to play the
sounds from the FPS: Baseball CD, which may adversely affect
performance.

Click on Save Settings button to save these sound settings for
future games (until you change them again).
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VIEWING ON-FIELD ACTION

FPS: Baseball offers the unique Camera Angle Managem.ent
System (CAMS) which allows you to change a camera's location,
angle, and direction at any time, even while the play is running.

If you change a camera position during a play, the play will pause
while you make the changes. When you resume the play, the new
camera settings will be used. This gives you a level of camera
control that even sportscasters can only dream about. You can
personalize the camera coverage of the game to suit your tastes
and viewing preferences.

Along with the multi-featured CAMS, you can record any play,
utilize the CAMS features during the taping of a play, keep a
library of tapes, and use the VCR control window for instant
replays.

CAMERA AND REPLAY MODES

FPS: Baseball provides a variety of options for controlling the
cameras that cover the on-field action. To get to the Camera Angle
Management System (CAMS) control window, press the F6 key, or
right-click anywhere within the playing field during a game, then
select CAMS from the pop-up menu. This dialog box opens with
"Basic” settings displayed. These are preset camera angles that
you can select by clicking one of the radio buttons.

You can click Advanced... if you would like to choose from some
more precise options for controlling the Location, Height, Zoom, and
Rotation of the camera. There are also options for selecting from
seven different camera modes and selecting a number of targets.
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5 [Presets

Controls

Location: dollies camera forward/backward/left/right
Height: raises/lowers camera

Zoom: zooms camera in/out

_ Rotation: pans camera left/right/pitch up/pitch down

- Modes

Additional controls (Location, Height, Zoom, Rotation) are only
available in certain modes.

Free Floating: Stationary camera that you can place anywhere in
the stadium facing in almost any direction. This camera does not
{rack or zoom on any object.

At Target: Places the camera at the point of view of the selected
target. The selected target can be any player on the field (offensive
or defensive), the fielder who is fielding the ball, the ball itself, or
the destination toward which the ball is headed (the catch zone).

Track Target: The camera stays positioned between the target and
the backstop to track the target as it moves. As with the At Target
mode, you can select any player on the field, the fielder, the ball, or
the catch zone for your target.

Follow Target: The camera will reposition the screen so it always
remains at the target's back and keeps the target in the center of
the screen. As with the At Target mode, you can select any player
on the field, the fielder, the ball, or the catch zone for your target.

Trail Target: Trails the target from behind at a set distance. The
camera will reposition itself to always remain at the target's back.
As with the At Target mode, you can select any player on the field,
the fielder, the ball, or the catch zone for your target.

Static TV: Pans in any direction to track the selected subject, and
will zoom in and out automatically to keep the subject at a constant
distance. This stationary camera can be placed anywhere, but its

~ physical location will not change while tracking.

Target Area: Allows you to define preset cameras for each of the

- nine field regions (listed in the Target drop down menu within the
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CAMS dialog box). You can change the position of each camera by
first selecting the appropriate field region, then using the
directional edit keys. When this mode is active, the camera (for the
selected field region) will center on the catch zone while the ball is
in the air. Once the ball hits the ground, the camera will "track" the
ball until the ball leaves that camera's region.

The Active region refers to the one where the ball is in play. It can
be any of the nine regions where the cameras are located. Camera
positions cannot be changed when Active is displayed in the
Target box. Active should be displayed in the Target box when you
exit the CAMS dialog box.

Reset Mode: resets Mode to the FPS: Baseball default setting.

Reset CAMS: resets all settings in the dialog box to the FPS:
Basehball default settings.

Save Settings: saves the settings as they are displayed in the
dialog box; these setting will then be used for all future games
until you change them again.

INSTANT REPLAYS AND
HIGHLIGHT TAPES

You can view Instant Replays of all on-field action in FPS:
Baseball. After any play, press the F5 key or right-click once in the
Stadium window and select Replay from the pop-up menu to open
the VCR.

From the VCR, you can view o replay as many times as you wish,
changing the speed and direction of the tape each time. When you
are done viewing the replay, you can save it to disk for future
viewing. You can also open saved tapes from the VCR dialog box.
The VCR interface controls are shown in the following picture:
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Load Tape
X

Rewind to beginning
Save Tape Fast Reverse

Forward to end
FastPlay

Reverse
Play

Slow Motion

Open: Load VCR tapes.
Save: Saves VCR tapes.

OK: Closes the VCR Control Panel and returns you to the playing
field.

Beginning: Jumps to the beginning of the tape.
Fast Reverse: Runs the play backward at fast speed.

Reverse: Runs the play backward at normal speed. If Pause is
turned on, the play will step back one frame per click.

Pause: Pauses replay. Pause will remain locked until you uncheck
it. Once you uncheck it, you need to click on Play to resume. If it is
activated, pressing the Play button will advance the replay one

frame. Pressing the Reverse button will reverse the replay one
frame.

Play: Runs the play forward at normal speed. If Pause is turned on,
Play moves the play forward one frame at a time.

Fast Play: Runs the play forward at fust speed.
End: Jumps to the end of the tape.

Slow: Plays the tape at half speed. To resume normal speed, click
the Slow check box again.

When you save replays to disk as a VCR tape, you can rerun, reedit,

and resave the camera views on the play as many times as you
wish.

To edit a tape you are viewing, open the CAMS control window by
pressing the F6 key or by right-clicking in the Stadium window and
selecting CAMS from the pop-up menu. As long as the CAMS
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control window is on the screen, you are able to alter the viewing
perspectives for the current replay.

The camera positions you select while rerunning tapes can be
included on the tape. To record the new camera position, the
camera positioning interface must be showing, and the frame must
be "played" with the new camera settings. Once recorded, the new
camera settings will be saved with the tape.

SAVING GAMES

To quit a game in progress, click the right mouse button anywhere
on the Stadium window and select Exit from the pop-up menu or
press Ctrl + F4. You will be prompted to Exit Stadium? Yes / No. If
you select No, you will return to the Stadium. If you select Yes, the
dialog box shown below is displayed.

Play/Watch: Returns to the stadium in Play mode (see "Play vs.
Simulate” on page 138 for more information)

Simulate: Returns to the stadium in Simulate mode (see Play vs.
Simulate for more information)

Save for later: Saves game; select Resume Saved Game from the
Mcain menu to resume the game

Delete: Removes all game data; you must restart the game from the
beginning
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)
'LEAGUE MANAGEMENT OVERVIEW

I:F'PS: Baseball allows you to manage every aspect of a major
league baseball association. You can choose to focus your efforts

On one team in the association or you can rule over your entire
baseball world.

When you click League Management from the FPS: Baseball
Btartup screen, the Association Data screen is displayed.

Note: If you find yourself clways wanting to go directly to
League Management, you can edit the BBPRO.INI file to
bypass the startup screen.

In this manual, we will refer to the League Management part of the
fjame as the Front Office. Management responsibilities are carried
out on both an Association-wide basis and on a team-by-team
basis. You might find it convenient to set most of your team and
league activity to be automatically handled by the computer so
you can focus on one team. Or you can also take a more active role
In managing the teams in your league. The possibilities are
sndless with FPS: Baseball.

PREFERENCES

T'he Preferences dialog box allows you to change certain settings
‘while you are in the Front Office.

Team: This text box shows the default team and/or Association that
Wwill be loaded when the program is started. To change the team,
Blick on the text box. A dialog box will be displayed that shows the
g,ﬁ.ssociaiion name at the top and the teams below. To select a
different Association, click on the Association name text box.

other dialog box will appear, allowing you to select a new
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Association. When you click OK, the team selection dialog box will
reappear. You can then select the team and click OK.

Startup Screen: This text box shows the screen which will be
loaded when you first go to the Front Office. To change the Startup
Screen, click on the text box. A dialog box will appear, showing a
list of the screens you may select. Click on the screen you want,
then click OK.

Music: Turns the background music on or off.

Print To File: When checked, any data that you print on any screen
will be added to the end of a file called PRINT.OUT in the directory
where BASEBALL.EXE is located. If this box is not checked, the data
will be sent to-your printer.

ASSOCIATION OVERVIEW

An Association in FPS: Baseball is defined as a group of 8-48 teams,
divided into 1-3 independently scheduled leagues made up of 8-16
teams each, divided into 1-3 Divisions. FPS: Baseball supports two
types of Associations:

Career: Career associations take on a life and history of their own.
At the end of each season, players are subject to the effects of
aging, with some players electing retirement. Fictional high
school and college players are generated for the amateur dratt,
each with abilities ranging from one-dimensional players who
may never play in games, through the players of average skill, to
the star players who may eventually be elected to the Hall of Fame.
As players age, the younger ones see improvements in their skills
while the skills of older players decline. Spring training is not only
used to maintain and sharpen skills for the coming season, it can
be an opportunity to accelerate a player's growth or to slow the
decline of an older player.

Although the winning and losing happens on the field, it is guided
and planned in the front office. As Owner and General Manager of
a tegm in a career association, you will be faced with the
challenge of building and maintaining an organization that will
be competitive for more than just the current season. You will be
faced with the loss of players due to injuries, retirement, or simply
the effects of age. You will need to field a competitive team with
the depth to endure injuries to key players, yet you must keep an
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..ye on the future, growing the kind of players that can be the
tornerstone of your organization for the next 20 years.

_.Bingle-Secmon: Allows you to play one or more seasons with the
Same group of players. Because there is no need for new players
I ‘thel a@ateur and free agent drafts, player retirements, and spring’
Iraining are skipped, although you may still elect to start the
association with an initial player draft. Players may have their

.;easons ended by injury, but will have their injuries cleared when
I new season is started.

- The following outline portrays the life cycle of an association:
1. Create an Association
2. Initial Player Draft (optional)
- . Spring training (career associations only)

Spring Training occurs prior to the first season only if an Initial
Player Draft was held.

4. Regular season play begins

FPS: B‘crsgbcrfl automatically schedules games for each team in an
. Association. Teams play games every day, although there are off

days in each full-season schedule. All games for a current day

:lnust be resolved before the association can proceed to the next
ay.

5. Amateur draft (career associations only)

B. Regular season play continues

7. All-Star game (full-season schedules only)

8. Regular season play continues

On September 1 active rosters may be expanded to 40 players (full-
- Beason schedules only).

8. End of regular season play

10. Playoffs begin (except 8 and 10-team associations)

11, Playoffs end

MVP, CY Young, Rookie of the Year, and Triple Crown awards are
given out.
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12. Start new season

In career associations, all players undergo the effects of aging,
with some choosing to retire. = Outstanding retirees may be
nominated for election to the Hall of Fame and existing nominees
may be elected. With single-season associations this resets all
injuries, generates a new schedule, and makes the association
ready to repeat the cycle with step 4.

13. Free agent draft (career associations only)

14, Go to Step 3.

ASSOCIATION NEWS

The Association News screen gives you the opportunity to see
what's happening with all the teams in your Association for the
current day, without going to each team's Team News screen. The
Transactions report in the upper half of the screen shows roster
moves and trade proposals. The lower half of the Association News
screen shows the injury status for the Association's players. Unlike
the Team News screen, you cannot click on any of the entries in the
list boxes to perform an action.

The Action Menu

Print: Prints the Association's transactions and injuries.

ASSOCIATION DATA

The Association Data screen allows you to modify names of
various structures of the Association and reset the ownership and
Computer GM (General Manager) options for all teams in the
Association.

Text Fields

You may edit any of these fields at any time.

Association: The Association's name. It may be up to 32 characters
long.

League 1. 2, 3: The name of each league. Each may be up to 32
characters long. If there is only one league in an Association, it
does not have a separate league name.

Abbreviation: The abbreviation for each league. Each may be up to
four characters long.

Division 1, 2, 3: The name of each division. Each may be up to 16
characters long.

Cheampionship Trophy: The trophy name can be up to 32 characters
long.

Check Boxes

Ground Rules: For a Single-Season Association, you may set the
ground rules prior to the first game of any season. For a Career
Association, you may set them prior to the first game of the first
Beason.
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Designated Hitter: You may turn the DH rule on or off for each
league separately prior to the first game of any season.

Use ratings: Turns the use of individual player ratings on or off.
When it is turned off, all players' skills are rated as Average (50).

Injuries: Turns injuries on or off. When it is turned on, players may
be injured and have to leave the game.

Fatigue: Turns pitcher fatigue on or off. When it is turned on,
pitchers tire as the game progresses according to their Endurance
rating and the number of pitches thrown.

Base Stealing: Turns base stealing on or off. When it is turned on,
base runners may attempt to steal.

Fielding Errors: Turns the possibility of fielding errors on or off. If
it is turned off, all throws are on target and fielders will not make
errors, although there still may be balls that they cannot handle.

Pitch to Center: Disables the Pitch Location variable. When it is

turned on, all pitches will be thrown down the center of the plate.

Items You Can't Change

Type: The type of the Association, Single-Season, or Career is set
when the Association is created and cannot be changed.

The Action Menu

Reset teams: Brings up the Reset Teams dialog box that allows you
to modify the ownership or Computer GM options for ALL teams in
the Association in one easy step.

Print: Prints the Association Data.

RESET TEAMS DIALOG Box

The Reset Teams dialog box allows you to change the ownership
or General Manager (GM) options for ALL the teams in the
Association at once. To display this dialog box, select Data from
the Association menu. Then select Reset Teams from the Action
menu.

The Reset Teams dialog box consists of two sets of radio buttons.
The first set allows you to make chunges to the ownership,
between Human or Computer, or you can elect to make no changes.

The second set of buttons allows you to make changes to the
Computer GM options of all human-owned teams in the
Association. If you made no changes to the ownership, the
Computer GM options will affect all teams that were human-
owned before you selected Reset Teams. If you changed all teams
to humen-owned, the Computer GM changes will be made to all
teams. If you changed all to computer-owned, the Computer GM
options are ghosted and unavailable. You may also choose Make
no changes here.

(If you set both the Ownership and Computer GM options to Make
no changes, nothing happens at all.)

ASSOCIATION STATISTICS

The Assocication Statistics screen can be used to compare statistics
for all players or teams in an Association by league. To display this
screen, select Statistics from the Association menu. The statistics
display consists of ten columns of data, eight of which can be set
by you. To change the data displayed in any column, choose
Change Columns from the Action menu. You may sort the data
shown by any of the columns by clicking on the column heading.
That heading is then shown in white letters.

You can also view individual player stats by league. To do this,
first select Players from the Show menu. Then you can customize
the statistics shown with the Choose Players options from the
Action menu as well as the other options available from the Show
menu (outlined below).

The Action Menu

Change Columns: changes the data displayed in any of the eight
configurable columns.

Choose Players: selects which players are to be displayed.

Print: Prints the information that is on-screen for all players
currently in the list.
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Print Top 50: Prints the information that is on-screen for only the
top 50 players currently in the list. To change the order of players
in the list, click on a column heading to sort the list.

Print Column Leaders: Prints the top 10 players in the current list,
and only the information that is displayed in the selected column.
For instance, to check out the home run leaders, click on the
column header for home runs (HR), which sorts the list, then select
Print Column Leaders from the Action menu. The top 10 leaders in
HR for the league are printed, along with the number of home runs
for each.

The Show Menu

Leagues: Selects the league to be displayed. (If the current
Association is a single-league Association, the area of this menu
is left blank.)

Teams: Sets the statistics display to show team totals by league.

Players: Sets the statistics display to show players. The players
shown are determined by the Choose Players dialog box in the
Action menu.

Retired Players: Sets the statistics display to show a list of players
who have retired since the Association was formed. This is valid
only for Career Associations.

Historical Data: Shows the historical statistics for the players
shown. NOTE: Historical data is not kept for teams. This selection
shows the totals of the historical statistics for the players on each
team. It is only available if historical statistics were copied as part
of the Association creation process.

Accumulated Week: Shows the statistics generated in FPS:
Baseball for the past seven game days.

Accumulated Season: Shows the statistics generated during the
current season.

Accumulated Career: Shows the statistics generated for each
player during his FPS: Baseball career. (Historical statistics are not
included.) Not available for teams or if the current Association is of
the Single-Season type.

Batting/Fielding Stats: Shows batting and fielding data.
Pitching Stats: Shows pitching data.

See also Roster and Statistics Screens.
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CHOOSE PLAYERS DIALOG BOX

The Choose Players dialog box allows you to narrow the list of
players displayed in the Associations Statistics display.

There are two sets of option buttons. The first allows you to show
players of all positions or to select positions. In the dialog box
shown below, catchers and second basemen have been selected.

25 T e e
| O An Positions

The second set of option buttons allows you to show all players at
the positions selected, or just those who meet the minimum
playing time qualifications. To qualify for inclusion in the batting
statistics, a player must have a minimum of 3.1 plate appearances
(PA) per game that his team has played. To qualify for inclusion in
the pitching statistics, a player must have at least 1 inning pitched
(IP) per game that his team has played.

ASSOCIATION SCHEDULE

The Association Schedule screen allows you to examine the daily
schedule for any league in the current Association. To display this
screen, select Schedule from the Association menu. When the
screen is displayed, the current game date is shown. To look at
other dates in the schedule, use the Date option under the Show
menu to jump quickly to a specific date; you may also click on the
buttons at the bottom of the screen to move backward or forward by
a day or a week at a time. You may view the schedule for other
lecgues in the Association by selecting the league name from the
Show menu.

For games that have not been resolved, the League Schedule
shows the pitchers scheduled to start the game, their respective
Won-Lost records, and their current ERA. For games that have
already been played, the League Schedule shows the final score. It
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also shows the winning and losing pitchers, as well as a save, if
one was earned.

You may use this screen to play or simulate league games or to
view box scores for games that have been played within the last
game week. To start a single game, click on the option button next
to the game listing to set the game to Play or Sim, then click on the
game listing itself (right on the words 'STL AT CIN' for example) to
start the game. (For the differences between Play and Simulate,
see "Play vs. Simulate” on page 138.) I the Sim button is set, the
computer will cutomatically simulate the selected game. If you
have set it for Play, you will be asked to choose the controls for
each Human-owned team in the game. (For more information on
controllers, see "Playing Modes” on page 107.) Next, you will be
asked to confirm the starting pitcher and lineup for each Human-
owned team in the game. See "Set Starting Pitchers & Lineups” on
page 140.

To simulate multiple games at once, select the Simulate command
on the Action menu. A dialog box will be displayed, allowing you
to specity the range of games to be simulated.

Note: All games from previous days must be completed before
a new game can be started.

If the game has been completed within the last 7 game days and
the score is displayed, you can view the box score by clicking on
the game listing itself (right on the words 'CIN 3, STL 0' for
example)

The Action Menu

Simulcte: Brings up the Simulate Games dialog box, which allows
you to simulate groups of games.

Print: Brings up the Print Schedule dialog box that allows you to
print one or more days in the league schedule.

The Show Menu

Date: Brings up a dialog box that allows you to select a date for
which the schedule is to be displayed. To change the date, move
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the slider or use the left and right arrow button until the desired
date is shown.

Leagues: Selects the league to be displayed. (If the current

Association is a single-league Association, the area of this menu
is left blank.)

Playoffs: Takes you to a screen that shows the status of the
playotts. This command is available only after the regular season
has been completed.

SIMULATE GBEMES DiaLoG Box

This dialog box, which is available from the Action menu when the
Association or Team schedules are displayed, offers you a choice
of three option buttons. These choices allow you to simulate games
for three different time frames.

Today's games only: Simulates all games on today's schedule that
are set to Sim. Afterward, if all of today's games have been
resolved, the game date will be advanced, and all between-days
activities (resolving free agent claims, healing injuries, etc.) will
be completed.

All games until next 'Play" Simulates all games set to Sim, until
the game date cannot be advanced because games are set to be
Played, rather than Simulated. If no games are set to Play, the
simulation will continue through the end of the season. (Playoff
games are set to Play by default.)

All games until date: Simulates all games set to Sim until a date
you specify. You may choose any date up to the end of the regular
season. The simulation will be interrupted if any games are set to
Play prior to the date selected. To choose a date, move the slider
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until the desired date is shown, or use the left and right arrows to
go backward and forward.

If either of the last two options are chosen, the simulation will be
interrupted if an injury causes any player in a starting lineup or
pitching rotation to be unable to play, if that team is Human-owned
and does not have the Reassign players function of the Computer
GM turned on.

PRINT SCHEDULE DIALOG BOX

The Print Schedule dialog box allows you to print the schedule for
the currently selected league. To display this dialog box, click on
Print in the Action menu of the Association Schedule screen. You
have three printing options:

Today's schedule only: prints the schedule of games for the current
date only.

From-To any dates you choose: you select the range of dates to be
printed.

Full season schedule: prints the entire league's schedule.

Scores for games that have already been completed will be
printed.

ASSOCIATION STANDINGS

The Association Standings screen displays a variety of
information relating to the Won-Lost records of the teams of each
league in the Association. To display this screen, select Standings
from the Association menu. The following information is
displayed:

Team: Team name

W: Number of wins.

L: Number of losses.

Pct.: Winning percentage.
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GB: Number of games each team is behind; this is the number of
games that the team would have to win and the top team would
have to lose in order for the team to move into first place.

l-run: Record in games decided (won or lost) by one run.
X-inn: Record in extra inning games.

L-10: Record for last 10 games.

Strk: Current winning or losing streak.

Home/Road: Home or away records. (Click title to switch between
Home and Road.)

vs. LHP/vs. RHP: Each team's Won-Lost records against either left-
or right-handed starting pitchers. (Click title to switch between vs.
LHP and vs. RHP.)

In Div/NonDiv: Won-Lost records against teams in division or
teams out of division. (Click title to switch between In Div and
NonDiv.)

To display the standings for another league in the Association,
select that league from the Show menu. Standings can be printed
by selecting Print from the Action menu. The Standings will be

printed using the current information displayed. If you wish to

print other information, change the on-screen display before
printing.

The Action Menu

Print: Prints the League Standings.

The Show Menu

Leagues: Selects the league to be displayed. (If the current
Association is a single-league Association, the area of this menu
is left blank.)

Playofis: Takes you to the Playolfs screen that shows the current
status of the playotiis. This option is not available until the regular
season has been completed.
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ASSOCIATION HISTORY

The Association History screen provides a look at the past
achievements for the current Association. You may open this
screen at any time by selecting the History command on the
Association menu. There may be times when one or more of the
lists is empty, because no player or team has won the award yet.
For example, when you create a new Association, all of the lists
will be empty, until the first season has been completed. Likewise,
there may be years when no player wins the Triple Crown award.

Tony Phillip
Ryne Sandberg |
Dzrzie 1

Larrvy Walker (T
Ray Lankford
Jose Vizoai
Robin Ventuo
Jim Thome
Kenny Lofton

Ricky Bones (P, N¥
Brian Anderson IF, CLE} ali

The following items can be displayed on this screen, by selecting
the appropriate command from the Show menu. The Show menu
also lists the league names, which you can select to display the
awards (MVP, Cy Young, Rookie of the Year, Triple Crown) for
different leagues in the Association.

Champions: Shows the championship teams and their World
Series record from prior seasons. In associations without
scheduled playoffs, the team's seasonal record is shown instead of
the record in the non-existent World Series.

Hall of Fame: Players who have shown outstanding performance
over the course of their career may be nominated for election into
the association Hall of Fame. To be eligible for nomination, a
player must have played at least 10 years, or every year in an
association's history, and must have made a certain impact on the
association. Nominated players are eligible for election 5 years
after retirement and remain eligible for 15 more years.

76

Each year the most qualified of eligible retirees are elected for
enshrinement in your Hall of Fame, but only a limited number are
gelected each year. Marginally qualified players may find
themselves at the bottom of each year’s eligibility list and may
never get elected to the Hall of Fame before becoming ineligible,
but given a period of time when the relative level of player
accomplishments is low, the marginally qualified player may get
enshrined.

Player accomplishments are measured statistically for each
geason and for the player's career as a whole. Players are given
credit for each statistical accomplishment as well as reaching
gertain "magic’ milestones, such as 3000 hits or 300 wins, and a
host of others. If the player wins any seasonal awards or is an
important member of winning teams, particularly if he plays an
important defensive position, such as catcher or shortstop, he will
have a greater chance of being nominated and elected. (Note: the
Hall of Fame is not available for Single-Season Associations.)

Most Valuable Player Award: Awcarded to the most valuable
player in each league with pitchers being ineligible. Individual
statistical accomplishments and milestones (such as hitting 30
homers and having 30 stolen bases), relative team strength, and
defensive importance all contribute to the selection.

Cy Young Award: Awarded to the top pitcher in each league and
awarded to pitcher's based on their statistical accomplishments
and milestones (such as winning 20 games or having 30 saves).

Rookie of the Year Award: Awarded to the top roockie in each
league, being a player with an Experience of 0. Players with 0
Experience will not get a year of experience awarded to them each
season as long as they remain in the minor leagues, but once they
appear in a league game, they will increment a year of Experience
each season, whether they play or not. The Rookie of the Year
award can be given to either a pitcher or a position player and is
based on the same criteria as are used to select the MVP and Cy
Young award winners.

Triple Crown: Not really an award, but more an acknowledgment
of this rare accomplishment. The Triple Crown is awarded to any
player who leads his league in Batting Average, Home Runs, and
Runs Batted In. A player may be tied for the lead in homers or RBI,
but must lead the league outright in baiting to win the award.
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The BAction Menu

Print: Prints the currently displayed data.

DRAFT ROSTER

The draft screen handles the drafting of players. To display it,
select Start/Resume Draft from the Association menu.

The roster display consists of ten columns of data, eight of which
can be set by you. To change the data displayed in any column,
choose Change Columns from the Action Menu. You may sort the
data shown by any of the columns by clicking on the column
heading. That heading is then shown in white letters.

The Action Menu

Set Criteria: Brings up the Set Criteria dialog box, which allows
you to select the players to be shown.

Skip Round: Causes the team to not choose a player in the current
round, if the team's draft functions are human-controlled.

Skip Draft: Causes the team to not choose any more players in the
draft, if the team's draft functions are human-controlled.

Start/Continue Draft: Causes the draft selection process to begin or
resume from where it left off. If the team's draft functions are
computer-controlled, the computer will select the player to be
dratfted, display a message of who was dratted, and pass control to
the next team. If the team's draft functions are human-controlled,
you select the player to draft by double-clicking on his name in the
roster display. You can specity whether draft functions should be
human conirolled or computer conirolled on the Team Data screen.

Restart Draft: Puts all players for all teams back into a common
pool for drafting. This option is available only for the Initicl Draft,
not for the Amateur or Free Agent Drafts. In the confirmation dialog
box that appears, you may choose to use the Same Order or New
Order for drafting. If you select New Order, FPS: Baseball will
randomly choose a new order for the drafi.

Print: Prints all of the displayed players in the draft list.
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Print Top 50: Prints the first 50 players in the draft list. To rearrange
the order of the players, click on o column heading to sort the list
by that column.

Print Column Leaders: Prints the first 10 players in the list and the
‘gelected column of data. To select a column of data, click on the
heading.

' Change Columns: Brings up the Change Columns dialog box that
‘allows you to choose the statistics to be displayed in each column
of the roster display.

Draft Delay Time: Brings up a dialog box that allows you to specify
the time (from 0 to 30 seconds) that FPS: Baseball will wait between
computer-controlled teams making draft selections. Caution: if you
get the time to 0, you will not be able to interrupt the draft until it is
complete, if there are no human-controlled teams.

The Show Menu

Draft Order: Shows the order the teams will pick in the draft.

Historical Data: Shows the historical statistics for the players
shown. NOTE: Historical data is not kept for teams. This selection
shows the totals of the historical statistics for the players on each
team.

Accumulated Week: Shows the statistics generated in FPS:
Baseball for the past seven game days.

Accumulated Season: Shows the statistics generated in FPS:
Baseball during the current season.

Accumulated Career: Shows the statistics generated for each
player during his FPS: Baseball career. (Historical statistics are not
included.) This option is not available for teams, or if the current
Association is of the Single-Season type.

Batting/Fielding Stats: Shows bdtting and fielding statistics.

Pitching Stats: Shows pitching statistics.
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SET CRITERIA DIALOG Box

This dialog box allows you to narrow the list of players to just the
ones you want to see while you are drafting or trading players, or
signing free agents.

Pitchers: These option buttons allow you to select the throwing
hand of the pitchers shown.

Batters: These check boxes allow you to set the batting hand of the
players to be shown. You must have at least one of these boxes
turned on.

Positions: These check boxes allow you to set the positions of the
players to be shown. You must have at least one of these boxes
turned on. 'Utility' players are those who qualify at multiple
positions, at least one of which is not in the outfield. (For example,
a player who is qualified at LF and RF is not a utility player, but
one who is qualified at LF and 3B is.)

Minimum Ratings: When any of these check boxes are turned on,
all players who do not meet the minimum rating are eliminated
from the list. However, the Position player minimums are not
applied to the Pitchers listed, and vice versa.

Age: You may set one or both of these check boxes to restrict the
age range of the listed players.

LOADING AN ASSOCIATION

The Load Association dialog box allows you to load a new
Association. Only one Association can be loaded at a time.

To load a new Association:
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ll Select the Load Association command from the Main menu.

2. Scroll through the list of Associations in the dmlog box that
uappears. Click on the desired Association.

3. Click the OK button.

Deleting Associations

?f'ou can also use the Load Association dialog box to delete an

- Association you no longer want. (You can use the BBArchive utility

{o back-up the Association before deleting it).

To delete an Association:

1. Make sure that the Association that is currently loaded in FPS:
Baseball is NOT the one you want to delete (you can not delete the
currently loaded Association). Look at the status bar at the bottom
of the screen. The Association name is displayed on the right. If
this is the one you want to delete, you need to load a different
Association using the steps listed above.

2. Select the Load Association command from the Main menu.

8. Scroll through the list of Associations in the dialog box that
appears. Click on the desired Association.

4. Click the Delete button.

5. A dialog box will prompt you for confirmation before deleting the
Association.

CREATE R NEw ASSOCIATION

FPS: Baseball not only allows you to manage a professional team,
but you can create entire Associations consisting of leagues and
divisions organized to satisfy your baseball dreams. You have the
freedom to mix historical teams with MLBPA teams from the
current season. You can even enter your own favorite teams from
the past or faniasy teams for use in your Associations using
Dataln.

To build a new Association:

1. Select the Create New Association command from the Main
menu. The New Association Configuration menu appears. Here
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you select the number of teams, league and divisional alignment,
and set the new Association as either Career or Single-Season.

2. Select teams from existing Associations that will be copied into
the new Association on the Select Teams screen. You may select
any team from any Association, including Associations created
with Dataln.

3. Specify whether to dump «ll players from the teams into a free
agent pool so they can be redrafted during the Initial Player Draft.
You can also select a single Association to dump players from into
the Initial Player Draft.

Specity whether to copy historical und career stats. If you choose to
copy historical stats, your Association will require more disk
space, but you will have access to the player's real life statistics
from the Association Statistics and Team Statistics screens. If you
choose to copy career stats, your Association will require more disk
space, but you will have access to the player's statistics that were
generated in the previous FPS: Baseball Association.

The computer will then take a few moments to begin creating the
new Association.

4. Select the schedule length from the "Select Schedule Length'"
dialog box. There are three schedule lengths available for all
Association configurations:

The computer will finish creating your new Association and will
then display the Association Data screen, where you can edit the
names of the Association, leagues, division, and set ground rules,
and reset team ownership/controls.

NEw Ass'N: TYPE &
CONFIGURATION

To start a new Association, you must specify its type and
configuration by selecting Main menu > Create New Association.

Click on the arrow buttons at the top to set the number of teams. An

Association may have from 8 to 48 teams. Selecting the number of
teams will automatically determine the league and division

configurations available for that particular number of teams. FPS:
Baseball provides 48 Association/league contigurations.

Below the "slider" control that sets the number of teams are option
buttons for setting the Association type to either Career or Single-
Season. In Career Associations, new players are drafted each year.

As the seasons pass, these players accumulate career statistics,
age, and eventually retire. In Single-Season Associations, no

drafts take place, no players age or retire, and no career totals are
recorded. This choice is final - once you leave this dialog box, the
only way to change it is to delete the Association and start over.

After you have set the number of teams and selected the league
configuration and Association type, click on the OK button. The
program will take you to the Select Teams screen.

NEw ASSOCIATION: TEAM

SELECTION

The TeamSelection screen allows you to select the teams to be
copied into the new Association you are creating.
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Note: The Muain, Association, Team, and Show menus are
ghosted and unavailable on this screen. To leave this screen,
vou must select either Continue or Cancel from the Action
Menu or click on the Continue or Cancel buttons at the bottom
of the screen.

The screen is divided into two sections: a Source section and a New
Association section. The Source section has a text box which
shows which Association is loaded. You may click on this text box
to bring up the Select Association dialog box to load a new source
Association from which you can select your individual teams. You
may select teams from several different Associations for your new
Association.

Also in this section are two sets of radio buttons for leagues and
divisions. To the right is a list box which displays the teams
available from the selected league/division. Use the radio buttons
to specify the league/division combincation and display the list of
corresponding teams.

The lower section contains a text box for the name of your new
Association, two sets of radio buttons with text boxes for new
leagues and divisions names, and a group of 10 text boxes for
teams. Set up your new league and division names by selecting
the appropriate radio button, clicking in the text box, then typing
in a new name.

Select Teams

The text boxes to the right show the default teams that will be
copied into the new Association. By default, teams from the MLBPA
will be placed in the slots. To change any team, select the new
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team name from the list in the Source section above, then click in
‘one of the team slots in the New Association section (1 through 10,
depending on division size). Be sure you have the league and
division radio buttons set the way you want before placing the
team. A small square will be displayed to the right of the text box,
to indicate that the team to be copied in is a non-default team.
Don't worry about the team names at this point, as you will be able
o change them in the Team Data screen after you are finished

creating the Association.
|

‘When you select teams, you may use teams from any existing
Association, including the single-team Associations created by the
:;-,DATAIN program. (For more information about entering teams
{rom the past into FPS: Baseball, see “Entering Custom Team Data
‘With the Dataln Utility” on page 152.) Teams retain the team data
they had in their previous Association, including the type of
‘ownership (Human or Computer).

-ﬁemember, you can change the default names for the Association,
leagues, and divisions. Click on the text box you wish to change
and then type in a new name.

After you have made your changes to league and division names
and you are satisfied with the organization and placement of
feams in your new Association, click on the Continue button or
thoose Continue from the Action Menu.

The Action Menu

il.occd new source: Allows you to load another Association as a
;iource for the teams to be copied into the new Association.

Continue: Continues the New Association Creation process.
Cancel: Cancels creation of a new Association.

You may buy and sell teams within your Association after it is
created. For more information on how to do this, see “Buying And

Belling Teams” on page 107.

'he Player Options dialog box, which is automatically displayed
s you go through the process of creating a new association, gives
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you several options about the players you will be adding to your
new Association.

Copy Player Historical Statistics: copies all players' historical
statistics from their previous Association into the new Association.
Historical statistics are "real-life" statistics, that either come from
the Associations that ship with FPS: Baseball or from Associations
created with the Dataln utility.

Copy Player Career Statistics: copies all players' career statistics
from their previous Association into the new Association. Career
statistics are FPS: Baseball-generated statistics.

Dump All Players into a Common Drait Pool: creates an initial
player draft. If you select this option, all the players from the teams
you placed in the new Association are placed in a pool. Initial
rosters are then determined by a player draft. The draft order is
randomly determined in an Initial Draft.

Only Use Players From Source Teams: uses only players from the
source teams selected in your new Association.

Generate New Players As Necessary: allows FPS: Baseball to
generate new players as necessary to fill out the rosters on all
teams and to create a pool of free agents in the new Association.

Generate All New Players: instructs FPS: Baseball to create all new
players for the new Association. This option is for the user who
does not want any preconceived notions about player
performances based on real player names. This option is available
only if the Dump All Players into a Common Draft Pool option is
checked.

[}

Use ALL Players from this Association Only: select this option if
you do not want to use the players from your source teams.
WARNING: if your new Association is 48 teams and you select an
Association here that is only 8 teams, you will not have enough
players to fill out your rosters. If this is the case, then during the
tegular season, FPS: Baseball will automatically generate
fictional players to allow you to field a team. This option is
available only if the Dump All Players into @ Common Draft Pool
option is checked. Once you click this option button, you can click
on the Association name to select a different Association. A dialog
box will appear with all the Associations displayed in it. Scroll
through the list and click on the Association that contains the
players you want to use. Then click OK.

f you choose to have an initial player draft when creating a new
Association, Start/Resume Draft will appear as an option on the
Association menu. Select this to begin the Initial Player draft.

The computer will automatically moke draft decisions for
computer-owned teams, and for any teams that have Free Agent
Draft selected under the Computer GM options on the Team Data
icreen.

For more information about the drafting process, see “Player
Drafts” on page 91.

NEwW ASSOCIATION: SCHEDULE
ENGTH

‘The Select Schedule Length dialog box, which automatically
tppears as you are going through the process of creating a new
-association, shows the number of games to be played by each
league for each season option: Short, Half, and Full. The number of
games varies with the number of teams in the leagues. For Career
Associations the schedule length selection is permanent. In
‘Bingle-Season Associations, a new schedule length may be
‘gelected each season.
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Click the option button for the length of season you prefer, and
click on OK to continue.

If you have a 14-team league in your Association, and you are
using a full-length schedule, FPS: Baseball offers two types of
schedules. Historical will use the scheduling model in effect in
professional baseball. Divisional will create a schedule that
assures your team of playing the majority of its games against
teams within the same division.

Schedule Length for League

Number of Games

Teams in League Short Beason Half Season Tull Season
i 14 84 154
10 18 90 162
12 32 86 162
14 (2 divisions) 38 %0 162
14 (3 divisions) 26 76 162
16 30 a8 160

Once you have set the schedule length for the Association, the new
Association process is complete. The Association Data screen will
be displayed, where you can change the Association name, league
and division names, ground rules, and so on.

NEW ASSOCIATION: GROUND
RULES

Setting Ground Rules

You can also define the Ground Rules for your Association.
Caution: Ground rules for a Single-Seascn Association are in force
for the entire season—you can change them during the off-season
only. Ground rules for a Career Association are set permanently
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Pprior to the first game of the first season, and cannot be changed
thereafter.
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Dptions include:

Injuries: When "Injuries" is turned on, players may be injured and
ave to leave the game.

Fatigue: When "Fatigue" is turned on, pitchers tire (and their
performance suffers) as the game progresses according to their
Endurance rating and the number of pitches thrown.

Designated Hitter: Determines whether the team can use «
signated hitter. If "Designated Hitter" is turned off during o

me, the player who had been the DH will be removed from the
game and cannot be used later.

Use Ratings: Determines whether individual player ratings are

used during the game. When it is turned off, all players' skills are
tated as Average.

Flelding Errors: Determines whether fielding errors may or may
not occur. If it is turned off, all throws are on target and fielders will

not rcxlllcxke errors, although there still may be balls that they cannot
‘handle.

use Stealing: When turned on, the team's base runners may
attempt to steal.

to Center: Disables the Pitch Location variable. When it is
rned on, all pitches in the League game will be to the center of
the plate.
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You activate a ground rule by clicking on its checkbox. If selected,
that playing condition is turned on for the entire Association.

You can select the Designated Hitter rule separately for each
league within the Association by clicking on the Designated Hitter
option box for that league. Unlike other Ground Rules, the DH can
be set for each individual league in your Association, and can be
changed between seasons, even in a Career Association.

NEwW ASSOCIATION: RESETTING
TEAMS

When teams are selected for a new Association, they will retain
the ownership and any Computer/General Manager settings they
possessed in their original Association. (For information about
ownership and the Computer/GM options, see "Team Data” on
page 106.) If, for instance, a team was Human-owned and had all of
the General Manager functions disabled, those settings would be
copied into the new Assocciation for that team. You may use the
Reset Teams option to change the ownership of all the teams in
your Association or to set the Computer/ GM functions for all
Human-owned teams in the Association.

To reset teams, select the Reset Teams item in the Action Menu on
the Association Data screen. You can reset these options al any
time during a season.

The Reset Teams option is especially usetul when creating a new
Association using teams from your existing Associations because
teams retain all their team data. You may also want to use this to
set all teams to Human-owned with the Sign Free Agents, Propose

lrades, and Respond to Trades options turned off, so you can
exactly duplicate trades and free agent signings of your favorite
teal-world professional baseball Association manually.

LAYER DRAFTS
There are three different drafts in FPS: Baseball Pro '98:

Initial Draft: both Career and Single-Season Associations may
have initial drafts, if that option is chosen during the Create
‘fAssocication process in the Player Options screen. The initial draft
‘ccurs by dumping all players in the Association into a poel, from
which teams then select, one by one, until all of the team rosters

Note: During computer-controlled drafts, one team may not
stop drafting for a number rounds after the others have
completed their drafts. The draft round number displayed may
become a negative value. Possible Solution: Let the draft
continue normally. The team will eventually stop with «
complete team as normal. Although the problem appears to be
serious, it isn't. The team will have enough players to play
games and the Association will continue as normal.

free Agent Draft: held in December; teams can try to plug some of

e holes in their rosters created by players retiring. Only held for
Career Associations.

Amateur Dratt: held in June; kids out of high school and college are
elected and placed on a team’s Low Minors roster. Only held for

Career Associations.

'ther than what is stated above, the drefts are handled in «
milar manner:

I, You are automatically notified when it is time for a draft to begin.

% Teams are automatically set into a draft order based on their
Won-Lost percentage in the previous season (for Amateur and Free
Agent Drafts) or in a random manner (for Initial Drafts).

4, To start a draft, select Start/Resume Drait from the Association
menu, then select Start/Resume Draft from the Action menu.
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4, The computer will cutomatically make draft decisions for
computer-owned teams, and for any teams that have Free Agent
Draft selected under the Computer GM options on the Team Data
screen (for Free Agent Draft and Initial Draft) and Amateur Drait
selected for Amateur Draft. If the draft is being handled by a
human for a team, the player is selected by double-clicking on the
player name is the roster-display.

To aid in your selection, you can use the Set Criteria and Change
Columns commands on the Action menu to select a group of
players to display and select what information to display on
screen. You can then use the commands on the Show menu lo
display different stats and time trames.

Once selected, if the Team has Reassign Players set to human
control, the Reassign Players dialog box is displayed and you can
place the selected player on one of your rosters. Otherwise, your
Computer GM will do it for you.

5. To pass for a round, select Skip Round under the Action menu. T
take your team out of all remaining rounds, select Skip Draft on the
Action menu. You may examine the draft order by selecting Draft
Order under the Show menu.

6. The drafts continue as long as teams want to select. Players not
selected in the draft are added to the free agent pool. The player
drafts must be completed before the season can continue.

The Betion Menu

Set Criteria: Brings up the Set Criteria dialog box, which allows
you to select the players to be shown.

Skip Round: Causes the team to not choose a player in the current
round, if the team's draft functions are human-controlled.

Skip Draft: Causes the team to not choose any more players in the
draft, if the team's draft functions are human-controlled.

Start/Continue Draft: Causes the draft selection process to begin or
resume from where it left off. If the team's draft functions are
computer-controlled, the computer will select the player to be
drafted, display a message of who was drafted, and pass control to
the next team. If the team's draft functions are human-controlled,
you select the player to draft.
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':Besturt Drait: Puts all players for all teams back into a common
pool for drafting. You may also change the draft order.

:‘ rint: Prints the Team Roster.

Change Columns: Brings up the Change Columns dialog box that

allows you to choose the statistics to be displayed in each column
of the roster display.

Drait Delay Time: Brings up a dialog box that allows you to specify
the time (from 0 to 30 seconds) that FPS: Baseball will wait between
- tomputer-controlled teams making draft selections. Caution: if you

et the time to 0, you will not be able to interrupt the draft until it is
‘complete, if there are no human-controlled teams.

he Show Menu

Draft Order: Shows the order the teams will pick in the draft.

Historical Data: Shows the historical statistics for the players
‘shown. NOTE: Historical data is not kept for teams. This selection
l!hows the totals of the historical statistics for the players on each
leam.

%Accumulated Week: Shows the statistics generated in FPS:
Baseball for the past seven game days.

Accumulated Season: Shows the statistics generated in FPS:
Baseball during the current season.

Accumulated Career: Shows the statistics generated for each
player during his FPS: Baseball career. (Historical statistics are not
included.) This option is not available for teams, or if the current
Association is of the Single-Season type.

Batting/Fielding Stats: Shows batting and fielding statistics.

Pitching Stats: Shows pitching statistics.

SPRING TRAINING

:” ach spring, teams in Career Associations hold training camps to
prepare their players for the new season. As the manager, you can
allocate percentages of training time to each of the individual skill
tatings. (See "Player Ratings” on page 133.) If sufficient training
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time is allocated to a particular skill, a player's actual ratings for
that skill will increase. The amount of increase in actual ratings
depends on the amount of training time allocated and the
percentage of his potential ratings the player has reached. If a
player has an actual rating that is very close to his potential, very
little increase will be gained even by a large amount of training.

Training Allocations for all players will be made automatically by
the computer after the Free Agent draft (and Initial draft, if selected
during the Create Association process), unless the player has 100%
of his training time already allocated. You may modily the training
schedule for any player on your team after the computer has set it.
For example, if the Championship series, your star 3rd baseman
fails to get a base hit and you lose the game. You could
immediately set his training time for Contact Hitting to 30%, and
fill out the other 70% for other ratings. The computer will then not
touch his allocation time (since it is 100%), when it fills out the other
players on your team.

Teams must be human-owned in order for you to change the
training time allocations. To do this, select Training Allocations
from the Team menu.

When you are satisfied with your team's training allocations,
select Start Spring Training from the Association menu. If any
teams have incomplete allocations, a dialog box will list those
teams and ask whether you want to have the computer finish
assigning their training allocations.

BLL-STAR GAME

At about mid-season in each full-season schedule, all teams have
a Monday, Tuesday, and Wednesday off so that the Association
All-Star game can be played on the Tuesday in the middle of the
break. Two teams will be generated by the computer divided into
the two leagues or divisions present in the association.
Associations with three leagues or divisions will have two teams
representing an amalgamation of the best players in the
Association. The All-Star teams are selected by FPS: Baseball at
the time the game is played and are based on the statistics
generated by the players in the Association's current season, as
well as their rated abilities.

To start the All-Star game, go to the League Schedule screen by
choosing Schedule from the Association menu and click on the
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{Jame text. You may choose to either play or simulate the All-Star

fjame. Player injuries and pitcher iatigue will be recorded for this
game, but the statistics will not.

‘ alf- and short-season association schedules do not have an All-
| tctr' b.rt?ak, but you may choose to play an All-Star game from the
Exhibition Play screen at any time in the season and teams will be

generated based on the player statistics and skills available to the
froupings you choose.

'PLAYOFF SCHEDULES

’* ter the regular season schedule has been played, the best teams
‘ in each division or league may advance to the postseason

tournaments, which begin on the second day after the end of the
q tegular season.

._T.here may be two sets of tournaments: League Championships
und ‘World Championships. How long each lasts depends on the
tonfiguration of the Association.

All League Championship tournaments must last the same
number of rounds. If any league in the Association has three
divisions, the League Championships must last two rounds. If the
largest number of divisions in any league is two, the League
Championships last only one round. If the Association has only
pingle-division leagues, there are no League Championships at all

the team with the best regular season record is the League
Champion.

o

.Imilarly. the length of the World Championships is determined
by the number of leagues. A three-league Association has two
ounds. A two-league Association plays one round. If there is only
‘ one league, the winner of the League Championship is the World

Champion.
" he following table lists the lengths of each round of playoffs for
‘pach league configuration. The number of divisions listed is for the

league with the most divisions in that configuration.

P i

Note: Each playofi round is a "best of" series.
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Playoif Schedule for League
Configurations

Number of Games

Numbar of Number of League League Asscciation Assaciation

Leagues Divisions 1st Round 2nd RHound 15t Round 2nd Round
1 1 0 0 ] 0
1 2 7 0 0 0
1 3 7 7 (1 1]
2 3 0 1] 7 1]
2 2 7 0 & 0
2 2 5 7 7 0
3 1 0 0 7 7
3 Z 5 0 7 7
3 3 3 5 5 7

Once the regular season has ended, you may track Playoff Status
from the Playoffs menu item on the Show menu.

The results of all Association championships are displayed when
you select History from the Association menu, then select
Champions from the Show menu.

PLAYOFF STATUS

The playoff status screen shows the status of the championship
playoifs for an Association whose regular season schedule has
been completed. To display this screen, select Playoffs from the
Show menu of either the Association Schedule or Association
Standings screens. It is useful in monitoring teams as they
advance through the playoff rounds.

For each playoff round started, information about the 'best of'
series is displayed, followed by the results of each played game.
Any available league championship information is displayed first,
followed by any available world championship information.

Playoif Statistics

At the start of each playoff round, all weekly statistics will be
cleared. This provides a method of viewing exact results of how
teams/players have performed in the current round, using any of
the various roster and statistical screens.

Basahall Pro
Season

The Action Menu

_" rint: Prints the playoif status.

STARTING A NEW SEASON

?}_’Lﬂer the playoffs are finished, you may continue on to the next
season by selecting Start New Season from the Association menu.
Starting a new season does the following things:

1. Age and retire players (Career Associations only)

2. Set up the Free Agent Draft (Career Associations only)
8. Reset all team and player seasonal statistics to zero.
4, Generate a new schedule.

It is a good idea to backup your Association before starting a new
Beasor.

Restarting a Season

For Single-Season Associations, you can restart the season at any
time by selecting Restart Season from the Association menu. This
resets all team and player seasonal statistics to zero. It is
available at all times for Single-Season Associations.

juswafieueyy anhieal I

TEAM NEWS

The Team News screen displays the Team name, record, division,
and Association at the top. The screen is divided into two list
boxes: Transactions and Injuries. To display this screen, select
News from the Team menu. Information for the current team will be
displayed. To change teams, select Select Team from the Team
menu. In the dialog box that is displayed, select the team you want
to display, then click OK.
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C Tom Bagnozzi
F Trent Hubbard

LF Dante Bichette

: 3B Lenny i
: 1B Brook Fordyce

Transactions

The Transactions report in the upper half of the screen shows
roster moves and trade proposals.

You can take the following actions by clicking on items in the
Transactions list box, if the team is human-owned:

Trades proposed by your team: Cancels a pending trade proposal
you have made to another team. A dialog box will ask you to
contfirm the cancellation.

Trades proposed by other teams: Lets you accept or reject a trade
proposed by another team. If you accept the trade, you will go
directly to the Roster Assignments dialog box to make the
necessary roster adjustments.

Trades accepted by the other team: Opens the Roster Assignments
screen, where you can assign these players to your roster.

Free agent claims by the team: Cancels a pending claim you have
on a free agent.

Free agent signings by the team: Finalizes a free agent claim that
has been approved by the league and opens the Roster
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Assignments screen, where you can make the necessary roster
adjustments.

Injuries

he lower half of the Team News screen shows the injury status of
leam members. If the Injuries report is longer than the display
‘@ireqa, you can use the scroll bar on the right to move down the list.
You can reassign injured players to the Disabled List by clicking in
the Injuries list box to bring up the Roster Assignments dialog box,
the team is human-owned.

'Clicking on an injured player brings up the Reassign Player dialog

OX.

The Action Menu

Print: Prints the team's transactions and injuries.

'TEAM STATISTICS

The Team Statistics screen can be used to compare players on the
1j:ec1m and to compare team totals with those for opponents. To
display this screen, select Statistics from the Team menu.
BStatistics for the current team are displayed. To change teams,
select Select Team from the Team menu. In the dialog box that is
‘displayed, select the team you want to display, then click OK.

The statistics display consists of ten columns of data, eight of
‘which can be modified. To change the data displayed in any
‘column, choose Change Columns from the Action menu. You may
gort the data shown by any of the columns by clicking on the
column heading. That heading is then shown in white letters.

The Action Menu

‘Change Columns: Brings up the Change Columns dialog box,
‘which allows you to choose the statistics to be displayed in each
column of the roster display.

Print: Prints the team statistics.
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The Show Menu

Historical Data: Shows the historical statistics for the players
shown. NOTE: Historical data is not kept for teams. This selection
shows the totals of the historical statistics for the players on each
team.

Accumulated Week: Shows the statistics generated in FPS:
Baseball for the past seven game days.

Accumulated Season: Shows the statistics generated in FPS:
Baseball during the current season.

Batting/Fielding Stats: Shows batting and fielding statistics.
Pitching Stats: Shows pitching statistics.

See also Roster and Statistics Screens.

STATISTICAL TOTALS

Batting/Fielding Statistical Totals

While in the Team Statistics or Team Roster screens, you may
select the Change Columns command from the Action menu to
display statistical totals for your players, both batters/fielders and
pitchers. The list of available statistics is as follows:

Stat Description

G Games played
AB At bats

R Runs

H Hits

1B Singles

2B Doubles

3B Triples

HR Home runs
RBI Runs batted in
SH Sacrifice hits

100

SF Sacrifice flies

HBP Hit by pitches

BB Bases on balls (walks)
IBB Intentional bases on balls
S0 Strikeouts

'SB Stolen bases

CS Caught stealing

GDP Ground into double play
Avg Batting average

OBP On-base percentage

Slg Slugging percentage

PA Plate appearances

:—:'Iso Isolated power. Iso is simply slugging percentage

minus batting average. Iso of .200 or higher is very
good. (Devised by Bill James.)

K/BB Strikeouts-to-walks ratio

RC Runs created. RC is a method of putting together basic
stats in such a way as to give an idea of a player's
overall offensive contribution. 100 runs created is a very
good season. (Devised by Bill James.)

TB Total bases

SA Secondary average. SA evaluates the kind of things
that don't go into a batting average. SA of .350 or higher
is very good. (Devised by Bill James.)

Pro Production. Pro = OBP + Slg. Pro attempts to measure a
player's rate of offensive production. (Devised by Pete
Palmer and Dick Cramer.}

TA Total average. TA is another mecasure of a player's
offensive cutput. (Devised by Thomas Boswell.)

'The data displayed for each of the following fielding statistics are
for the player's primary fielding position only.

Stat Description

GPos Games played at position

101
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Pct

Bng

TC

Innings played at position
Putouts

Assists

Errors

Double plays

Passed balls

Fielding percentage

Range factor. Rng = (PO + A) * 9/ Inn. We include Rng for
first basemen and catchers, although the large number
of putouts each makes (first basemen on throws from
other infielders, and catchers on strikeouts) do not
reflect the player's own defensive ability. (Devised by
Bill James.)

Total chances. TC = PO + A + E.

Pitching Statistics Totals

Stat
G
GS
GF
1P
BFP

Sv
BB
IBB
S0
AB

1B
2B
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Description

Games played

Games started

Games finished (as a reliever)
Innings pitched

Batters facing pitcher
Wins

Losses

Saves

Bases on balls (walks)
Intentional bases on balls
Strikeouts

At bats

Hits

Singles

Doubles

88 Season

Triples

Home runs

Runs batted in
Sacrifice hits
Sacrifice flies
Hit batsmen
Complete games
Shutouts

Quality starts. A starting pitcher makes a QS when he
goes at least six innings and allows no more than three
runs.

Stolen bases allowed.
Caught stealing
Runs

Earned runs

Inherited runners. A relief pitcher receives one IR for
each runner on base when he enters the game.

Inherited runners scored.

Holds. A relief pitcher receives a Hold if he enters the
game in a save opportunity (see below) and passes on
the save opportunity to the next relief pitcher.

Save opportunities. A relief pitcher receives o SvOp if
he receives a Save, or if he enters the game in a save
situation and gives up the lead.

Wild pitches.

Juawaheueyy snbeay I

Opponent's batting average
Opponent's on base percentage
Opponent's slugging percentage
Strikeouts-to-walks ratio
Winning percentage. Pct = W/W+L
Save percentage. Sv% = Sv/SvOp
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ERA Earned run average. ERA = ER"9/IP

RAT Ratio. Ratio = (H + BB)/IP. Ratio is a common fantasy
league statistical category.

K/9 Strikeouts per 9 innings pitched

BB/9 Wualks per 9 innings pitched

H/9 Hits per 9 innings pitched

SITUATIONAL STATISTICS
COLUMNS

While in the Team Statistics or Team Roster screens, you may
select the Change Columns command from the Action menu to
display situational statistics for your both batters/fielders and
pitchers.

These columns display statistics for players in particular
situations. All of the columns are the same for batters/fielders and
pitchers with the exception of the Pro column (a batting-only
statistic). All of the statistics shown below can be displayed for any
of the situational modifiers listed in the Player Ratings topic.

Stat Description

AB At bats

H Hits

2B Doubles

3B Triples

HR Home runs

RBI Runs batted in

BB Bases on balls (walks)
SO Strikeouts

Avg Batting average

OBP On-base percentage
Slg Slugging percentage
Pro Production. Pro = OBP + Slg. Pro attempts to measure a

player's rate of offensive production. (Devised by Pete
Palmer and Dick Cramer.)
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TEAM SCHEDULE

The Team Schedule screen shows the current team's schedule for
‘the current season. Each date on the calendar shows the game
‘scheduled for that day. The current date is indicated by a yellow
highlight. Each date is color-coded to indicate a home game, away
game, or open date. To display this screen, select Schedule from
‘the Team menu. To change teams, select Select Team from the
Team menu. In the dialog box that is displayed, select the team
you want to display, then click OK.

Jun=a 289 June 30 uly 1 il 2 duly 3
CIN CONYN2 N¥HN 1 NYN 2 N¥YN 2
CHN 2 CHN 3 CHN 2 CHN & CHN 3
July 7 [July 8 iduly ' 9 July 10
BoH Bow viBom
SCHN 1 CHN 1 CHN -3
IN¥YN 4 NYN 2 ¢ {INYING
July 17

July 13 July 16

July 29

duly 27
Spisq

Unresolved games: You may click on the current date to start
today's game. The scheduled starter for the game is indicated by
the code SP:Sx, where 'x' is the slot in the starting rotation that is
due up. You can click on the small icon in the bottom right corner
of each date to toggle it to show either a joystick (Play mode) or a
monitor (Simulate mode). See "Play vs. Simulate” on page 138.

Resolved games: Each date shows the score of that day's game.
Box scores are available for the past week's games; this is
indicated by the word 'Box' on the calendar. To see the box score,
just click on the date.

The Action Menu

Print: Prints the team schedule.
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TEAM DATA

This screen allows you to take control of and modify a team in the
current Association. To display this screen, select Data from the
Team menu. Information for the current team is displayed. To
change teams, select Select Team from the Team menu. In the
dialog box that is displayed, select the team you want to display,
then click OK.

niform Cofors

Team Name, Nickname, Abbreviation: You may click directly on
these text boxes to type in new data for these items. The Name and
Nickname may be up to 16 characters each, and the Abbreviation
may be up to 4 characters.

Manager: You may click directly on this text box to type in new
data. The manager's name may be up to 32 characters.

Ownership: You may click on this text box to toggle the ownership
of this team from Computer to Human and back. When the
ownership is set to Computer, you cannot change any of the team's
data - the computer has complete control of the team. Once the
ownership is changed to Human, you can modify the team as you
wish. NOTE: you may toggle all teams at once between human-
and computer-owned by selecting Reset Teams from the Action
menu on the Association Data screen.

Play Modes: Make choices as to what level of control you will have
during league games.

106

Roster Management: Make choices as to what level of control you
will have over player transactions.

City and Stadium: Select the city and stadium where the team will

play and the surface for the stadium.

The BAction Menu

Print: Prints the team data that has been saved for the team. If you

change data (for example, team nickname), and print it without

saving, you will get the old name. To save changed data, press

Ctrl+C or select Change Team from the Team menu. A dialog box

will appear, prompting you to "Save Changes?" Click OK; then
when the Change Teams dialog box is displayed, click Cancel.

BUYING AND SELLING TEAMS

All teams in a new Association start off with the same ownership and
management settings they had in the Association they were copied
from. (See “New Association: Team Selection” on page 83) You may
"buy" any team by changing its ownership from Computer to Human,

~ or "sell" ateam by changing ownership from Human to Computer. You

may buy or sell a team at any point during the season.

To change the ownership of a team, select Data from the Team
menu, then click on the Ownership text box. If you are changing
ownership from Human to Computer, you will be prompted for
confirmation before the change is made. To change the ownership
of all teams in the Association at once, see "Reset Teams Dialog
Box"” on page 68. When a team becomes computer-owned, FPS:
Baseball will reevaluate and modify roster assignments and
starting lineups for that team.

PLAYING MODES

FPS: Baseball lets you customize team control and on-field game
play to match your personal tastes.

Whenever you start an exhibition game from the Front Office or
configure a new Association, you may select the level of strategic and
on-field control you want. You may also change the control level
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during the game. Choose complete control, delegate everything to the
computer, or find a comfortable mix—the choice is yours.

!

Note: When you select Exhibition Play from the FPS: Baseball
startup screen, as opposed to starting from the Front Office, you
don't have the sume level of control over several game options.

Control Mode

These settings determine the control of each team. They can be set
for an exhibition game by selecting Exhibition Play from the Main
menu. They can also be set for both exhibition and league games
from within the Game Options screen during the game.

The control modes are Computer, Joystick 1 - Joystick 18 (if
available), Keyboard L, and Keyboard B control. If set to Computer,
this mode sets all other modes to Computer for that team also.

Note: You may watch the action in "one-pitch mode" if all on-
field modes for both teams are set to Computer. One-pitch
shows only the decisive pitch of each at-bat.

Managing Mode

This setting determines the degree of managerial control you have
over the on-field simulation.

Basic: You may call any play. The computer will position defensive
players, instruct fielders to charge bunts from first or third base,
and signal the pitcher to hold a baserunner. It will also make all
player substitutions, including pinch hitters, pinch runners, and
relief pitchers. You will be informed of any player substitutions the
computer makes on your behalf,

Standard: The computer still positions defensive players, instructs
fielders to charge bunts from first or third base, and signals the
pitcher to hold o baserunner. It will only suggest player

substitutions. You may accept the suggestion or do something
else.
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Bdvanced: You control all Manager options for your team:
‘positioning fielders, charging bunts, holding baserunners, making
‘substitutions, etc.

Manage Only

Click this check box to set all the following on-field modes—
Pitching, Batting, Fielding, and Running—to Computer. This lets

‘you play in any Managing mode you want while the computer
controls all on-field play.

Pitching Mode

Computer: The computer takes complete control of the pitching
game,

Basic: You select the pitch type only.
Standard: You select the pitch type and location.

Advanced: You select the pitch type, location, and speed.

Note: If human-managed, you may order pickoffs, pitchouts,
and pitch arounds in all pitching modes.

Fielding Mode

Computer: The computer controls all fielding.

Basic: The computer takes control of fielding any batted ball. If you
wish, you may take control of fielders after the ball is fielded. You
can then move with the ball or throw to a base. If you do not take
control, the computer will control all fielding.

Standard: You may take control of the fielder attempting to field
the ball. If you do not take control, the computer will try to field the
ball. You must take control after the ball has been fielded, and are

' then responsible for moving the fielder or throwing the ball to a
base.

Advanced: You control all fielding and throwing.
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Batiting Mode

Computer: The computer controls all batting. It decides the type of
swing to use, and when and where to swing.

Basic: You select only the type of swing the batter will use (power,
contact, bunt). The computer decides when and where to swing.

Standard: You select the swing type, and when (and if) to swing.
The computer controls the location of the swing.

Advanced: You control all aspects of batting: swing type, and when
and where to swing.

Baserunning Mode

Computer: The computer controls all baserunning.

Basic: You may advance or retreat a base runner after the ball is in
play. The computer controls all stolen base attempts, and returns
runners to base on pickoffs and pitchouts.

Standard: You may advance or retreat a base runner when the ball
is in play, and you control stolen base attempts. The computer will
automatically return a runner to base on pitchouts and pickoff
attempts.

Advanced: You control all baserunning.

Note: To quickly set all on-field modes to "Computer," check
the Manage Only option. If done for both teams, this also will
allow the "one-pitch" mode option.

UNIFORM COLORS

To modify a team's uniform colors, click on the Uniform Colors
button on the Team Data screen. Here, you may customize the color
that will be used for jerseys, caps, sleeves, trim and pants on your
team’s uniform. You may also customize the uniform colors for
home and road trips, as well as special dates. Additionally, you
may select what those special dates are.

110

The default colors for Associations provided with FPS: Baseball are
close approximations of each team's actual home, away, and

special uniforms. The image below is meant to show the

placement of controls only.

The screen will show a player as an example of the colors you are
selecting. Adjust the R (red), G (green), and B (blue) slider bars left
and right to alter the combination of basic colors and change the
hue. When you are finished, click on OK to return to the Team Data
screemn.

TEAM DATA: ROSTER
MANAGEMENT

FPS: Baseball provides a Computer General Manager to handle
any management functions you wish to delegate. This allows you
to concentrate on the aspects of team management that interest
you, while leaving routine functions to the discretion of your
computer assistant.

Management options that can be delegated to the Computer GM
include:

Reassign Players: This sets the degree of control the Computer GM
will have over the team's players. When this option is selected, the
computer will make decisions about roster assignments, resting
players, and moving players to and from the Disabled List. When
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Reassign Players is checked, the three options listed directly
below it are also available:

Propose Trades: The Computer GM will initiate trade
proposals with other teams.

Respond to Trades: The Computer GM will make decisions
concerning trade proposals received from other teams.

Sign Free Agents: The Computer GM will sign free agents as
needed for the team.

Amateur Draft: The Computer GM will make draft selections for the
team in the annual Amateur draft in June.

Free Agent Draft: The Computer GM will make draft selections for
the team in the annual Free Agent Draft and the Initial Draft (if that
option was selected when the Association was being created).

TEAM DATA: STADIUM AND CITY

Each team has a home stadium located in or near a city. The
stadium model and the city can affect players’ ratings during a
game. 28 stadium models and 85 cities are included in FPS:
Baseball. The nearest city, and the calendar date of the game,
determine the weather for all league games. The weather affects
ratings (except when using the domed stadiums).

Baltimore, MD

You can change the name of your stadium at any time.

You may change your stadium model or move your team to a new
city prior to the first game of any season. To change these, click on
the appropriate text box. A dialog box will show you a list of
available choices. Scroll through the list until the desired model or
city appears, then click on that item and click OK.
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You may also decide whether the stadium has an artificial or grass
Burface by selecting the appropriate option button in the bottom
left corner of this screen.

ROSTERS

‘Bingle-Season Association teams consist of a 40-man roster
‘divided into an active roster and a reserve roster. (In Career
 Associations, you have an additional 10-man Low Minors roster.)
The active roster holds the players who are available for use
'_d_uring games, and the reserve roster contains players on your top
minor league team (AAA) or on the Disabled List (DL). From
Opening Day until August 31, the active roster can have a
maximum of 25 players. After September 1, teams may expand the
_active roster to as many as 40 players by promoting players from
AAA and the Disabled List. The total number of players, however,
still may not exceed 40.

You may move players between the active roster and AAA freely at
“any time. (Exception: During the playoifs, you may only promote a
AAA player to replace an injured player.) You may place injured
' players on the Disabled List (DL) at any time, but once placed on
the disabled list, players must remain there at least 15 days. A
‘maximum of 15 players may be on the DL and at AAA at any given
time.

In a Career Association, each team also has a separate Low Minors
roster, which may have up to 10 players. This represents the team's
farm system. Players are assigned to the Low Minors when dratted
in the June Amateur Draft. Players may be promoted from the Low
‘Minors to the 40-man roster at any time, but once promoted, they
‘may not be returned to the Low Minors roster. A player under the
‘age of 26 may, however, be released to the free agent pool, then re-
‘signed one day later and assigned again to the Low Minors roster.
‘Of course, the player may be signed by another team before the
original team can re-sign him.

A player traded from a team's Low Minors roster may be placed on
‘the new team's Low Minors roster or the major league roster, but a
player traded from a major league roster may not be placed on his
new team's Low Minors roster.

‘To move players from roster to roster, the team must be human-
owned. Select Reassign Players from the Team Menu. For more
‘information, see "Reassigning Players” on page 122.
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ROSTER AND STATISTICS SCREENS

Statistics maintained by FPS: Baseball are available from o
variety of locations within the game. To see ratings and statistics
for individual players on your team, select the Roster command
from the Team menu. To view player and team statistics, select the
Statistics commoand from the Team menu. To view current league
leaders in the various statistical categories, select the Statistics
command from the Association menu.

Statistics are maintained for all players on three levels: weekly,
seasonal, and in a Career Association, for the duration of a
player’s career. When using players you have entered from
historical baseball teams or players who we have included in
Associations that came with FPS: Baseball, the actual historical
statistics of the players are also available for review. The Show
menu of the Team Roster, Team Statistics, and Association
Statistics screens lets you select the set of statistics you wish to
view.

On any of these screens, you may print the data shown by selecting
Print from the Action menu.

For information on what can be displayed, see "Change Columns
Dialog Box.”

CHANGE COLUMNS DiaLoG Box

The Change Columns dialog box allows you to select from over
1500 data items per player to show in the roster or statistics
displays. To display the Change Columns dialog box, select
Change Columns from the Action menu (on a screen that uses o
roster/statistics display, such as Association Statistics or Team
Roster). To change a column, click on the column heading to
highlight it (see SLOT in the diagram below), then select a data
item from the scrolling list below it. Use option buttons on the left
side of the dialog box to change the items available in the scrolling
list box. You may mix and match data items freely. NOTE: you must
select the column heading first to avoid inadvertently changing
the wrong heading.
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There are eight categories of statistics available on the Change

Columns dialog box: four for Pitching and the same four for
Batting/Fielding. Only the data items in the scrollable list change.

Player Data: Biographical data about the player and playing

status (Slot, Health, Pitches available, eic.}

Player Ratings: Basic and situational ratings.

Statistical Totals: Overall statistics for the time frame in question.

Situational Statistics: Statistics for performance in specified
situations.

Saving Column Sets To Disk

Once you have organized the columns to be displayed, you can
save them to disk for easy display in the future. A set of 8 column
headings is known as a StatSet. Click on the Save (to copy over an
existing file) or Save As... (to save a new f{ile) and choose a name
for saving the new StatSet. Use the Load... button to load a saved
StatSet.

PLAYER DATA COLUMNS

While in the Team Roster screen, you may select Change Columns
from the Action menu to display the following items for all players,
both pitchers and batters:

NO Uniform number

POSN Primary defensive position
115
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QPOS Qualified defensive position. If the player is qualified
at only one position, QPOS is the same as POSN. If the
player is qualified at two or more positions, the
secondary position at which he has played the most
games is shown. NOTE: In order to be qualified at a
position, a player must have played a number of games
at that position equal to at least 1/8 of total games he
has played (including historical data).

B Batting hand

T Throwing hand

AGE Age as of current game date

EXP Experience at the major league level (in years)

SLOT Roster slot occupied by this player. This could be Act
(Active roster), AAA, DL (disabled list) or Low (Low
Minors, in a Career Association).

HEALTH Current health status. This could be OK (not injured),

HURT (injured, but able to play) or OUT (injured and
uncble to play).

The following data is additional only in pitching columns:

AVAIL Number of pitches the player has available, before

becoming exhausted.

ROSTER DISPLAYS

Many of the screens that are displayed in the Front Office have a
roster display showing player ratings and statistics. The data
shown in these displays can be customized to meet your
informational needs.

On screens with roster displays, such as the Team Roster screens,
the Show menu allows you to change the roster display to show
Batting/Fielding stats or Pitching stats. You may also select the
time frame for which statistics are shown. Accumuleated statistics
from games you play can be shown for the previous week, for the
current season, or for a player's FPS: Baseball career (in a Career
Association). For players included in FPS: Baseball, or players you
enter using the DATAIN program, you may also review historical
statistics. (On some screens, some options may not be available.)
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To rearrange the data being displayed, select Change Columns in
‘the Action menu. To change information displayed in an
‘Individual column, click on the column heading you wish to alter.
Pick the new data item from the list box by clicking on it. The data
‘et currently displayed in the list box is controlled by the option
‘buttons on the left side of the screen. Each of these will open a new
‘data set for selection in the list box. The roster display can be
‘gorted by any statistic by clicking on a column heading. Clicking
‘on HR, for instance, will automatically display the list according to
the number of home runs each player has hit.

CHANGING BATTING/FIELDING
RATINGS

To change a rating, click on a text box and enter a new value. The
‘actual ratings that are displayed, range from 0-99. The ratings are
‘described below:

Batting
'CH: Contact Hitting

This rating indicates how often the player makes contact, putting
the ball into play.

PH: Power Hitting

This rating indicates how hard the player hits the ball.
SP: Speed

‘This rating indicates how fast the player runs.

G/F: Groundball/Flyball
117
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This rating indicates how likely the batter is to hit the ball on the
ground or in the air. A batter with a high G/F rating hits more on the
ground; one with a low G/F hits more in the air.

Pull: Pull

This rating indicates how likely the batter is to pull the ball. A
batter whose Pull is 70 or more is a strong pull hitter, one whose
Pull is near 50 is a spray hitter, and one whose Pull is 30 or less is
an opposite field hitter.

Batting Situational Modifiers

These modify the CH and PH ratings of the batter. If a batter has a
situational rating of 50 (avercge), it means the situation has no
eifect on his performunce A : aver 50 indicates that he does
better than normal in this situation. A rating under 50 means he
does worse than noring! in this situction.

The two non-monthly situational modifiers (vs. L, Home)} have
implied 'opposiie' ratings, which can be figured by subtracting the
rating from 100. (For example, a batter with a vs. L. rating of 55 has
an implied vs. R rating of 45.) The two situational modifiers, ScPos
and C&L, show how well a player does in those situations.

The six monthly modifiers indicate an overall proficiency of a
player during a given month. For instance, a player with an August
modifier rating of 40 compared with ratings of over 50 for all other
months, is likely to slump in all ratings during August.

All situational modifiers have a range of 40 to 60, except vs. L,
which runs from 35 to 65.

vs. L: vs. Left-handed pitching situational modifier
ScPos: Scoring Position situational modifier

C&L: Close and Late situational modifier

Home: Home situational modifier

Apr: April situational modifier

May: May situational modifier

Jun: June situational modifier

Jul: July situational modifier
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‘Aug: August situational modifier

§/0: September/October situational modifier

Fielding

1

Arm Strength (AS)

This rating indicates both how far and how accurately a fielder can
throw the ball.

NOTE: Unlike the other player ratings, Arm Strength cannot be
calculated from existing fielding statistics and is thus
completely subjective. All players in the MLBPA 97 have AS
values that have been assigned based on information
contained in player scouting reports. You should feel free to
change any player ratings that you disagree with.

'FA:P — FA:RF: Fielding Ability

These ratings indicate how well the player plays each of the
defensive positions.

CHANGING PITCHING RATINGS

To change a rating, click on a text box and enter a new value. The
‘actual ratings that are displayed, range from 0-99. The ratings are
‘described below:

HdRn: Holding Runners

This rating indicates how effectively the pitcher holds base
runners.
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EN: Endurance

This rating indicates how many pitches a pitcher can throw in a
game before losing his effectiveness. While this rating determines
the number of pitches that can be thrown before tiring, the value of
the rating does not represent the actual number of pitches.

CO: Control

This rating indicates how accurately the pitcher throws at his
target location

G/F: Groundball/Flyball

This rating indicates how likely the batter is to hit the pitcher’s
pitch on the ground or in the air. A pitcher with a high G/F rating
gets more pitches hit on the ground; one with a low G/F has more
hit in the air.

AS: Arm Strength

This rating is used to determine the speed of the pitcher's fastball.

Pitches

FB: Fastball

This is the standard pitch that nearly every pitcher has in his
repertoire. Its flight path is essentially straight from the pitcher's
hand to the targeted location in the strike zone.

CB: Curveball

The basic breaking ball, this pitch curves down and away from a
batter batting from the same side of the plate as the pitcher is
throwing (both are right-handed or both are left-handed).

CU: Change-up

Also known as an off-speed pitch, the change-up is about 15 M.P.H.
slower than the pitcher's fastball.

SI.: Slider

A cross between a fastball and a curve, a slider breaks away from
a same-handed batter like the curveball. The slider has more
horizontal break than vertical break.
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SI: Sinker

‘Also known as a two-seam fastball, the sinker is thrown with near
fastball velocity and has a sharp break downwards at the plate.

' 8C: Screwball

A "reverse curveball," this pitch breaks toward a same-handed

‘;bcttter.
KN: Knuckleball

A pitch thrown with almost no spin, the knuckleball is susceptible
to any random air currents between the mound and plate and
breaks very unpredictably.

A pitcher may have o rating for each of the seven pitches, but may
only use his best four pitches in a game.

Situational Modifiers

These modify the ratings of the pitcher. If a pitcher has o
situational rating of 50, it means the situation has no effect on his
performance. A rating under 50 indicates that he does worse than
normal in this situation. A rating over 50 mecns he does better than
normal in this situation.

The two non-monthly situational modifiers (vs. L, Home) have
implied 'opposite' ratings, which can be figured by subtracting the
rating from 100. (For example, a pitcher with a vs. L. rating of 55 has
an implied vs. R rating of 45.) The two situational modifiers, ScPos
and C&L, show how well a pitcher does in those situations.

The six monthly modifiers indicate an overall proficiency of a
pitcher during a given month. For instance, a pitcher with an
August modifier rating of 40 compared with ratings of over 50 for
all other months, is likely to slump in all ratings during August.

vs. L: vs. Left-handed batters situational modifier
Home: Home situational modifier

ScPos: Scoring Position situational modifier
C&L: Close and Late situational modifier

Apr: April situational modifier
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May: May situational modifier
Jun: June situational modifier
Jul: July situational modifier
Aug: August situational modifier

S/0: September/Cctober situational modifier

REASSIGNING PLAYERS

The players on your team may be assigned to the active roster,
BAA, the Disabled List, or, in a Career Association, to the Low
Minors. (See "Rosters” on page 113 for a detailed explanation of the
various rosters.) From time to time, you may need to make changes
in these assignments. To do this, select Reassign Players... from
the Team menu (make sure your team is the current team first).

The top four list boxes show the players currently on your team'’s
various rosters. The buttons above the lists identify the roster and
indicate the number of players currently on that list. The bottom
three lists are used to move players on and off the roster.

To move players between these rosters, highlight the player's

name and then click on the button above the list to which the

player is to be moved.
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‘0u can move players freely between the rosters listed on the top
ttlf of the screen. The lists on the bottom half of the screen,
lOwever, vary in how you can use them.

| you have signed a free agent or drafted a player, his name will
ippear in the Signed Free Agent list. Prior to starting your next
me, you must assign him to one of the team rosters on the top
1lf of the screen. Click on the free agent's name, and then click on
lle roster to which you wish to assign him.

he Released Players list shows the player (or players) that you
ill be releasing from your roster, once you click OK. Click on a
layer's name in any list, then click on the Released Players button
) move a player to this list. If you have inadvertently moved a
layer here, you can move him back to any of the top four list
ioxes, before you click OK.

| a player lrade has been finalized, your new players will appear
[ il the Receive In Trade list. These players must be assigned to one
f the team rosters prior to your next scheduled game.

ee also “Trading Players” on page 125.

PITCHING STAFF ORGANIZATION

f the Reassign Players option for your team is not set to Computer
M, then you will need to assign roles to the pitchers on your team.
[his includes establishing a starting rotation and, at your option,
18signing specific relief roles to non-starting pitchers. These
i8signments are used by the computer when you play in Basic or
standard Manager mode, or when you are simulating games. You
may assign roles to your pitchers from the Team Roster screen by
shoosing Pitching Statf Roles from the Show menu.

_' e possible assignments are:

Juawatieueyy anbeat I

?ccrting pitchers: The first pitcher used in a game. Each pitcher
will be used in turn. You may use a four- or five-man starting
fotation.

Long Relief/Spot Starter: This is the guy who will be brought in if
1e starter is knocked out of the box early. He is also used as an
imergency starter, and he may be called in if the game goes to
ixira innings.

Middle reliever: These are the guys brought in to pitch the sixth or
eventh innings, or to finish off games that are not close.
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Set-up men: These are the guys who close things down in the
seventh and eighth, so you can bring in the closer.

Closer: This is the man you bring in to get the last three outs, to nail
down the victory.

To change the assignments, click on a player in the roster display.
The player is now highlighted. Now click on the assignment slot
into which you want the player to go. If the player you put into the
slot already had oan assignment, the player who previously
occupied the new slot will move to the old slot. (For example, if
Randy Johnson is the number one starter, and Jetf Fassero is the
number three starter, moving Fassero to S1 moves Johnson to 53.)

Not all roles have to be filled; you are only required to designate
four starting pitchers. If you want to remove a pitcher from his role
without replacing him with another pitcher, highlight his name in
the list, then click on his name in the assignment slot.

The Endurance rating (EN) is your primary guide in determining
the best utilization of a pitcher. An EN rating of 60 or better
qualifies a pitcher to be a starter. A pitcher with a low EN rating is
better qualified for a short relief role (Setup Men or Closers).

You can select specific pitchers as Middle Relievers and Setup
Men. When choosing « Closer from your bullpen staff, you
probably want to use a pitcher with a very good Control rating
(CO.

You may also leave any bullpen role empty (except for the first four
starting pitchers). To take a pitcher out of an assigned slot, click on
his name, then scroll to the bottom of the displayed roster, where
you will see a blank line. Click on the blank line. The list of players
is color-coded. Names appearing in red are currently assigned a
role somewhere on the staff.

If you opt to make no specific bullpen assignments, the computer
will use its best judgment in determining the use of relief pitchers,

To change assignments, click on the desired text box containing
the pitcher currently assigned to a role, and then click on a name
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'5:5 om the displayed roster. The two pitchers will exchange places
and roles.

Note: A team cannot start a game or batting practice until its
top four starting pitcher spots have been filled.

RADING PLAYERS

To explore possible player trades with another team, select

exi R 1o
; |Mi’ke Lieberthal

ceseon

i
o

a
§ 949 [Loamon, Hewvin
| 51 iMaddux, Greg

rOoOo

fou may use this display in two ways. You may put one of your
luyers "on the auction block" to see what other teams offer in
exchange, or you may ask another team for a specitic player to see
what they will demand in return.

Juswakieuely anbes] I

hopping a Player

To see other teams’ responses on a player you are willing to trade
away, make sure your players are shown in the roster display by
_’electing Players to SEND in the Show menu. Click on the player
that you are willing to part with, then click on the Send text box.
\he player's name will appear in the box. Then select Get
Hesponse to SEND from the Action menu. The Computer General
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Managers (GMs) of all of the other teams in the Association will
take a look at your player and, if they are interested, will offer a
player in exchange. The names of all interested teams will appear
in the Team list box. To see each offer, click on the team name, and
the player will appear in the Receive box.

Note: You may send or receive up to three players in trade at a
time. You may also make "uneven' trades, such as one for
three or three for two, etc.

Finding the Right Player

To find the right player to fill your team'’s needs, select Show menu
> Players to display a list of available players and select Set
Criteria from the Action menu. A dialog box will allow you to set
your requirements. You may select players based on their current
team, qualified positions, batting and pitching hands, minimum
ratings, age, and current roster status (active, AAA, or Low Minors).
The roster display will change to show the players who meet your
criteria. If you see one you are interested in, click on his name, then
click in the Receive text box. Select Get Response to RECEIVE, and
the other team will name the player wanted in exchange in the
Send box.

Submitting the Trade

Once you have found a deal you are happy with, make sure the
proper players are in the Send and Receive boxes and select
Submit Trade from the Action menu. Messages will appear in the
Team News of each team. If the team you are proposing a trade to
is « human-owned team, the GM will have one game day to
respond to your offer. Computer teams will respond at the end of
the game day. You may withdraw your offer at any time before the
other team takes action on it by clicking on Team News. (See
"Team News" on page 97.)

Two things to remember about proposing trades:

1. If you are proposing a trade to a human-owned team that has
Respond to Trade turned off on the Computer GM settings, the
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_c:m might not accept a trade that the Computer GM approved
tluring negotiations.

4 You may submit any trade, even if the players involved were
fiot the ones listed by the Computer GM as ones he wanted to

frade. He is asking for the player he wants the most, but may
ticcept another.

Trade Restrictions

Trades have some restrictions. Players on the Disabled List may
not be traded. Also, after August 31 (in Associations with full-
length schedules) you may trade with teams in the same league
only. For example, if you owned a team in the National Baseball
League, you could not trade with teams in the American Baseball
League. Finally, no trades may be made during the playoffs.

Responding to Trade Proposals

I you receive a trade proposal from another team, a message will
tppear in your Team News. Click on that message to respond to the
lrade. If you accept the trade, you must assign the player to one of
your rosters before you start your next game. (See "Reassigning
Players” on page 122.)

hen a Proposal is Accepted

If your trade proposal is accepted, a message will appear in your
Team News. Click on that message to assign your new player to
one of your rosters. (Players received from another team's active or
AAA rosters may not be placed on your Low Minors roster.) You
must assign the player to one of your rosters before you can start
‘your next game. (See "Reassigning Players” on page 122.)

The Show Menu

Players to Send: Changes the roster display to show the players on
your team.

Players to Receive: Changes the roster display to show the players
on another team. Only players who meet the criteria on the Set
Criteria dialog box will be shown. The players shown will be from
the team highlighted in the team box on the Trade display.
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Historical Data: Shows the historical statistics for the players
shown. NOTE: Historical data is not kept for teams. This selection
shows the totals of the historical statistics for the players on each
team.

Accumulated Week: Shows the statistics generated in FPS:
Basehball for the past seven game days.

Accumulated Season: Shows the statistics generated in FPS:
Baseball during the current season.

Accumulated Career: Shows the statistics generated for each
player during his FPS: Baseball career. (Historical statistics are not
included.) Not available for teams, or if the current Association is
of the Single-Season type.

Batting/Fielding Stats: Shows batting and fielding statistics

Pitching Stats: Shows pitching statistics.

CLAIMING FREE AGENTS

You may sign free agents at any time during the season and assign
them to any of the team'’s rosters (except during the Amateur and
Free Agent Drafts). To sign a free agent, or to see what talent is
currently available, select Claim Free Agent from the Team menu
(make sure your team is the "current team" first). The Set Criteria
dialog box will appear, allowing you to narrow down the list of
players to suit your needs. Then the roster display will change to
show all the players currently available in the free agent pool.

To make a claim:

1. Use the Set Criteria dialog box to narrow down the list of players
to suit your needs.

2. Display the free agents that meet your criteria by selectingFree
Agents from the Show menu.

3. Change the display columns to view information that will help
you make your decision by selecting Change Columns from the
Action Menu. You can sort the list by clicking on the heading of one
of the display columns (it will then turn white).
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4, When you have found « player you want to claim, double-click
on his name. His name will be displayed in the Claim edit box at
he top of the screen.

5. Select Submit Claim from the Action Menu to send your claim to
the Commissioner. While the day’s games are being played, the
Commissioner's Office will respond to free agent claims. If two or
‘more teams claim the same free agent, he will be awarded to the
team with the poorest winning percentage.

the Commissioner's Office approves your free agent claim, a
message will appear in your Team News. Double-click that
message and the Reassign Players dialog box will appear,
allowing you to specify to which of the various team rosters the
new player(s) will be assigned. You must assign the player to the
active, reserve, or Low Minors roster before you can start your next
game,

' The Action Menu

Set Criteria: Brings up the Set Criteria dialog box, which allows
you to set the criteria for players you want to see. Depending on
‘how you set the requirements in this dialog, you may eliminate all
players from the display. If this happens, bring up the dialog box
again and change some of the settings.

Submit Claim: Sends the free agent claim to the League
Commissioner's office. If multiple claims are made for the same
free agent, the Commissioner will award the plaver to the team
with the poorest won-lost percentage.

Change Columns: Brings up the Change Columns dialog box,
which allows you to choose the statistics to be displayed in each
column of the roster display.

Print: Prints all of the displayed players in the free agent list.

Print Top 50: Prints the first 50 players in the free agent list. To
rearrange the order of the players, click on a column heading to
sort the list by that column.

Print Column Leaders: Prints the first 10 players in the list and the
selected column of data. To select a column of data, click on the
‘heading.
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The Show Menu

Free Agents: Changes the roster display to show the players in the
free agent pool. Only players who meet the criteria on the Set
Criteria dialog box will be shown.

Team: Changes the roster display to show the players on your
team.

Historical Data: Shows the historical statistics for the players
shown.

Accumulated Week: Shows the statistics generated in FPS:
Baseball for the past seven game days.

Accumulated Season: Shows the statistice generated in FPS:
Baseball during the current season.

Accumulated Career: Shows the statistics generated for each
player during his FPS: Baseball career. (Historical statistics are not
included.) Not available for teams, or if the current Association is
of the Single-Season type.

Batting/Fielding Stats: Shows batting and fielding statistics.
Pitching Stats: Shows pitching statistics.

See also “Trading Players” on page 125.

TRAINING ALLOCATIONS

One of the cool features of FPS: Baseball is that you can actually
help players improve over the course of their career. This is done
by allocating Spring Training time to different ratings. A team
must be human-owned in order to change training allocations.

At the end of a season, players will undergo aging. Aging will tend
to raise or lower a player's ratings, depending on the rating and
the player's age. During Spring Training, the player must apply a
certain amount of time to his ratings in order to maintain their
current level (after aging effects). If the player puts the minimum
required amount of time into their ratings, they will likely see no
change to the ratings, they will simply be maintained. If the player
puts additional time into o rating, may see an increase in that
rating. If a player puts less than the minimum amount of time into
a rating, he will see a significant decrease in that rating.
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Bpring Training Allocations are available throughout the season.

This allows you to make changes to the player's upcoming Spring
'J aining time whenever you notice a shoricoming during the
current season. The player doesn't train at that time (he must wait
until the next spring); this is more of a "note pad" feature, allowing

‘f of a pitcher's time to a Curve ball (CB), and allocate nothing
else, the pitcher probably will not end up with 20% allocated to CB
‘after FPS: Baseball has allocated the time.,

You can allocate training time for each player in increments of 5%,
viding it among the various skills. You cannot exceed a total of
100%. The minimum amount of time that a player will need is

' based on the rating. CH, PH, and SP all require a 20% allocation to

‘maintain their current levels. CO and non-pitcher FA ratings
‘require 15%. AS, EN, HR, pitcher-FA, and all pitch ratings require a

‘minimum of 10% training time to maintain their level.

1. Click on the Previous or Next buttons at the bottom of the screen.

5.’ Select Choose Player from the Action menu. The Choose Player
‘dialog box will show all players and the percentage of training
time allocated. Highlight a player’s name and click OK to display
‘that player in the Spring Training screen.
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About the Display

The player’s current rating for each skill is shown. Click the arrows
beside the displayed allocation percentage to increase or
decrease the amount of time the player will spend improving that
particular skill. Players may have a fielding rating for all nine
defensive positions. Those positions for which they are qualified
are indicated by the check boxes next to each position. Training
time can be allocated for each individual fielding position, with
the exception of the three outfield positions, which use the same
training allocation.

The Action Menu

Choose player: Brings up a dialog box that allows you to choose
another player for whom to allocate training time.

Print: Prints the spring training allocations.

Starting Spring Training

When you are satisfied with your team's training allocations,
select Start Spring Training from the Association menu. If any
teams have incomplete allocations, a dialog box will list those
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:'_eams and ask whether you want to have the computer finish
assigning training times or postpone Spring Training.

PLAYER RATINGS

All players have several basic ratings, which range from 0 to 99.
These numbers indicate the player's current skill levels. The
higher the numeric rating, the more skill the player possesses. The
lower the rating, the lower the skill level. An average rating is 50
in all categories. The ratings are divided into two categories:
Batting/Fielding and Pitching. However, since pitchers can bat,
and batters may occasionally pitch, all players are rated in both
categories.

In a Career Association, certain skill ratings will change during
the course of a player's career, improving from work during spring
training and slowly declining as the player ages.

;Euch player has three different sets of ratings, which are used at
various points:

Actual ratings represent the player's normal performance levels as
shown on the roster screen. Actual ratings do not change during

the season.

Potential ratings represent the maximum level the player may

‘reach in his career. You will never actually see a player's potential
ratings displayed anywhere within FPS: Baseball. A player's

-actual ratings may increase during spring training and aging, but

‘will never surpass the level of his potential ratings.

:-. sffective ratings are up-to-the-minute player ratings used during a
‘game. The effects of injuries, pitcher fatigue, and any situational
-modifiers are reflected in a player's effective ratings.

Player Ratings: Batting/Fielding

see "Changing Batting/Fielding Ratings” on page 117 for o
complete description.

Player Ratings: Pitching

‘see "Changing Pitching Ratings” on page 119 for a complete
description.

133

uswakeueyy snbeay I



FRONTPAGE SPORTS

League Management I

EDITING PLAYERS

If the team is human-owned, you can edit certain player data.

Changing General Information

s

Johnson

At the top of the dialog is a section for general player data. Here
you may change the first name, last name, uniform number (NO),
age, or experience by clicking on the text box and entering new
data. You can change the player's batting hand or throwing hand
by clicking on the text box and cycling through the possibilities (L-
left hand, R-right hand, S-either hand). You can change their skin
color and pitch delivery by clicking on the option buttons.

You can specify which positions the player is qualified to play by
clicking on the check boxes next to the position labels. Then you
can specify their primary position by clicking on an option button.
(Primary position must be one of the positions they are qualified to
play.)

The bottom part of the Edit Player dialog box displays either
Pitching ratings or Batting/Fielding ratings. To switch between the
two, click on the button labeled Batting/Fielding or Pitching
Ratings in the lower-left corner. Once you've finished editing the
player data, click on OK to save it, or Cancel to ignore your
changes.
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A\ctual Ratings: Ratings which represent the player's normal
performance levels. Actual ratings do not change in Single-
ieason Associations nor will they change during the season in
Career Associations. For Career Associations, actual ratings
ficrease and decrease as a player ages, see "Player Aging” on
page 136. During Spring Training the player's training time is
illocated to each rating in order to maintain, and possibly
lcrease, their Actual value.

Actual and Potential ratings values are computed when the player
I8 created but may be manually modified or recomputed by using
: .1, e Dataln utility. Additionally, you may edit the Actual ratings for
it d1v1dual players from the Team Roster screen, see "Editing
Players” on page 134.

PLAYER HEALTH
niuries

In FPS: Baseball, as in real life, players may be injured. Injuries
may be minor, resulting in a reduction of abilities for a period of
days, or serious enough to end a player's career. (Any injuries
Bustained in exhibition play, regardless of severity, are not
tecorded after the exhibition game concludes.)

If o player is injured during a game, look at the Team News after
the game to find out the severity of the injury and how long the
]ayer is expected to be hurt. If the player is listed as "day-to-day,"
Iu may be used in games, but he will heal more slowly than if he
is allowed to rest. If a player is listed as "expected out for" some
period of time, he cannot be used in a game. The player's status is
listed in the Health column on the Team Roster. A healthy player is
listed as "OK." A player who is injured, but able to play, is listed as
LHU'RT " and a player who cannot play is listed as "OUT."

‘-Heuling

Injured players heal « little bit every day. The amount that they
‘heal depends on how they are used each day. A player who plays
‘most of a game will not heal very much. One who appears briefly
in a game will heal more, and one who does not play at all will
‘heal the most. A player heals fastest when he is placed on the
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Disabled List, but a player cannot be brought back from the DL for
at least 15 days, even if he fully recovers from his injury sooner,

Some players may incur injuries that will leave them listed an
"day-to-day" for an extended period of time. If a player continues in
this state for more than « few days, you should consider placing
him on the Disabled List. To do this, click anywhere within the
Injuries list on the Team News screen or select Reassign Players
from the Team menu to display the Roster Assignments screen.

PLAYER AGING

The birth date for each player in the MLBPA associations has been
set so that in Career Associations, each player's Age is increased
on their cactual birthday. Between seasons, each player will
experience the effects of aging according to his age when Starf
New Season is selected. Younger players will generally see an
increase in their Actual Ratings while older players will see «
decrease.

Each rating has a "normal" growth curve based on the player's
Potential Rating and Age in that skill. A player's growth can be
accelerated, and his decline slowed down, by applying extra
training time to that skill in Spring Training. Similarly, his growth
will be severely impaired, and his decline accelerated by
providing less than the minimum required amount of training time
to a skill. However, the vast majority of a player's growth in each
skill is due to aging and his potential.

In general, a player's skills will peak at about 28 years of age,
However, each skill has a different growth curve and may actually
peak earlier or later than 28. Although each player is unique and
can vary from the norm, the following guidelines can be used when
gauging the effects of aging on player skills:

1. Contact hitting (CH) is a younger player's skill. Although teen-
aged players will not likely start with a large portion of their
potential, they will improve quickly and should peak before they
reach 28 years of age. Players should maintain their contact
hitting well into their 30's before they start to decline in skill.

2. Power hitting (PH) is an older player's skill. Teen-aged players
will not likely start with a majority of their potential and will not
improve as quickly as with contact hitting, but will start to see
greater improvements as they get stronger in their mid-20's and
will continue past age 28. Power hitting is maintained by players
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ito their late 30's, but should show a sharp decline as they age

tther.

~ Speed (SP) is a young player's skill and is pretty much
tablished as o teenuager. Player's may see some minor
iprovement in their speed as they get older, but a player's speed
hould peak well before he is 28 years old. Players start to lose

. Fielding ability (FA) is a skill that established early. but has
yom for moderate growth. Players will generally peak at about 28
wars of age with their fielding ability and will maintain it
iroughout their career.

). Arm strength (AS) is similar to speed in that teen-aged pitchers
ind position players already have almost all the arm strength they
vill achieve, but with room for minor growth. Arm strength is
lenerally maintained by the player or pitcher until somewhere
tround 40 years of age and then will generally decline rapidly.

. Control (CO) is an older pitcher's skill and, like power hitting,
vill show a slower early development with an accelerated growth
45 the player hits his mid-20's and continuing past 28. Pitchers will
generally retain most of their control into their 40's.

7. Endurance (EN) is an established skill with nominal growth and
will be maintained well into the late 30's, but will generally start to
ghow a sharp decline thereafter.

Hold runner (HdRn) is a skill in which a pitcher can show
moderate growth, peaking at about 28 and maintaining throughout

For more information, see "Player Ratings” on page 133.

LAYER RETIREMENT

In a Career Association, players decide at the end of each season
whether to return for another season or to retire. Factors involved
in their decision include the number of seasons they have played,
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how well they performed in the previous season, and how well
their team performed in the previous season. Any player who has
suffered a career-ending injury will retire at this time as well,
Notification that players have retired appears in the Team News
and Association News screens. You can view retired players
statistics from the Association Statistics screen.

ASSOCIATION VS. EXHIBITION
GAMES

Association games are played between two teams in the same
Association, according to the Association schedule. After the game
is over, statistics are saved, league standings are updated, and
injuries are recorded. Box scores are saved for the last 7 game
days. All games for the same day in the Association schedule must
be completed (thus advancing the FPS: Baseball calendar) before
any games on subsequent days may be started. For more
information, see "Association Overview" on page B4.

Exhibition games on the other hand, may be played between any
two teams from any two Associations. A team may even play
against itself. After the game is over, statistics and injuries are not
recorded, and league standings are not affected. Only one box
score, from the most recently completed exhibition game, is
available. You may start and save as many exhibition games as
you wish (as long as you have space on your hard drive). For more
information, see "Exhibition Overview” on page 143.

PLAY vS. SIMULATE

League games may be either played or simulated. When a game is
played, you see the game take place on your screen, and if either
of the teams involved is human-owned, you can take control of that
team. You might want to watch a game between two computer-
owned teams to scout an upcoming opponent for a team you
control. You can specify on the Association Schedule screen which
games to simulate.
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much less time than one that is played. All games are set to
ulate by default, but you can set any individual game to be
__layed on either the League (Association) Schedule or Team
Schedule screens.

Using FASTSIM

FPS: Baseball includes a FASTSIM feature that allows you to
simulcte games in about one third the speed of the standard
gimulation, but without saving highlights. By default, FPS:
Baseball is set to use the standard simulation mode. To change to
FASTSIM:

. Open the BBPRO.INI file, which is in the BBPRO directory.

Locate the "Fast=0" entry in the [Sim] section and change it to
'Fast=1."

8. Save changes to the BBPRO.INI file.

TARTING A GAME

'The simplest way to start an exhibition game is to click Exhibition
Play on the FPS: Baseball startup screen. This option limits your
choices as far as selecting teams in different leagues or all-star
‘teams. For more control over Exhibition Play, you can click League
Management to go to the Front Office and select Exhibition Play
from the Main menu, then choose your settings and click Play
Game.

To start an Association game, you can use the Team Schedule
screen, or the Association Schedule screen.
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UNRESOLVED TRANSACTIONS

Wher}' you attempt ‘to start a game, you may get a dialog box which
says "There are still teams with unresolved trades or free agenl

signings." You have the option to "Reject trades and release fres
agents" or "Cancel".

RESUME SAVED GAME

The Resume Saved Game screen displays a list of all games that
have been saved while in progress. To resume a game, click on the

game in the list box, then select Resume Game from the Action
menu.

To delete a saved game, click on the game in the list box, then
select Delete Game from the Action menu. Each saved game uses
about 100 KB of hard disk space.

SET STARTING PITCHERS &
LINEUPS

If you start an exhibition game with the Use Lineup option turned
on, the game will start using the next starting pitcher in the
rotation and the standard starting lineup for each team. Ii Use
Lineup is turned off (or when starting league games), the Start

Game dialog box lets you modify the starting pitcher and lineup
for this game.
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This diclog box is divided into four sections, but only one is active
‘¢t o time. Ecch team may change the starting pitcher and then the
starting lineup. To make changes, click on the Change button. This
1 take you to the Team Roster where you can alter both
‘defensive positions and pitchers.

hen you have made all desired changes in a section, click OK to
‘advance to the next one.

BoxX SCORE

'The box score screen shows the box score from a game you have
selected. You can display the box score screen in any of the

{ "o]]owing Ways:

1 From the Association Schedule screen, click on the game that
has been completed within the last 7 game days.

2. From the Team Schedule screen, click on the game that has been
complete within the last 7 game days.

8. From the Exhibition Play screen, select Show Box score from the
Action menu.

You may also choose to see highlights, if they are available by
selecting Highlights from the Show menu. This will take you into
the 3D Stadium for VCR playback. (Highlights are only save for the
previous day's games.)
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The Show Menu

‘Batting/Fielding: Sets the box score displays to show data about
batting and fielding during the game.

Pitching: Sets the box score displays to show data about pitching
during the game.

‘Highlights: Takes you to the VCR to see saved highlights from the
- game. Highlights may not always be available. The computer will
automatically save highlights from simulated games, but
highlights are not automatically saved from Exhibition games.
Highlights will be available from played games only if you have
saved them. In addition, highlights from League games are
deleted after one game day.

BASERUNNING:
€S  Dye, J.

There are two scroll boxes, which show data for each team. The
visitors are shown in the left display, and the home team in the
right display. (In the screen shot above, the home team's display is
scrolled down to show all of the stats.) The displays show either
Batting/Fielding data (as shown above) or Pitching data (as shown
below) based on the settings on the Show menu.

EXHIBITION OVERVIEW

The Exhibition Play screen allows you to select two teams and play
a game that does not affect the standings or statistics of those
teams in their respective Associations.

To play an exhibition game:

1. Click Exhibition Play on the FPS: Baseball startup screen or
select Exhibition Play from the Main menu.

2. Select the teams and the stadium.

3. Select the weather conditions.

4. Set the field rules and game options.
5. Set the team controls.

B. Select Play Game from the Action Menu.
The Action M
enn 7. Set the starting pitchers and lineup. This step is optional. If you
P Y
check Use Preset Lineup in the game options, you do not need to set

Print: Prints the b
OX score. the starting pitchers and lineup.

Once you have completed an exhibition game, you can view the
most recently completed game's box score by selecting Box Score
from the Show menu while displaying the Exhibition Play screen.
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EXHIBITION: TEAMS AND STADIUM

When the Exhibition Play screen is displayed, it already has teams
and a stadium selected (the ones that were used the last time to
start an exhibition game).

! Atlanta

Changing a Team

To change a team, click on the team name, for either the home team
or the visitors. A dialog box appears, giving you the option of
selecting either a Standard Team (one that currently exists in some
Association) or an All-Star Team, which FPS:Baseball '98 creates
for you. You can also press Cancel if you decide to use the
previously selected team.

Standard Team

All-%tar Team

Standard Teams

If you select Standard Team, the Standard Team selection dialog
box is displayed. In the edit box at the top is the name of the
Association that contains the teams displayed in the list box. To
select a different Association, click on the Association name. The
Select Association dialog box is displayed. Scroll through the list
of the Associations and click on the one you want to use. Then click
the OK button.

Now, scroll through the list of teams and click on the one you want
to have play in the game. Then click cn the OK button,
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All-Star Teams

If you select All-Star Team, a Choose Players From: dialog box
appears. The top edit box lists the name of the Association from
which to select the all-star players. (All players on an all-star team
must come from the same Association). To select a different
Association, click on the Association name. The Select Association
dialog box is displayed. Scroll through the list of the Associations
and click on the one you want to use. Then click the "OK" button.

The League text box displays the league from which to select the
all-stars. It may say All Leagues to select the players from all
leagues in the Association (or if there is only one league in the
Association), or it may list the specific league to use. To select a
different league from within the Association, click on the League
edit box. The text will change to the next league or All Leagues.
Repeat until the league you want is displayed.

If you select a specific league from which to select the all-stars,
you'll also have the opportunity to specify the division from which
to select the players. Click on the Division edit box to cycle through
the divisions in the selected league, or All Divisions to include all
divisions within the league.

Click on the OK button to have FPS: Baseball generate the All-Star
lineup.

Changing the Stadium

To change the stadium in which the game will be played, click on
the Stadium text box. A Choose Stadium dialog box is displayed.
Scroll through the list of stadiums and click on the one where you
want to play. Then click on OK. If you want to play in the home
team's stadium, just click on the Home Team's Stadium button. If
‘you change your mind and do not want to select a new stadium,
just click on Cancel.

TEAM CONTROLS

'The control text boxes allow you to choose how each team is to be
controlled. You may choose Computer, Keyboard R (right),
Keyboard L (left) or, if available, Joystick 1 - Joystick 16. Click in the
‘text boxes to cycle through the options. (See "Game Controls” on
page 22 for more information.)
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Computer

Computer

Managing Mode: allows you to select the managing control for
human-owned teams. Click in the text boxes to cycle through
Computer, Basic, Standard, or Advanced settings.

Manage only: turning on this check box sets all on-field control
modes (Pitching, Batting, Fielding, Running) to Computer.

Pitching. Batting, Fielding, Running: These text boxes allow you to
set the on-field control modes for each team. Click on the text
boxes to cycle Computer, Basic, Standard, and Advanced modes.

EXHIBITION: WEATHER
CONDITIONS

The weather condition options are available when you select
Exhibition Play from the Main menu in the Front Office. However,
they are not available when you select Exhibition Play from the
FPS: Baseball startup screen.

There are three ways to specify the weather conditions for the
exhibition game you are about to play (you can not change
weather conditions for Association games):
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In from Center

1. Have the computer select the conditions.

Click on the Computer Selects option button, then click on the City
text box to select the city. A Select City dialog box appears. Scroll
éihrough the list of cities and click on the one you want, Then click
' OK or click Cancel to leave the selection as is. FPS: Baseball will
pick a month and set the weather conditions accordingly.

2. Select the city and month.

Click on the Set Month option button, then click on the city text box
to select the city. A Select City dialog box appears. Scroll through
the list of cities and click on the one you want. Then click OK. Then,
below the city name, click on the option button for the month in
which you want to play. FPS: Baseball will set the weather
conditions accordingly.

8. Specity the exact conditions you want.

'Click on the Set Conditions option button. The conditions will be
- displayed below the button (as shown above). Use the scroll bar to
set the Temperature and Wind Speed. Click on the Skies and Wind
Direction text boxes to cycle through the various conditions and
directions. (Yes, you can even make it rain in a domed stadium...)

XHIBITION: RULES & OPTIONS

hese options are available when you select Exhibition Play from
‘the Main menu in the Front Office. However, they are not available
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when you select Exhibition Play from the FPS: Baseball startup
screen.

Ground Rules

There are seven ground rules. To turn on « ground rule click on the
check box next to it, so that a check appears. To turn off the ground
rule, click on the check box so that the check disappears. You may
set the rules differently for the home team and the visiting team.

Injuries: When "Injuries” is turned on, players may be injured and
have to leave the game. (If you turn Injuries off after a player has
been injured, that player will not return to the game.)

Fatigue: When "Fatigue" is turned on, pitchers tire (and their
performance sulfers) as the game progresses according to their
Endurance rating and the number of pitches thrown.

DH Rule: Determines whether the team can use a designated hitter.
If "Designated Hitter" is turned off during a game, the player who
had been the DH will be removed from the game and cannot be
used later.

Use Ratings: Determines whether individual player ratings are
used during the game. When it is turned off, all players' skills are
rated as Average (50).

Fielding Errors: Determines whether fielding errors may or may
not occur. If it is turned off, all throws are on target and fielders will
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‘not make errors, although there still may be balls that they cannot
‘handle.

‘Base Stealing: When turned on, the team's base runners may
attempt to steal.

Pitch to Center: Disables the Pitch Location variable. When it is
turned on, all pitches thrown by your pitcher in the League game
‘will be to the center of the plate.

Game Options

There are two gume options that you can set on the Exhibition Play
screen. To turn an option on click on the check box next to it, so that
an check appears. To turn it off, click on the check box so that the
check disappears. The options apply to both teams.

,_f_Use Preset Lineup: Proceeds directly to the game using preset
lineups for facing left- and right-handed pitchers. If turned off, you
will have the chance to set the starting lineup for each human-
controlled team.

One Pitch Mode: When it is turned on, only the final pitch of the

plate appearance will be shown, except for stolen bases, wild

pitches, passed balls, successtul pickoffs, and pitchouts. Note:
Batting, Baserunning, Pitching, and Fielding controls must all be
set to Computer for one-pitch mode to be available.
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UPDATING ASSOCIATIONS

There is no need for you to update FPS: Baseball '96 associations
for use with FPS: Baseball ‘98. However, if you still have FPS:
Baseball '94 associations, you will need to update them.
BBBUPDATE is an FPS: Baseball utility program. It allows you to
search your drive(s) for FPS: Baseball '94 associations, copy them to
the Baseball '98 directory, and convert them to a format compatible
with FPS: Baseball.

CASIERRAVBASEEAL L \assn\0BNEWOOB.ASN
CASIERRANBASEEALL vassn\DBNEW D04 25N
CASIERRANBASEEAL L \assn\IBNEWD0ZA5N
CASIERRAVBASEEAL \assn\MLEPAJ4.45N

FEB 23 8-TEAM
GREAT 8
MLEFA 1934
MNew Associal
JLEOD

ANLD
AassnyOBNEWOD3ASN
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Starting the Program

To start the program, go to Start > Sierra > FPS BBUpdate Utility.

Program Operation

1. When the program starts, it automatically detects all drives on

your system and adds them to the "drive" box at the top of the

BBUPDATE screen.

2. Then BBUPDATE does an automatic search of all directories on

the first drive listed. If it finds a FPS: Baseball '94 Association, it
adds it to the upper list box ("Baseball '94 associations found on
this drive").

3. Next, you may do any of the following:

Exit: This simply exits the program without any copying or
converting.

Add: This copies the selected association from the "found" list box
to the lower "chosen" list box ("Associations to be copied and

converted").

Remove: This removes the selected association from the "chosen"

list box.

Copy and Convert: This ends the selection process and begins the
copying and converting. The wait cursor is displayed, and the
status of the operation is displayed in the bottom right corner of the

- screen. When copying/converting is complete, the program

terminates. During the copying/converting process, a log file
named BBUPDATE.LOG is produced in the same directory where
BBUPDATE.EXE is located. This file will show you what

- associations were copied and converted. If you run BBUpdate

again, the results will be appended to this file.

The Space available... and Space required... text boxes show you
- the required storage information.

Note: BBUpdate can not read associations that are read-only.
Consequently, you will not be able to update associations
from o CD. You can copy the Association to your hard drive
yourself, then run BBUpdate to convert it.
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ENTERING CusTOM TEAM DATA
WiTH THE DATAIN UTILITY

FPS:Baseball '98 includes a separate program that allows you to
enter player data and statistics, and convert this information to
player ratings that can be used in the game. You may create full
teams of up to 40 players and use them as a source when creating
new Associalions. You may also create individual players lo be
placed in the free agent pool of existing Associations.

To start Datain, select Start > Programs > Sierra > FPS Dataln
Utility.

Complete instructions for using the program are contained in its
on-line help. Press the F1 key anytime while in the Dataln program
to display its help file.

GENERAL

Dataln provides a fast and easy-to-use method for creating players
and teams for use with Front Page Sports: Baseball Pro. Help is
always available by pressing the Fl key. Additionally, data field
explanations corresponding to the highlighted data field are
shown at the bottom of the screen.

Navigating in Dataln:

You can use either a mouse or the keyboard when working with
Dataln.

MOUSE - Dataln will allow you to select menu items, data
fields, and pick-list items simply by pointing to the item with
the cursor and clicking the left button. The mouse can also be
used to scroll « list up or down by clicking on the up/down
arrows on the scroll bar. For specific instructions on using
your mouse, refer to your mouse users manual.

KEYBOARD - Dataln was designed to provide a simple and
logical keyboard interface. As with the standard FPS: Baseball
menus, the pulldown menus can be accessed by holding down
the Alt key and pressing the highlighted letter. For example,
to access the Player menu hold down the Alt key and press the
P key.

152

‘Once a menu is pulled down, you can navigate between menus
‘and menu items by using the cursor keys on the keyboard and
pressing the Enter key to select the highlighted option.
Additionally, the individual menu items can be selected by
pressing the letter that corresponds to the item's highlighted letter.

'On the data entry forms, you can move between the data fields in
‘Beveral ways. Press either the Enter key or the Tab key to move the
‘cursor to the next field in the template. Press Shift+Tab to move
‘back to the previous field. The PgUp and PgDn keys will move the
form up or down « full section at a time.

‘Some menu functions can be accessed with aCtrl key combination
‘as indicated on the pull-down menu.

DITING PLAYERS AND TEAMS

In addition to creating players and teams, Dataln allows you to
‘edit the personal data and all ratings and modifiers of players in
existing Associations.

To edit or create players in existing Associations, perform the
following preliminary steps:

1. Choose Open Association from the File menu and select the
Association you wish to edit.

2. Choose the Select Team option from the File menu and select the
team you wish to edit from the list. Note that in addition to the
standard teams in the Association, the list includes the Free Agent

and Amateur draft pools, which may be selected as you would any
other "team".

3. You may choose one of the following methods of manipulating
the players in your Association:

a. From the Player menu, select Add Player (CTRL+A) to add a
player to the team. (Note: teams in single-season associations
may only carry up to 40 players while those in career
associations may carry up to 50 players, while the draft pools
may carry any number of players).

b. From the Player menu, select Edit Player (CTRL+E) to edit
any of the personal data, ratings, and modifiers of a player on
the selected team. Choose the player you wish to edit from the
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list of players presented when the option is selected. The
player will be edited with the selected Form.

c. From the Player menu, select Delete Player to delete any
player on the selected team. Choose the player you wish to
delete from the list of players presented when the option is
selected. Since the operation is immediate and permanent,
you will be asked to confirm the deletion of the selected
player.

d. From the Player menu, select Generate Player to randomly
create a player for the selected team. The player will be
created using the same methods used to generate players for
new fictional Associations. (Note: teams in single-season
associations may only carry up to 40 players while those in
career associations may carry up to 50 players, while the draft
pools may carry any number of players).

e. From the File menu, select Change Ratings to increase or
decrease any of the actual or potential ratings or modifiers by
a fixed amount or percentage for a single player, a single
team, or the entire Association.

{. From the File menu, select Ratings Compute to recompute the
potential ratings for all players in the Association, based on their
current age and actual ratings. This function is useful as a final
step after making changes to actual ratings to make certain that
players have the proper room for growth as they age.

When editing the player information, you can view the player
database record through any of the 9 "forms" corresponding to
popular statistical sources. These forms access the same
database record, but limit the display to the fields available in the
various source books. See "Forms” on page 162 for more
information.

MENUS

The Dataln menus are accessible via the keyboard, mouse, or with
the special hot keys. The availability of some of the menu
tunctions, however, depends upon where you are in the program.
If a menu item is not currently available, it will be "ghosted." If you
are currently engaged in a task such as modifying the team data,
attempting to access the menu items will result in an error
message indicating that you must complete the current task.

154

Baselall Pro

FILE MENU

The File Menu allows you to perform functions for a team or
association. The options are:

Open Association
Allows you to open an existing association for editing. To edit

players existing players, you must select a team using the Select
Team command, described below.

| Close Association

Closes a currently open association. Only one association can be
open at a time.

Create Team
This option allows you to create a new single-team Association.
You can use this single-team Association as a source Association

tfor creating new multi-team Associations in FPS: Baseball Pro.

You will be asked to input the team's City, Nickname,
Abbreviation, and Year. Although not required, you may also enter

- the team colors, the manager name, the name and location of the

stadium and the stadium model. Information about these choices
can be found in the Team Data section.

The team year entered serves as the default year for the players
created on the team. Additionally, the year serves as an identifier
when selecting source associations in the New Association
creation process.

Select Team
This option allows you to select an existing team from an open
association. If you do not have an Association open, you must first

select an existing Association for editing.

You may also edit the historical statistics and ratings of any
player.

~ Delete Team

This option allows you to delete an existing single-team
Association.
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Modify Team

This option allows you to modify the City, Nickname, Abbreviation,
and Year for an existing single-team association created by
Dataln. You may also enter the team colors, the manager name, the
name and location of the stadium and the stadium model. Teams
in existing Associations may only be edited using the main
program.

Print Team

Prints the roster of the currently selected team to your default
Windows printer.

Change Ratings

This option allows for global editing of ratings for a player, a team,
or an association.

Ratings may be changed for a single player, the currently loaded
team, or the currently loaded association. Ratings may be
changed by a fixed amount or a percentage of that rating. To select
multiple ratings to change, click on each rating; to deselect a
rating, click on it again.,

Ratings Compute

This allows you to recompute the potential ratings for all the
players in the currently association, based on their age and actual
ratings.

Preferences

This options allows you to set numeric or alphabetic choice for
player positioning.

With the Numeric option selected, fielding positions are referred to
by their commonly accepted numeric value. These values are:

P=1,C=2,1B=3,2B=4,38=5S53=6LF=7CF=8andRF =9

With the Alphabetic option selected, fielding positions are
selected by the first letter or number. The following inputs
correspond to the specific positions:

P=P,C=C,1=1B,2=2B,3=3B,5=55,L=LF, CF=CF.and R=RF
Select the convention with which vou feel most comfortable.
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Exit

Closes Dataln and returns you to Windows.

PLAYER MENU

This menu allows you to perform functions on a player level. The
functions on this menu require that a team be currently selected for
editing.

Add Player (CTRL+A)

Allows you to create a new player record in the database. If
editing a single-team association, this function is available only if
there are less than 40 player records.

Edit Player (CTRL-E)

Allows you to edit an existing player. You will be presented with

- a dialog box listing all the players on the current team. Highlight

the name of the player you wish to modify and click the OK button

‘or simply double-click the player name to edit that player.

:'Delete Player

Allows you to delete a player from the current team. After selecting
the option, you are presented with « list of all players on the team.

'Highlight the player you wish to eliminate and click the OK button.

A dialog box will appear asking you to confirm the deletion.

Generate Player

Creates a player with "random" age, position, and ability ratings.
The player generation algorithm used here is the same as that
which creates entire fictional associations and fictional ameteur
players.

HELP MENU

The Help menu allows you to view various help topics for Dataln.
You may also get help by pressing the F1 key; the help topic that is

- displayed depends upon what you are doing at the time. If there is

more information than will fit in the window, you can scroll
through the page using the PgUp and PgDn keys, or by using the
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mouse to manipulate the scroll bar on the right hand side of the
screen.

You may view the contents of the help file by clicking the mouse
cursor on the Contents menu choice under the Help Menu.

To exit help use the Windows Close Button or chose Exit under the
File Menu.

TEAM DATEA

When creating or editing a team, you will need to specily some
basic data so that the team can be identified by both Dataln and
the New Association creation process in Front Page Sports:
Baseball Pro.

To select a lield to change, press the highlighted letter in the field
label or click on the field with the mouse cursor. You will be
presented with a dialog box displaying the current data. If you
wish to change the current data entirely, simply start typing the
new data. If you wish to edit the data press the left or right cursor
keys to activate the current data, then make any necessary
modifications.

When you are finished entering or editing a data field, pressEnter
or click the mouse cursor on the OK button. If you wish to cancel
the changes you have made, press Esc or select the Cancel button
with the mouse. Aiter you have made all necessary changes to the
team data, press Enter or click on the OK button with the mouse
cursor. If you wish to cancel the changes, press Esc or click on the
Cancel button.

Required Team Data:

City - The first part of a team's name, usually the city or region.
Examples would be Eugene, Springfield, and Oregon.

Name - The second part of a team's name, usually a nickname.
Examples would be Rivermen and Loggers.

Abbr - The team abbreviation, usually a 2-4 letter designation that
identifies the team in the Association. Examples would be EUG,
SPRG, and OR.

Year and League - The Year and League for the team. This field
will be used as the default Lg¥r when creating new players for the
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team. Providing the proper league and yvear information on this
screen will save you from having to enter it for each new player
you create. Any year can be entered, but the league must be either
N, A, or F (National, American, Federal). The league year is used to
value a player's performance based upon that year's league

averages.

Optional Team Data:

.-Uniiorm Color - Choose from among 21 "standard" uniform color
schemes. You may fine tune each specific part of the uniform from

- the Team Data screen in the main game.

Manager Name - You may provide the team manager's name in
this space.

Stadium Name - You may provide the name for this team's
stadium.

Nearest City - Select the "nearest city" for the team. The "nearest
city" is used strictly for weather pattern determination and does

not need to correspond in any way to the Team City data described
above.

Stadium Model - Select a stadium configuration for the team from
among the various stadium models provided with the game.

PLAYER DATA

‘Required Data

The following items must be entered for new players you create.

First Name - Usually the player's popular or nickname and
contains any necessary middle name abbreviations,

Last Name - Usually includes Sr., Jr. or other titles as applicable.

Pos - The player's primary fielding position. If you are entering a
player who is listed simply as Outfield (OF), assign the player a
Specific position based upon your subjective analysis of his
fielding ability. Assign the best outfielders the CF position and LF
1o the worst. If the player is a DH only, you will probably want to
assign either a known fielding position from a previous season or
the 1B position.
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Using the Preferences command from the File menu, Dataln can be
configured so that this field accepts either text or numeric position
input. If configured for text input (default), the field will acceptP
(pitcher), C (catcher), 1 (first base), 2 (second base), 3 (third base), §
(shortstop), L (left field), CF (center field - note that CF is the only
position requiring two keystrokes), and R (right field). If configured
for number input, the field will accept 1 (pitcher), 2 (catcher), 3 (first
base), 4 (second base), 5 (third base), 6 {shortstop), 7 (lett field), 8
(center field), and 9 (right field). See File Menu for more details.

The player needs to have a Primary Position. You may either enter
the actual Primary Position or you may enter the total number of
Games Played By Position and Dataln will calculate the Primary
Position.

Age or Birth Date - The player's age is crucial in determining
potential ratings for career league players. Player age is
calculated for a season as of April 1. For example, consider two
players born in 1960, one on March 31 and one on April 31. When
playing in 1983, the player born on March 31 will be considered to
be 23 years old, and the player born on April 31 will be considered
to be 22.

If you provide only the player age, Dataln will assign a Birth Date
of January 1 for the League Year minus Age. If you provide the
player's Birth Date, the Age can be calculated based upon the
League Year and the April 1 cutoff. The player's birth date in MM/
DD/YYYY format. If the year is in the 1900's, you may simply type
in the last two digits and Dataln will provide the "19" prefix

Lg¥r - The Year and League in which the player posted the stats.
This is used to calculate the player's Age and to normalize the
player's statistics to the context in which they were created. If the
year is in the 1900's, you may simply type in the last two digits and
Dataln will provide the "19" prefix.

When the player ratings are calculated (based upon the statistics
you have entered), Dataln will first adjust the statistics based upon
its internal tables for the League Year specilied. The tables
contain the normalization factors for the various pitching, hitting,
and fielding statistics for each American and National year from
1901 to 1995 as well as the Federal years 1914-1915. If a year other
than these is provided, the normalization factor is the average of
all 192 league seasons.
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For example, in 1930, the league batting average for the Nationals
was .303 while in 1968 the average was .243. It is easy to see that a
+275 hitter in 1930 would be considered a below average hitter, yet
in 1968 would be considered above average. You can get an idea
of how much baseball statistics have fluctuated over the history of
the game by creating a player, then changing his League Year and
recalculating the ratings.

Optional Data

Bats - The "hand" the player bats with. The default is R (right-
handed batter). Dataln will accept L for left-handed batters, R for
right-handed batters, and S or B for switch hitters.

Deliv - The style of throwing when the player pitches. The default
is O (overhand). Dataln will accept O for an overhanded delivery
and S for a sidearmed delivery.

‘Exp - The number of years of league experience. Years spent in
AAA or the Low Minors do not count towards experience. The
‘number should include the current year if end-of-season stats are
being entered. For example, if you are entering a rookie's mid-
- season stats, this would be 0, but if you are entering the end of
season stats, this would be 1.

Num - The player's uniform number.
number if the field is left blank.

Dataln uses the player

Skin - The player's skin tone. The default is L (light skin). Dataln
will accept L for light skin, M for medium skin tone, and D for dark
skin.

‘Throws - The hand the player throws with. The default is R (right-

‘handed). Dataln will accept L for left-handed throwers and R for
right-handed throwers.

REPLACEMENT DATA

Dataln will calculate player ratings based upon the statistics you
“have entered for a player. If you do not provide any statistics, the
player will be calculated as a "replacement level" player, which is
a player below league average.
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In addition to normalizing the player ratings based upon the
League Year context in which they were created, players with
insufficient playing time to establish their level of play are
normalized with the "replacement level". For example, a player
that hits 400 in 10 at-bats has not had enough playing time to
establish the .400 as his actual ability, whereas a player who hits
.400 in 300 at-bats has established an ability to hit at that level.

For more information, see “Player Ratings” on page 133.

FORMS

When creating players with Dataln, you can select one of nine data
entry "forms." The forms provide a "window" to the player database
record that conforms to the layout of seven popular baseball
reference works as well as two special layouts, as described
below. Please note that none of the publishers of these reference
works specifically endorse Front Page Sports: Baseball Pro, nor
does FPS: Baseball Pro specifically endorse any one of these works
over any of the others.

STATISTICS

For a complete list of statistical description, see "Statistical
Totals" on page 100.

RATINGS

Ratings determine how the player will perform in FPS: Baseball
Pro. When you calculate the ratings for a player or team, Dataln
will evaluate the statistics you have entered and generate the
player ratings accordingly.

Modifiers are used to adjust the ratings up and down depending
upon game situations and proven player tendencies in those
situations. Modifiers have a base level of 50. The further from 50
the more pronounced the effect the modifier will have on the player
abilities. Values above 50 indicate o tendency to perform well in
the indicated situation.

Generally, if a player has less than 300 plate appearances, 600
defensive innings, or 50 innings pitched, his calculated ratings
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will be normalized with a "replacement level" set of ratings. The
replacement level is a below average ability and represents what
you would expect to receive from an unproven player. The average
level is considered to be the league average level of performance.
Simplistically, if the league batting average is .250,a player with
average level ratings would bat around .250.

BBARCHIVE - BACKING UpP
ASSOCIATIONS

Backing up important data files is always a good idea, and FPS:
Baseball Associations are no exception. A separate utility called
FPS Archival Utility, or BBArchive, is automatically installed when
you install FPS: Baseball, and it can be found in the Sierra/
Baseball program group, or it can be found under the name
BBARCH.EXE in the directory where FPS: Baseball was installed.
BBArchive finds all of the files belonging to the selected
- association (except for saved games), and compresses them into a
single backup file on the destination you specify. If you specify a
floppy drive destination, BBArchive will prompt you for additional
floppies as needed.

B9E\CDroot\B aseball\Assn
D:\BB3E\CDroothB aseball\assn
D:ABE3EACDroothB aseball\Assn
D:ABBSEACDronthBaseball\dssn
D:ABBSEACDoat\Basehall\dssn

i

ew Association
-BL-6-6Lx
1aft Test

When you start BBArchive, it will automatically search for any
Associations found on your hard drive (or other drive specified in
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the drive text box) and display them in the upper list box. Highlight
each one that you want to archive (one at a time) and click any
appropriate check boxes.

Delete Original: removes the original Association files from your
hard drive once they are backed up.

Include Box Scores: includes box score files with the other
association files.

Include Highlight Films: includes highlight films with the other
association files.

Click the Archive bulion to begin the backup. A dialog box will
appear, allowing you to select the directory location for the backup
file. You may select a floppy drive and BBArchive will split the
backup across multiple floppy disks as necessary. The time
required for backup will vary depending on the size of the
Association. '

Restoring a Backup

Any Associations shown in the lower list box may be restored into
the \Assn and \Stats directory where FPS: Baseball is installed on
your hard drive. Highlight the name by clicking on it, then click the
Restore button. If the Delete Archive box is checked, it will remove
the archived file once it is restored to your hard drive.

REMOTE LEAGUE COMMISSIONER
TASKS

FPS: Baseball includes a utility for managing a multi-player
remote league so owners can play out their league games on their
own computer system and send the results to a commissioner for
compilation into the master association files.

If you are going to be an owner in a remote league, see “Remote
Leagues Owner Tasks” on page 189,

Following is an overview of the remote league process that you can
use as a checklist to ensure that the remote league operates
smoothly:
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Commissioner Responsibilities

Generating the Starting Game Files

L, The commissioner (being the person responsible for
maintaining the master league files) makes an archive of the
current association files using the BBArchive archival utility. The
commissioner should also ensure that the default association
loaded when Baseball is started is the remote association. See
Preferences for instructions on setting the default association and
team.

2. Go into the Front Office portion of FPS: Baseball and create an
association in the normal manner.

3. Exit FPS: Baseball and launch the Remote Manager Utility,
which is in the Bbpro_98 directory.

4. Select Main > Select Association and lead the association you
just created.

5. Select Main> Set Preferences to configure the remote functions
for the selected league.

Remote directories - Local and FTP sites

Maximum play modes - The maximum playing mode
(Computer, Standard, or Advanced) that the commissioner of a
remote league will allow owners to use during remote league
games.

Commissioner name and password

Specify a "preferred play" team. (If both teams send results, the
preferred play team's results will get processed.)

6. Select Commissioner > Set Source to set the current condition of
the league as the "original source" to be used when generating
update files.

7. Select Commissioner > Upload/Download to send the "original
source” association files to the remote site and announce a
deadline for getting change files from prospective owners.
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Basic Management Responsibilities

1. When the deadline for owners to submit change files arrives,
select Commissioner > Upload/Download to download any change
files from the remote owners.

2. Select Commissioner > Process Day's Results to process the
change files from remote owners.

3. Select Commissioner > Create Update to create an update file
with the changes from the new owners.

4. Select Commissioner > Upload/Download to send the new
update file to the remote site.

Initial Draft (optional)

If the commissioner starts the association with an initial draft, it
must be completed and processed before league play can
commence. To initiate a dreaft:

1. Announce to the league members that their draft list must be
uploaded to the remote site by a specific date and time. The
commissioner also specifies how many rounds will be included in
the draft.

2. At the draft list submission deadline, selects Commissioner >
Upload/Download to obtain the draft lists from the remote site.

3. Select Commissioner > Process Draft List to process the draft
lists.

4. If the draft is not completed, select Commissioner > Create
Update.

5. Select Commissioner > Upload/Download to send the update file
to the remote site.

6. Repeat steps 1-5 until the draft is completed.
Series Play

For each "play period," the commissioner needs to designate the
number of games to be played, who is responsible for playing the
games ( home or visiting owner), and when the deadline for
uploading game results will be. He then performs the following
actions:
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1. Select Commissioner > Create Update to create the update file
for the current period.

2. Select Commissioner > Upload/Download to send the update file
to the remote site.

3. When the deadline for the play period arrives, select

.~ Commissioner > Upload/Download to download the results from

the remote site.

4. Select Commissioner > Process Day's Results to process the
game results and roster moves for each team in the league.

5. If there are any remaining games for the current day, select
Commissioner > Simulate Remaining Games to launch FPS
Baseball '98's Front Office and simulate the remaining games.

6. This will advance the assocciation date. Repeat steps 4 and 5
until all games are completed for the current period.

7. (Optional) Select Commissioner > Print and/or Team > Print to
create any desired HTML printouts, such as the box scores for the
current play period. The printout is sent to the download site at the
next upload or download.

8. Select Commissioner > Create Update to create an update file
for the end of the current period. This gives visiting owners a
chance to make roster changes before the beginning of the next
play period (home owners can make roster moves during the play
period).

9. Select Commissioner > Upload/Download to send the update file
to the remote site. Announce a deadline for roster moves to the
owners.

10. When the roster move deadline arrives, select Commissioner >
Upload/Download to get any change files from the remote site.

11. Select Commissioner > Process Day's Results to process the
roster move change files for the current day.

The association is now ready to begin the next play period at step 1.
Between Seasons

1. Upon completion of any post-season play, the association is
ready for the next season. The commissioner starts the game
normally and selects Start New Season from the Association menu.
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2. After all processing has completed, the association is ready
for the Free Agent Draft. The commissioner exits FPS: Baseball,
starts Remote Manager, and selects Commissioner > Create
Update to generate the update file for the draft and gives owners a
deadline to get their draft lists uploaded.

3. Select Commissioner > Upload/Download to send the update file
to the remote site.

4. When the draft list submission deadline is reached, select
Commissioner > Upload/Download to download the draft lists.

5. Select Commissioner > Process Day’s Results to process the
draft lists.

6. Select Commissioner > Create Update to generate the update
file.

7. If the draft is to continue, select Commissioner > Upload/
Download to send the latest update to the remote site and
announce a new draft list deadline. Repeat steps 4-7 until the draft
is completed, leaving the game ready for spring training.

8. Select Commissioner > Create Update to generate the update
file for the end of the dratt.

9. Select Commissioner > Upload/Download to send the latest
update file. Announce a deadline for Spring Training change files
to be uploaded to the remote site.

10. Upon reaching the deadline, select Commissioner > Upload/
Download to download the spring training change files.

11. Select Commissioner > Process Day’s Results to process the
spring training change files.

12. Start baseball normally, load the remote association, and
select Start Spring Training from the Association menu to process
spring training. Upon completion exit the game and restart
Remote Manager.

13. Select Commissioner > Create Update to generate the latest
update file.

14. Select Commissioner > Upload/Download to send the update
file to the remote site. Announce a deadline for final roster moves
prior to starting regular season play.
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15. Upon reaching the deadline, select Commissioner > Upload/
Download to download any roster moves.

16. Select Commissioner > Process Day’'s Results to process the
roster move change files into the main game files.

17. At this point, the game is ready to start league play for the new
season. The commissioner should reset the Source league. To do
this, select Commissioner > Set Source.

18. Select Commissioner > Upload/Download to send the new
source associction files to the remote site.

The association is now ready to play games.

REMOTE LEAGUES OWNER TASKS

Betore starting a league, the commissioner will recruit people to
play. During this time, owners must decide which teams they will
play and await the source association files to be sent by the
commissioner. When the commissioner has created all source
files, he will inform the owners that it is time to begin league play.

Most of the management tasks for a remote league are performed
from the FPS: Baseball Remote Manager utility, which you can
open by going to Start > Programs > Sierra > FPS BBManage Utility.

- Here's what you do if you are an individual owner playing in o

remote league:
League Preparation Phase

1. Select Team > Join League. A dialog box is displayed asking
the user to specify the location of the source league files. This will
be the main remote site directory (without the SOURCE subdir).
The computer will then go the specified site and look for a source
league file. If found, the file will be downloaded and loaded into
memory.

2. Select Main > Set Preferences to set the local preferences for
the remote league. The remote site and max play modes will
already be set by the commissioner, so the local owner needs to
specify the local directory to store all necessary files and the
remote directory to send HTML files (optional).

3. Select Main > Select Team to select the working team. A check
box on the dialog will allow the user to specily that team as the
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default to be used whenever this association is loaded or the team
can be selected manually each time the user starts the Remote
Manager.

4. Select the Front Office button on the main screen to launch the
shell with the specified association and team loaded. Go to the
Team/Data screen to make any desired changes to the team data,
including uniform color, stadium model and surface type, desired
play and manage modes, and any desired name changes.

5. Exit the Front Office, returning to the Remote Manager.

6. Select Team > Upload/Download to send the changes to the
remote site.

Initial Dratt (optional)

It an initial draft is to be done, the player will perform the following
actions:

1. Once the commissioner has announced that the league is
ready for the draft, select Team > Upload/Download to get the
latest update files from the remote site.

2. Select the Front Office button to go to the front office to
generate the dratt list for the currently selected team.

3. Inthe Front Office, select the Association > Start/Resume Draft
option to get to the draft.

4. A dialog box is displayed telling the user to select at least as
many players from the draft pool as the number of rounds the
commissioner has specified for the draft, multiplied by the number
of teams in the association.

5. The user selects as many players as desired from the pool,
continuing to pick players until the required number of players has
been put into the pick list.

8. The user exits the game to return to Remote Manager.

7.  Select Team > Upload/Download to send the pick list to the
remote site.

8. After the commissioner has announced the presence of o new
update file, select Team > Upload/Download to download and
apply the latest update.
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9. Repeat steps 2-8 until the draft is completed or until the user
wants to drop out of the draft. To drop out of the draft, the user
would select END DRAFT as normal.

Series Play (if you are the active team)

For each series, the commissioner specifies how many games are
to be played. The default (home or away) team plays the games
unless other arrangements are made. For each play period, the
active team (the one playing the games) performs the following
actions:

1. Select Team > Upload/Download to get the latest update from
the remote site.

2. Select the Front Office button on the main screen to go to the
Front Office.

3. The owner can make any last minute roster moves, if desired.

4. The owner launches his game from either the League or Team
Schedule screens by clicking on the game matchup as normal.

5. The game is played either versus the computer or head-to-
head on the saume computer.

6. Once the game is completed, the user goes to the League
Schedule screen and selects Action > Simulate, which marks all
the rest of the day's games as played, without taking the time to
simulate them. Only the current day's games will be marked,
regardless of the length of time the user selects to simulate.

7. Now that the day has advanced, exit the game or play the next
game in the series, as desired.

Note: You can exit the Front Office at this time and then repeat
the above steps for playing each day's games or you can
remain in the Front Office and play all subsequent games
without exiting. You can make any desired roster moves
before play begins for any given game day.

8. Once all games have been completed, exit the Front Office
and return to the Remote Manager.
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9. Select Team > Print and/or Commissioner > Print to create any
desired HTML printouts.

10. Select Team > Upload/Download to send the change files to
the remote site and the HTML files to the specified HTML site.

11. Once the commissioner has announced the presence of a new
update for the roster move period, select Team > Upload/Download
to download the update from the remote site.

12. Select the Front Office button to start the Front Office. Make
any desired roster moves, then exit back to the Remote Manager.

13. Select Team > Upload/Download to send the change file to the
remote site.

Series Play (if you are the inactive team)

The ir.lccctive team may make changes to the roster or lineups for
any given game day. If the changes need to be made in the middle
of a play period, the owner should perform the following steps:

1. Select Team > Upload/Download to get the update file for the
beginning of the play period.

2. Select the Front Office button.,

3. If the changes are to be made on the current day, simply go to
the roster and make the changes. Otherwise, use the Action >
Simulate function on the League Schedule screen to mark all
games for the day as played, advancing the day. Repeat this step
until the desired day is reached, then make the roster moves.
Repeat if roster moves need to be made on additional days.

4,  Exit the Front Office.

5. Select Team > Upload/Download to send the roster moves to
the remote site.
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In most cases, the inactive team will wait for the roster move
update before making changes, allowing these actions:

Note: If a starter incurs a 100% injury during a game, the active
owner may email the inactive owner for instructions for the
lineups for subsequent changes. The active owner would start
the game as a head-to-head game, make necessary lineup
changes, then set the team to computer control in the game
simulation. If lineup instructions are not given, the computer
will qutomatically make out the starting lineups for each of

the subsequent games.

6. Once the game period has been completed and the
commissioner has uploaded the update for the roster move period,
select Team > Upload/Download to download it from the remote

site.

7. Select the League Management button on the main screen to
launch the Front Office portion of the game.

8. Make any roster moves, team data changes, {ree agent claims,
or trade proposals as desired.

9. Exit the Front Office and return to Remote Manager.

10. Select Team > Upload/Download to send the roster moves to
the remote site.

Series Play (inactive head-to-head)

If the two owners play their games head-to-head on the same
computer the rosters for both teams will be updated after each
game, allowing daily roster moves by each owner. However,
separate change files must be made by each owner by entering the
Front Office with a different team selected.
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EDITING THE BBPRO.INI FILE

It you are a seasoned veteran of FPS: Baseball, you might prefer to
go directly to the Front Office, rather than see the startup screen
each time you launch the game.

Note: Although editing the BBPRO.INI fle is simple procedure,
we recommend making a backup of your file if you are not
experienced with making changes to configuration files.

To modity FPS: Baseball so you get direct access to the Front Office:
1. Open the BBPRO.INI {ile, which is in the Bbpro_98 directory. In
Windows 95, it is listed as the file "Bbpro" with the type
"Configuration Settings.”

2. Add these lines to your configuration file:

[BBShell]

EZShell=0

3. Save changes to the file.

The next time you launch FPS: Baseball, you will go directly to the
Front Office.

4. If you want to revert to having the startup screen appear at
startup time, set EZShell=1.

For further instructions on customizing the BBPRO.INI file, read the
file BBPROINLTXT, which is in the BBPRO directory.
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UNINSTALLING FFPS: BASEBALL

If you need to remove FPS: Baseball from your hard drive, follow
these steps:

IMPORTANT! Use the BBArchive utility to back up

any Associations you want to keep, When you back up the
Associations, make sure you place them in a directory other
than where FPS: Baseball was installed (when FPS: Baseball is
uninstalled, everything in the BBPRO_98 directory will be
deleted).

ALSO' If you have installed FPS: Baseball in more than
one directory (for example, in a \SIERRA\BBPRO_98 directory
and in o \GAMES\SIERRA\BBPRO_98 directory), UNINSTALL
will remove the first one you installed. If you have any doubts
as to which was installed first, do not use UNINSTALL; instead,
delete the files and directories manually.

l. From the Windows 95 Start menu, select Programs > Sierra >
Setup & Uninstall.

This will run the Sierra Setup program.

2. Click on the Uninstall button on Setup's Main Menu. A dialog box
displaying all of your Sierra products will appear.

3. Select Front Page Sports: Baseball Pro '98 Season from the list
and click OK. Setup will remove the entire BBPRO_98 directory and
all of the files in it. Setup will also remove items from the registry
pertaining to FPS: Baseball.

What Is Not Removed

Setup does not attempt to remove any system software that was
installed as a part of FPS: Baseball. For example, when you
installed FPS: Baseball, Microsoft DirectX may have been
installed.
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RECOMMENDED READING

If you want more information on the rules and strategies of
professional baseball, the FPS: Baseball team recommends the
following books:

Official Baseball Rules, The Sporting News, 1997.

Nemec, David, The Rules of Baseball, New York, Lyons &
Burford, 1994.

Skills

Boggs, Wade, and David Brisson, The Techniques of Modern
Hitting, New York, Perigree Books, 1990.

Baker, Dusty, Jeff Mercer, and Marv Bittinger, You Can Teach
Hitting, Carmel, Indiana, Bittinger Books, 1993,

Jordan, Pat, Pitching: The Keys to Excellence, Lanham,
Maryland, SportsIllustrated Books, 1988.

Williams, Ted, and John Underwood, The Science of Hitting,
New York, Simon &Schuster, Inc., 1970.

Lau, Charlie, with Alfred Glossbrenner, The Art of Hitting .300,
New York, Penguin Books, 1980.

House, Tom, The Pitching Edge, Champaign, Illinois, Human
Kinetics Publishers,1994,

Hernandez, Keith, Pure Baseball: Pitch by Pitch for the
Advanced Fan, New York, Harper Collins Publishers, 1994.

Statistics & Statistical Analysis

The Sporting News Baseball Guide, St. Louis, MO, The
Sporting News Publishing Company, 1997.

The Sporting News Official Baseball Register, St. Louis, MO,
The Sporting News Publishing Company, 1997.

The Sporting News Complete Baseball Record Book, St. Louis,
MO, The Sporting News Publishing Company, 1997.
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STATS Minor League Handbook 1997, Skokie, IL, STATS
Publishing, 1997.

STATS Major League Handbook 1997, Skokie, IL, STATS
Publishing, 1997.

The Scouting Notebook: 1997, Skokie, IL, STATS Publishing,
1997.

STATS Baseball Scoreboard, Skokie, IL, STATS Publishing,
1997.

STATS Player Profiles 1997, Skokie, IL, STATS Publishing, 1997.

STATS 1997 Minor League Scoutin Notebook, Skckie, IL, STATS
Publishing, 1997.

Srinivasan, David, and Doug Myers, The Scouting Report: 1997,
New York, Harper Collins Publishers, Inc., 1997.

Neft, David S. and Richard M. Cohen, The Sports
Encyclopedia: Baseball, New York, St. Martin's Press, 1997.

Thorn, John, and Pete Palmer, Total Baseball, New York,
Harper Collins Publishers, Inc., 1997.

Baseball Weekly 1997 Almanac, New York, Hyperion, 1997.

Baseball America's 1997 Almanac, Durham, NC, Baseball
America Press, 1997.

James, Bill, The Baseball Abstract, New York, Ballentine Books,
1983-1988.

Clark, Dick, and Larry Lester, The Negro Leagues Book,
Cleveland, OH, The Society for Baseball Research, 1994.

History 8 Miscellaneous

James, Bill, The Bill James Historical Baseball Abstract, New
York, Villard Books, 1988.

Ritter, Lawrence S., The Glory of Their Times, New York,
William Morrow and Company, 1966.

Peary, Danny, We Played The Game, New York, Hyperion, 1994.

Okkonen, Marc, Baseball Uniforms of the 20th Century: The
Official Major League Baseball Guide, New York, Sterling
Publishing Company, Inc., 1993.

Curran, William, Big Sticks: The Phenomenal Decade of Ruth,
Gehrig, Cobb, and Hornshy, New York, Harper Collins
Publishers, Inc., 1990.
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Dickson, Paul, The Dickson Baseball Dictionary, New York,
Avon Books, 1988.

Zimbalist, Andrew, Baseball and Billions, New York, Harper
Collins Publishers, Inc., 1992.

Miller, Marvin, A Whole Different Ballgame: The Sport and
Business of Baseball, New York, Birch lane Press, 1991,

Baseball Weekly (published weekly).

Lowry, Phillip J., Green Cathedrals, Reading, MA, Addison-
Wesley Publishing Company, Inc., 1992.

TROUBLESHOOTING

See also Error Messages.

Problem: I've got my Top View, Scoreboard, Info, or Games Updates
window turned on, but I can't see it.

Possible Solution: To correct this problem, go to the "Display
Windows" tab on the Game Options dialog box and click the "Reset
Positions" button.

Problem: When first playing a game in the stadium, the animations
are jerky or sluggish, but as the game goes on the sluggishness
goes away.

Possible Solution: The sluggishness is a result of loading the
animations into memory when they are first needed, in order to
save time when starting a game. If you have sufficient memory
available on your system, you may preload the animations by
editing the BBPRO.INI file; in the [Graphics] section, set (or add) the
entry that says PreloadAnims= to PreloadAnims=1. Note this will
cause FPS: Baseball to take longer when starting a game (since it
is preloading all the animations), but once the game starts,
cnimations should play more smoothly.

Problem: ['ve deleted or modified the Associations that came with

FPS: Baseball. How do I get the originals back without reinstalling
the game?

Possible Solution: The default Associations are on the FPS:
Baseball CD in an archived format. Use the BBArchive utility and
select your CD drive. The default Associations will be displayed
and you can restore 1 or more of them, For more information, see
"BBArchive - Backing Up Associations” on page 163.
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Problem: The accelerator or shortcut keys shown on the menu
(Ctrl+D, for example) don't work or do the wrong thing.

Possible Solution: You may have the keys assigned in Windows to
do something else. Check your Windows documentation for more
information.

Problem: My cursor is behaving erratically.

Possible Solution: We have found that animeated and 3D cursors
exhibit some erratic behavior when used with FPS: Baseball. To
avoid these problems, simply double-click the MOUSE icon under
Control Panel, select Pointers, and choose the Windows Standard
scheme.

Problem: AutoPlay is not working with FPS: Baseball,

Possible Solution: Many Windows 95 users have the popular
Powertoys accessories installed as part of their default Startup
options. We have found the Powertoys utility, FLEXICD, to have
some potential to cause minor difficulties with FPS: Baseball. The
problem usually occurs when you place the FPS: Baseball CD into
the drive. We suggest you disable this utility before playing. To
close Flexicd, right click on the CD icon on the taskbar and select
EXIT FLEXICD.

Problem: The sounds stop playing or play improperly when I switch
from FPS: Baseball to another application and back.

Possible Solution: For sounds to play properly in FPS: Baseball, the
game's window must be the active window. If the FPS: Baseball
window is not the active window, all music and sounds should
stop. When FPS: Baseball is made active again, sounds and music
will resume. If they do not, it may be necessary to leave the
stadium and return to it to resume the game.

Problem: I'm having memory problems...

Possible Solution: Windows 95: Check your Virtual memory
settings on your system. Click on the START, SETTINGS,
CONTROL PANEL. Click on SYSTEM, PERFORMANCE, VIRTUAL
MEMORY, and make sure the system is set up for "Let Windows
manage my Virtual Memory Settings". If you still experience
memory problems you may need to free up some hard drive space
to enable Windows to use it for virtual memory. Note: If you have
less than 8Mb of free space on your HD, virtual memory behavior
can become erratic.
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ERROR MESSAGES

This section offers possible solutions for error messages you may
encounter. See also "Troubleshooting” on page 178.

UNABLE TO OPEN ASSOCIATION DATA FILE.

PLEASE MAKE SURE THE ASSN AND STATS DIRECTORIES EXIST,
AND THAT THERE IS ENOUGH SYSTEM MEMORY AVAILABLE.

FILE: ...MRDATA.CPP LINE 255

Besides checking that the SIERRA\BBPRO 98\ASSN and
SIERRA\BBPRO_98\STATS directories exist, and freeing up system
memory by closing other applications, use the DOS ATTRIB
command to verify that the files in the \ASSN and \STATS
directories are not read-only. From the DOS prompt, type:

CASIERRA\BBPRO_98\ASSN> attrib -r *.*
CASIERRA'BBPRO_98\ASSN> cd .\stats
CASIERRA\BBPRO_98\STATS> attrib -r ~.*

UNINSTALLER ERROR

AN ERROR OCCURRED WHILE TRYING TO REMOVE SIERRA ON-
LINE GAMES (REMOVE ONLY).

UNINSTALLATION HAS BEEN CANCELED.

This error may occur if you attempt to use Control Panel's Add/
Remove Programs feature and it can not find the Sierra Setup
program where it was originally installed. If this happens, run the
Sierra Setup & Uninstall item from the Sierra program group
instead. Then select Uninstall from Setup's main menu.

RUNTIME ERROR-ABNORMAL PROGRAM TERMINATION

If this error occurs as you are trying to start FPS: Baseball, it may
be because you have deleted all of your Associations or the one
that was set in Preferences to load by default when the game
starts. Try using BBArchive to restore the shipping Associations off
of the FPS: Baseball CD into the directory where FPS: Baseball was
installed. Then delete the BB.CFG file from the directory where
FPS: Baseball was installed and restart the game.
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CUSTOMER SERVICE

The best customer service in the industry.

"You don't just buy our games—you buy the support of the whole
company.”
—EKen Williams, CEO Sierra On-Line, Inc.

Sierra On-Line is dedicated to helping you with each and every
question or problem. Whether it's memory shortages, software
compatibility, or any other issue affecting our products, we
gucarantee your satisfaction.

The Sierra No-Risk Guarantee!

THE PROMISE: We want you to be happy with every Sierra product
you purchase. Period. Complete and return the enclosed owner
registration card, and we will be able to serve you better. If you are
unhappy with one of our software products for any reason, you can
return it for an exchange or refund within 30 days of purchase. (If it
was purchased retail, please include the original sales receipt.)

THE ONLY CATCH: You have to tell us why you don't like it, so we
can improve. If you send it back and tell us why, we'll do our best
to make you happy.

Software Warranty & Replacements

If your Sierra software or disk fails within 90 days of purchasa_\, we
will replace it free of charge. Return the CD directly to us with a
copy of your sales receipt. After 90 days, include the replacemgnt
fee: $10.00 in U.S.; £6.00 in U.K.; £7.00 outside U.K. Note: this policy
applies to the original owner only.

In the US, send Replacements/Returns to:

Sierra On-Line Fulfillment

P.O. Box 485

Coarsegold, CA 93614

(For Returns, add Atin: Returns)

Overseas, return your disk(s) to the appropriate Sierra Customer
Service center, marked "Atin: Returns."
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TECHNICAL SUPPORT

If you need additional help installing or using your Sierra product,
and you can't find the answer in this guide, try our Automated
Technical Support Line at (425) 644-4343; it is available 24 hours a
day and provides recorded answers to the most frequently asked
questions. Follow the recorded instructions to find your specific
topic.

If you can't resolve the problem through the Automated Support
Line, you can contact our Technical Support representatives
directly. You may call, write, fax, or contact us on one of the online
services that Sierra supports. (For sales information, back orders,
returns, technical support in Europe, or other information, see
Customer Service.) If you choose to write or fax us, please provide
detailed information on your computer system and the nature of
your problem. In addition, please include your address and phone
number should we need to call back or send you information.

Automated Technical Support Line - USA:
1-425-644-4343

Sierra On-Line offers a 24-hour Automated Technical Support line
with recorded answers to the most frequently asked technical
questions. To access this service, call (425) 644-4343, and follow the
recorded instructions to find your specific topic and resolve the
issue. If this fails to solve your problem, you may still write, or fax
us with your questions, or contact us via our On-Line services.

U.8. Technical Support

Main: (425) 644-4343

Monday-Friday, 8:15 a.m. - 4:45 p.m. PST
Fax:(425) 644-7697

Sierra On-Line

Technical Support

P.O. Box 85006

Bellevue, WA 98015-8506
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Automated Technical Support Line - United Kingdom:
(0118) 920-9111

Sierra On-Line UK offers a 24-hour Automated Technical Support
line with recorded answers to the most frequently asked technical
questions. To access this service, call (0118) 920-9111, and follow
the recorded instructions to find your specific topic and resolve the
issue. If this fails to solve your problem, you may still write, or fax
us with your questions, or contact us via our Internet or
CompuServe sites.

U.K. Technical Support

Phone: (0118) 920-9111
Monday-Friday, 9:00 a.m. - 5:00 p.m.
Fax: (0118)987-5603

Sierra On-Line Limited

2 Beacontree Plaza,

Gillette Way,

Reading, Berkshire

RG2 0BS United Kingdom

France

Téléphone: 01-46-01-46-50

Support Technique automatisé 7 jours sur 7 24h/24

Fax: 01-46-30-00-65

Parc Tertiaire de Meudon

Immeuble "Le Newton"

25 rue Jeanne Braconnier

Techniciens accessibles du Lundi au Vendredi de 10h a 1Sh
92366 Meudon La Forét Cedex

France

Germany

Phone: (0) 6103-99-40-40

Montag bis Freitag von 9 — 19Uhr
Fax: (0) 6103-99-40-35

Mailbox: (0) 6103-99-40-41

Sierra Coktel Vision Deutschland
Robert-Bosh-Str. 32

D-63303 Dreieich

Deutschland
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Spain

Teléfono: (01) 383-2623

Lunes a Viernes de 9h30 « 14h y de 15h a 18h30

Fax: (01) 381-2437

Coktel Educative Multimedia

Avenida de Burgos 9

1°-OF2

28036 Madrid

Spain

Technical Support via modem is also available through:
CompuServe USA: GO SIERRA

CompuServe United Kingdom: GO UKSIERRA
CompuServe France: GO FRSIERRA

CompuServe Germany: GO DESIERRA

America Online: Keyword Sierra

Internet USA: htip://www.sierra.com

Internet United Kingdom: http://www.sierra-online.co.uk

Internet France: http://www.sierra.fr

Internet Germany: http://www.sierra.de
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SALES SUPPORT

United States

Sierra Direct
U.S.A. Sales Phone: (800) 757-7707

: International Sales: (425) 746-5771

FAX: (402) 393-3224

Hours: Monday-Saturday 7AM to 11 PM CST, Sundays 8 AM to SPM
CST

7100 W. Center Rd
STE 301
Omaha, NE 68106

Disk and or Manual Replacement:
Sierra On-Line Fulfillment

PO Box 485

Coarsegold CA 93614

Product Returns:
Sierra On-Line Returns
PO Box 485
Coarsegold CA 93614

NOTE: To replace your disk(s) please send only Disk #1 {or the CD)
and copy of your dated Receipt, if less then 90 days. After 90 days
please include a $10 handling fee along with Disk / CD #l1. For
Documentation, please include a $ 5.00 handling fee and «
photocopy ONLY of disk #1. Payment should be made at the time
of your request. Sorry, no credit cards.

United Kingdom

Main: (0118) 920-9111

Monday-Friday, 9:00 a.m. - 5:00 p.m.

Fax: (0118) 987-5603

Sierra On-Line Limited

2 Beacontree Plaza,

Gillette Way,

Reading, Berkshire

Disk/CD replacements in the U.K. are £6.00,

RG2 0BS United Kingdomor £7.00 outside the UK. Add "ATTN.:
Returns.”
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France

Phone: (01) 46-01-48-53

Lundi gu Vendredi de 9h & 18h
Fax: (01) 46-30-00-65

Parc Tertiaire de Meudon
Immeuble "Le Newton"

25 rue Jeanne Braconnier
92366 Meudon La Forét Cedex
France

Germany

Tel: (0) 6103-99-40-53

Montag bis Freitag von 10h — 17Uhr
Fax: (0) 6103-99-40-35

Sierra Coktel Deutschland
Robert-Bosh-5tr. 32

D-63303 Dreieich

Germany

On-Line Sales

CompuServe USA: GO SI (CServe Mall)

CompuServe United Kingdom: GO UKSIERRA
CompuServe France: GO FRSIERRA

CompuServe Germany: GO GESIERRA

America Online: Keyword Sierra

Internet USA: http://www.sierra.com

Internet United Kingdom: http://www.sierra-online.co.uk
Internet France: htip://www.sierra.fr

Internet Germany: http://www.sierra.de

USING THE F'PS: BASEBALL
WEBSITE

If you click the Web Site button on the FPS: Baseball startup screen,
you will be connected via Windows 95 dialup networking to
Sierra's Baseball Pro "98 home page. (This function will only work
if you have dialup networking properly configured to connect to

your Internet Service Provider. )

The FPS: Baseball web site is an invaluable resource, offering tips,
support notes, and software updates. You can also go to Sierra On-

Line's Home Page at http://www.sierra.com.
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FPS: BASEBALL ‘98 CREDITS

Director
Glen Woliram

Lead Designer
Doug Johnson

Lead Programmer
Glen Wolfram

Stadium/Action Programmer
Dave Merrill

Front Office Programmer
Glen Wolfram

Sound Programmer
James Poelke

Additional Programming
Randy MacNeill, Michael Lytton

Technical Assistance
Rhett Anderson, Glenn Wallace

Art Direction
Tom VanVelkinburg

Artists
Troy MacFarland, Mark Peasley, Vance Naegle

Online & Print Manual
Michael Stearns, Doug Johnson

Video Production
Jim Carey, David Aughenbaugh, Kate Alley

Original Music
Charles Barth

Sound Effects
LOUDMOUTH, Ken Rogers

Quality Assurance Manager
Dave Steele
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QA Lead
John Wolf

QA Team
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Russell, Ken Smith

Producer
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Joe Rudi, David Sandgathe, Chris Singleton, Dave Steele, Dale
Tendick, Tom VanVelkinburg, Kurt Weber, Dan White, John Wolf,
Glen Wolfram, Scott Youngblood
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BY USING THIS SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE
TERMS OF THIS LICENSE.

Sierra On-Line End User License Agreement

This software is copyrighted. This software and documentation is licensed to you by Sierra On-
Line. You may copy it onto a computer for your own personal use and you may make back up
copies of the software to protect your software against loss. This software may be used by more
than one person, and may be freely moved from one computer location to another provided that
there is no possibility of the software being used at one location or on one computer while it is
being used at another. The software can not legally be used by two different people in different
places at the same time. You may not modify, network, rent, lease, loan, distribute the software or
create derivative works based upon the software in whole or in part, and you may not electronically
transmit the software from one computer to another or over a network.

This End User License Agreement grants you a limited license to use the Redistributable Code
licensed to Sierra On-Line, Inc. by Microsoft Corporation, Inc. together with Microsoft operating
system products. All intellectual property rights in Microsoft's Redistributable Code contained in
this product belong exclusively to Microsoft Corporation, Inc.

Limitations on Warranty

Sierra warrants the diskette(s) to be free of defects in materials and workmanship for a period of
90 days from the date of purchase. Sierra On-Line’s entire liability and your exclusive remedy will
be replacement of the disk.

Sierra On-Line specifically disclaims all other warranties, express or implied, including but not
limited to any implied warranty of the merchantability or fithess for a particular purpose.

This limited warranty gives you specific legal rights; you may have others which may vary from
state to state. Some states do not allow the exclusion of incidental or consequential damages, or
the limitation on how long an implied warranty lasts, so some of the above may not apply to you.

You are entitled to use this product for your own use, but may not copy, reproduce, translate,
publicly perform, display, or reduce to any electronic medium or machine- readable form,
reproductions of the software or manual to other parties in any way, nor sell, rent or lease the
product to others without prior written permission of Sierra. You may use one copy of the product
on a single computer. YOU MAY NOT NETWORK THE PRODUCT OR OTHERWISE INSTALL IT OR
USE IT ON MORE THAN ONE COMPUTER AT THE SAME TIME.

UNAUTHORIZED REPRESENTATIONS: SIERRA WARRANTS ONLY THAT THE PROGRAM WILL
PERFORM AS DESCRIBED IN THE USER DOCUMENTATION. NO OTHER ADVERTISING,
DESCRIPTION, OR REPRESENTATION, WHETHER MADE BY A SIERRA DEALER, DISTRIBUTOR,
AGENT, OR EMPLOYEE, SHALL BE BINDING UPON SIERRA OR SHALL CHANGE THE TERMS OF
THIS WARRANTY.

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, SIERRA MAKES NO WARRANTY,
EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. SIERRA DISCLAIMS ANY WARRANTY THAT
THE SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF
MERCHANTABILITY SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS LIMITED
EXPRESS WARRANTY AND 1S OTHERWISE EXPRESSLY AND SPECIFICALLY DISCLAIMED.
SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS,
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES: SIERRA SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF SIERRA IS ADVISED OF OR AWARE OF THE
POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT SIERRA SHALL NOT BE RESPONSIBLE OR
LIABLE FOR LOST PROFITS OR REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A
RESULT OF LOSS OF TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE
EXCEPT THE ACTUAL COST OF THE PRODUCT. IN NC EVENT SHALL SIERRA'S LIABILITY
EXCEED THE PURCHASE PRICE OF THIS PRODUCT. SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

© 1997 Sierra On-Line, Inc. ® and/or ™ designate trademarks of, or licensed
to Sierra On-Line, Inc. All rights reserved.
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